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Important safety information
This manual contains information and warnings that must be followed by the user for safe operation and to keep the product in a safe
condition.

To safely perform service on this product, see the Service safety summary that follows the General safety summary.

General safety summary
Use the product only as specified. Review the following safety precautions to avoid injury and prevent damage to this product or any
products connected to it. Carefully read all instructions. Retain these instructions for future reference.

This product shall be used in accordance with local and national codes.

For correct and safe operation of the product, it is essential that you follow generally accepted safety procedures in addition to the safety
precautions specified in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove the cover for repair, maintenance, or adjustment.

Before use, always check the product with a known source to be sure it is operating correctly.

This product is not intended for detection of hazardous voltages.

Use personal protective equipment to prevent shock and arc blast injury where hazardous live conductors are exposed.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other component manuals
for warnings and cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system is the responsibility of the assembler of the system.

To avoid fire or personal injury

Use proper power cord
Use only the power cord specified for this product and certified for the country of use. Do not use the provided power cord for other
products.

Ground the product
This product is grounded through the grounding conductor of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output terminals of the product, ensure that the product is properly
grounded. Do not disable the power cord grounding connection.

Power disconnect
The power cord disconnects the product from the power source. See instructions for the location. Do not position the equipment so that it is
difficult to operate the power cord; it must remain accessible to the user at all times to allow for quick disconnection if needed.

Connect and disconnect properly
Do not connect or disconnect probes or test leads while they are connected to a voltage source.

Use only insulated voltage probes, test leads, and adapters supplied with the product, or indicated by Tektronix to be suitable for the
product.

Important safety information
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Observe all terminal ratings
To avoid fire or shock hazard, observe all rating and markings on the product. Consult the product manual for further ratings information
before making connections to the product.

Do not exceed the Measurement Category (CAT) rating and voltage or current rating of the lowest rated individual component of a product,
probe, or accessory. Use caution when using 1:1 test leads because the probe tip voltage is directly transmitted to the product.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.

Do not connect a current probe to any wire that carries voltages above the current probe voltage rating.

Do not operate without covers
Do not operate this product with covers or panels removed, or with the case open. Hazardous voltage exposure is possible.

Avoid exposed circuitry
Do not touch exposed connections and components when power is present.

Do not operate with suspected failures
If you suspect that there is damage to this product, have it inspected by qualified service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged or operates incorrectly. If in doubt about safety of the product,
turn it off and disconnect the power cord. Clearly mark the product to prevent its further operation.

Before use, inspect voltage probes, test leads, and accessories for mechanical damage and replace when damaged. Do not use probes or
test leads if they are damaged, if there is exposed metal, or if a wear indicator shows.

Examine the exterior of the product before you use it. Look for cracks or missing pieces.

Use only specified replacement parts.

Do not operate in wet/damp conditions
Be aware that condensation may occur if a unit is moved from a cold to a warm environment.

Do not operate in an explosive atmosphere

Keep product surfaces clean and dry
Remove the input signals before you clean the product.

Provide proper ventilation
Refer to the installation instructions in the manual for details on installing the product so it has proper ventilation.

Slots and openings are provided for ventilation and should never be covered or otherwise obstructed. Do not push objects into any of the
openings.

Provide a safe working environment
Always place the product in a location convenient for viewing the display and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads. Improper or prolonged keyboard or pointer use may result in
serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an ergonomics professional to avoid stress injuries.

Use care when lifting and carrying the product. This product is provided with a handle or handles for lifting and carrying.

Important safety information
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WARNING: The product is heavy. To reduce the risk of personal injury or damage to the device get help when lifting or carrying
the product.

Use only the Tektronix rackmount hardware specified for this product.

Probes and test leads
Before connecting probes or test leads, connect the power cord from the power connector to a properly grounded power outlet.

Keep fingers behind the protective barrier, protective finger guard, or tactile indicator on the probes. Remove all probes, test leads and
accessories that are not in use.

Use only correct Measurement Category (CAT), voltage, temperature, altitude, and amperage rated probes, test leads, and adapters for
any measurement.

Service safety summary
The Service safety summary section contains additional information required to safely perform service on the product. Only qualified
personnel should perform service procedures. Read this Service safety summary and the General safety summary before performing any
service procedures.

To avoid electric shock
Do not touch exposed connections.

Do not service alone
Do not perform internal service or adjustments of this product unless another person capable of rendering first aid and resuscitation is
present.

Disconnect power
To avoid electric shock, switch off the product power and disconnect the power cord from the mains power before removing any covers or
panels, or opening the case for servicing.

Use care when servicing with power on
Dangerous voltages or currents may exist in this product. Disconnect power, remove battery (if applicable), and disconnect test leads
before removing protective panels, soldering, or replacing components.

Verify safety after repair
Always recheck ground continuity and mains dielectric strength after performing a repair.

Terms in this manual
These terms may appear in this manual:

WARNING: Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION: Caution statements identify conditions or practices that could result in damage to this product or other property.

Important safety information
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Terms on the product
These terms may appear on the product:

• DANGER indicates an injury hazard immediately accessible as you read the marking.
• WARNING indicates an injury hazard not immediately accessible as you read the marking.
• CAUTION indicates a hazard to property including the product.

Symbols on the product
When this symbol is marked on the product, be sure to consult the manual to find out the nature of the potential
hazards and any actions which have to be taken to avoid them. (This symbol may also be used to refer the user to
ratings in the manual.)

The following symbols(s) may appear on the product.

CAUTION: Refer to
Manual

Protective Ground
(Earth) Terminal

Earth Terminal Chassis Ground Mains Disconnected
OFF (Power)

Mains Connected ON
(Power)

Standby WARNING: High
Voltage

Important safety information

12



Specifications
This chapter contains specifications for the instrument. All specifications are guaranteed unless noted as "typical." Typical specifications
are provided for your convenience but are not guaranteed. Specifications that are marked with the  symbol are checked in Performance
Verification.

All specifications apply to all models unless noted otherwise. To meet specifications, the following conditions must first be met:

• The instrument must have been adjusted in an ambient temperature range between 18 °C and 28 °C.
• The instrument must be powered from a source that meets the specifications.
• The instrument must have been operating continuously for twenty minutes within the specified operating temperature range. (60

minutes continuous operation required if the ambient relative humidity is greater than 60%.)
• You must perform the Signal Path Compensation (SPC) operation described in the user manual and the online help. If the operating

temperature changes by more than 5 °C, you must perform the SPC operation again.

Vertical system analog channels
Number of channels ≥50 GHz models: 2+1,

<50 GHz models: Four channels, all identical

Input connector

TekConnect channels: TekConnect. Power supply compatible with VPI.

ATI channel: Male 1.85 mm coax.

Input coupling

TekConnect channels: Two modes: DC, 50 ohms to a programmable termination voltage; Ground.

The termination can be connected to a DC voltage:

≤ 1.2 VFS settings: -3.5 V to 3.5 V,

> 1.2 VFS settings: 0.0 V

ATI channel: DC, 50 Ω.

Input resistance

≤1.2 VFS settings 50 Ω ±3% at 18 to 28 ºC (64 to 82 ºF)

50 Ω ±4% over 5 to 45 ºC (45 to 113 ºF)

>1.2 VFS settings 50 Ω ±4.4% over 5 to 45 ºC (45 to 113 ºF)

ATI channel 50 Ω ±3% from 18 °C to 28 °C

50 Ω ±4% from 5 °C to 45 °C

Maximum input voltage

TekConnect channels: ≤1.2 VFS settings:

±1.5 V relative to the termination bias (30 mA maximum)

±5 V absolute maximum input

Specifications
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>1.2 VFS settings:

±8 V. Limited by maximum Vterm current and the attenuator power rating at maximum temperature.

ATI channel: ±0.75 Vpk

Aux channel: ±5.0 Vpk

Input termination voltage (VTerm) range, TekConnect channels

≤1.2 VFS settings: -3.5 V to +3.5 V

>1.2 VFS settings: 0 V

Input VSWR, typical
Measured with a TekConnect TCA-292D adaptor and a network analyzer.

≤1.2 VFS settings: 0 – 17 GHz: 1.4:1 

17 – 20 GHz: 1.6:1 

20 – 33 GHz: 2.0:1 

>1.2 VFS settings: 0 – 17 GHz: 1.4:1 

17 – 33 GHz: 2.0:1 

ATI channel: 0-20GHz: 1.7:1

>20-33 GHz: 2.0:1

> 33-70 GHz: 3.0:1

Vertical resolution 8 bits, (11 bits with averaging)

Number of digitized bits 8 bits

Digitizer nonlinearity (typical) < 1.0 DL (digitization level), differential; < 1 DL integral, independently based

Sensitivity range

TekConnect channels 62.5 mVFS to 6 VFS

ATI channel 100 mVFS to 300 mVFS.

DC gain accuracy ± 2%

DC voltage measurement
accuracy, Sample, Average,
and Hi-Res modes

Net offset = offset - (position × volts/division).

Full scale setting DC measurement accuracy

62.5 mVFS – 6 VFS 1 ±(Gain accuracy x | vertical value - net offset |) + offset
accuracy + 0.4% x FS

Delta voltage reading
Table continued…

1 For ATI channels, the full scale settings range is 100 mVFS to 300 mVFS.
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Full scale setting DC measurement accuracy
62.5 mVFS – 6 VFS ±(Gain accuracy x | Delta voltage measured | + 0.008 x FS

Position range ± 5 divisions

Offset range

TekConnect channels Full Scale voltage range Offset range
62.5 mVFS – 1.2 VFS ±3.4 V

>1.2 VFS – 6 VFS ±6 V

ATI channel Full Scale voltage range Offset range
100 mVFS – 300 mVFS ±300 mV - (10 div × Volts/div)

Offset accuracy
Net offset = offset - (position × volts/division).

Full scale voltage range Offset accuracy

62.5 mVFS to 1.2 VFS (TekConnect channels) ±(0.4% | net offset | + 0.2% | net offset – Vterm
setting | + 2.5 mV + 1% FS)

>1.2 VFS to 6 VFS (TekConnect channels) ±(0.6% | net offset | + 13.4 mV + 1% FS)

100 mVFS to 300 mVFS (ATI channel) ±(0.35% | net offset | + 2 mV + 1% FS)

Analog bandwidth
Bandwidth with a TCA292D adapter on TekConnect channels or directly into ATI channel.

Ambient temperature 18ºC to 28ºC assumed for all guaranteed bandwidth specifications.

Enhanced bandwidth is guaranteed at the following full scale (FS) stepped gain settings:

TekConnect channels: 62.5 mV, 100 mV, 200 mV, 500 mV, 1 V, 2 V, and 5 V.

ATI channel: All settings from 100 mV through 300 mV.

Specifications
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Instrument Channel BW settings Bandwidth 2 Sample rate

DPO77002SX ATI, 1 Ch 70 GHz BWE >67 GHz

70 GHz
typical

200 GS 3

DPO77002SX

DPO73304SX

TekConnect, 2 Ch No BWE >33 GHz All

DPO77002SX

DPO73304SX

TekConnect, 2 Ch 33 GHz BWE >33 GHz 100 GS/s

DPO77002SX

DPO73304SX
TekConnect, 2 Ch

TekConnect, 4 Ch

23 GHz BWE >23 GHz 50 GS/s

DPO75902SX ATI, 1 Ch 59 GHz BWE >59 GHz 200 GS
DPO75902SX

DPO75002SX

ATI, 1 Ch 50 GHz BWE >50 GHz 200 GS

DPO75902SX TekConnect No BWE >33 GHz All
DPO75002SX TekConnect No BWE >25 GHz All

25 GHz BWE >25 GHz 100 GS/s
23 GHz BWE >23 GHz 50 GS/s

DPO72504SX TekConnect 25 GHz BWE >25 GHz 100 GS/s
23 GHz BWE >23 GHz 50 GS/s

DPO72304SX TekConnect No BWE >23 GHz 50 GS/s, 100 GS/s
23 GHz BWE >23 GHz 50 GS/s, 100 GS/s

DPO72004SX TekConnect 20 GHz BWE >20 GHz 50 GS/s, 100 GS/s
DPO71604SX TekConnect 16 GHz BWE >16 GHz 50 GS/s, 100 GS/s
DPO71304SX TekConnect 13 GHz BWE >13 GHz 50 GS/s, 100 GS/s

TekConnect channel Typical temperature derating
Frequency TC, (dB/°C) 5 °C 45 °C
DC - 5 GHz 0.005 dB/°C 0.07 -0.09
10 GHz 0.010 dB/°C 0.13 -0.17
15 GHz 0.025 dB/°C 0.33 -0.43
20 GHz 0.045 dB/°C 0.59 -0.77
23 GHz 0.10 dB/°C 1.30 -1.70
Table continued…

2 To determine the amount of performance derating above the temperature limit, use the Typical Temperature Variation table.
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Typical temperature derating
Frequency TC, (dB/°C) 5 °C 45 °C
25 GHz 0.10 dB/°C 1.30 -1.70
30 GHz 0.115 dB/°C 1.50 -1.96
33 GHz 0.160 dB/°C 2.08 -2.72

ATI channel Typical temperature derating
Frequency TC, (dB/°C)
DC - 10 GHz 0.002 dB/°C
15 GHz 0.005 dB/°C
20 GHz 0.01 dB/°C
30 GHz 0.05 dB/°C
40 GHz 0.07 dB/°C
50 GHz 0.05 dB/°C
60 GHz 0.05 dB/°C
67 GHz 0.05 dB/°C

Frequency response tolerance

All modes, BWE on, 18 ºC
to 28 ºC (typical)

To determine the amount of performance derating above the temperature limit, use the Typical Temperature
Variation table

TekConnect channel: Step settings TekConnect channels: 77.5 mVFS, 151 mVFS, 302 mVFS, 605 mVFS, 1210 mVFS., 1620 mVFS,
3240 mVFS

±0.5 dB from DC to 50% of nominal BW

±1.5 dB from 50% to 80% of nominal BW

All other gain settings:

±1.0 dB from DC to 50% of nominal BW

±2.0 dB from 50% to 80% of nominal BW

ATI channel: All volts/div settings

±0.5 dB from DC to 20 GHz

±0.75 dB from >20 GHz to 30 GHz

±1.25 dB from >30 GHz to 68.5 GHz

±2 dB from >68.5 GHz to 69.5 GHz

+2 / -3 dB at 70 GHz

3 200 GS/s is the only sample rate available on the ATI channel.

Specifications

DPO70000SX Series Oscilloscopes Specifications and Performance Verification 17



TekConnect channel Typical temperature derating
Frequency TC, (dB/°C) 5 °C 45 °C
DC - 5 GHz 0.005 dB/°C 0.07 -0.09
10 GHz 0.010 dB/°C 0.13 -0.17
15 GHz 0.025 dB/°C 0.33 -0.43
20 GHz 0.045 dB/°C 0.59 -0.77
23 GHz 0.10 dB/°C 1.30 -1.70
25 GHz 0.10 dB/°C 1.30 -1.70
30 GHz 0.115 dB/°C 1.50 -1.96
33 GHz 0.160 dB/°C 2.08 -2.72

ATI channel Typical temperature derating
Frequency TC, (dB/°C)
DC - 5 GHz 0.005 dB/°C
DC - 10 GHz 0.002 dB/°C
15 GHz 0.005 dB/°C
20 GHz 0.01 dB/°C
30 GHz 0.05 dB/°C
40 GHz 0.07 dB/°C
50 GHz 0.05 dB/°C
60 GHz 0.05 dB/°C

Calculated rise time (typical) Table 1: Calculated risetimes for specified instrument bandwidths

Instrument bandwidth BWE On BWE Off
10% - 90% 20% - 80% 10% - 90% 20% - 80%

70 GHz 5.6 ps 4.3 ps n/a n/a
50 GHz 7.8 ps 6 ps n/a n/a
33 GHz 13 ps 9 ps 21 ps 14 ps
25 GHz 16 ps 12 ps 22 ps 15 ps
23 GHZ 17 ps 13 ps 24 ps 16 ps
20 GHZ 22 ps 15 ps 25 ps 17 ps
16 GHZ 26 ps 19 ps 26 ps 18 ps
13 GHZ 32 ps 23 ps 28 ps 19 ps

Step response settling time (typical)
The time by which the step response enters and stays below the indicated % error. Step transition occurs at the 50% amplitude point of the
step leading edge.
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BWE off Instrument Gain setting (FS) Settling Error
Amount Time

DPO73304SX 62.5 mV, 100 mV, 200
mV, 500 mV, 1.0 V, 1.2
V, 1.4 V, 2 V, 4 V

<6%

<5.5%

<3%

150 ps – 400 ps

400 ps – 3 ns

3 ns – 1 ms

Instrument Gain setting (FS) Settling Error
Amount Time

DPO77002SX TekConnect
channels

62.5 mV, 100 mV, 200
mV, 500 mV, 1.0 V, 1.2
V, 1.4 V, 2 V, 4 V

<6%

<5.5%

<3%

150 ps – 400 ps

400 ps – 3 ns

3 ns – 1 ms

DPO75902SX TekConnect
channels

62.5 mV, 100 mV, 200
mV, 500 mV, 1.0 V, 1.2
V, 1.4 V, 2 V, 4 V

<6%

<5.5%

<3%

150 ps – 400 ps

400 ps – 3 ns

3 ns – 1 ms

DPO75002SX TekConnect
channels

62.5 mV, 100 mV, 200
mV, 500 mV, 1.0 V, 1.2
V, 1.4 V, 2 V, 4 V

<6%

<5.5%

<3%

150 ps – 400 ps

400 ps – 3 ns

3 ns – 1 ms

DPO73304SX 62.5 mV, 100 mV, 200
mV, 500 mV, 1.0 V, 1.2
V, 1.4 V, 2 V, 4 V

<6%

<5.5%

<3%

150 ps – 400 ps

400 ps – 3 ns

3 ns – 1 ms

DPO72504SX,
DPO72304SX,
DPO72004SX,
DPO71604SX,
DPO71304SX

62.5 mV, 100 mV, 200
mV, 500 mV, 1.0 V, 1.2
V, 1.4 V, 2 V, 4 V

<6%

<5%

<3%

150 ps – 400 ps

400 ps – 3 ns

3 ns – 1 ms

BWE on (fastest BWE
setting) (typical)

BWE on (fastest BWE setting) Instrument Gain setting (FS) Settling

Instrument Gain setting (FS) Settling Error
Amount Time

DPO77002SX,
DPO75902SX,
DPO75002SX ATI channel

100 mV, 200 mV, 300
mV

<3.5%

<2.5%

<1.5%

150 ps – 400 ps

400 ps – 3 ns

3 ns – 1 ms

Table continued…
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Instrument Gain setting (FS) Settling Error
Amount Time

All Models, TekConnect
Channels

62.5 mV, 100 mV, 200
mV, 500 mV, 1.0 V, 1.2
V, 1.4 V, 2 V, 4 V

<3.5%

<2.5%

<1.5%

150 ps – 400 ps

400 ps – 3 ns

3 ns – 1 ms

Effective number of bits
(typical). Average value from
DC to full bandwidth of model.

70 GHz ATI Channel 4.6 bits at 250 mV FS, 200 GS/s
59 GHz ATI Channel 4.8 bits at 250 mV FS, 200 GS/s
50 GHz ATI Channel 5.0 bits at 250 mV FS, 200 GS/s
33 GHz TekConnect Channels 5.0 bits at 500 mV FS, 100 GS/s
25 GHz TekConnect Channels 5.2 bits at 500 mV FS, 100 GS/s
23 GHz TekConnect Channels 5.4 bits at 500 mV FS, 100 GS/s
20 GHz TekConnect Channels 5.5 bits at 500 mV FS, 100 GS/s
16 GHz TekConnect Channels 5.8 bits at 500 mV FS, 100 GS/s
13 GHz TekConnect Channels 5.9 bits at 500 mV FS, 100 GS/s

Noise (typical)

Gain setting, full scale, BWE off DPO77002SX, DPO75902SX, DPO75002SX,
DPO73304SX TekConnect channels

62.5 mV 0.88 mV
100 mV 0.96 mV
200 mV 1.53 mV
500 mV 4.19 mV
1 V 8.30 mV
2.0 V 18.84 mV
3.0 V 24.64 mV
4.0 V 37.91 mV
5.0 V 43.36 mV
6.0 V 47.93 mV

Gain setting,
full scale, BWE
off

DPO72504SX DPO72304SX DPO72004SX DPO71604SX DPO71304SX

62.5 mV 0.86 mV 0.79 mV 0.81 mV 0.74 mV 0.70 mV
100 mV 0.91 mV 0.86 mV 0.89 mV 0.82 mV 0.79 mV
200 mV 1.49 mV 1.41 mV 1.34 mV 1.30 mV 1.32 mV
Table continued…
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Gain setting,
full scale, BWE
off

DPO72504SX DPO72304SX DPO72004SX DPO71604SX DPO71304SX

500 mV 3.57 mV 3.14 mV 3.05 mV 3.00 mV 3.05 mV
1 V 6.74 mV 6.10 mV 6.06 mV 5.90 mV 6.08 mV
2.0 V 16.8 mV 14.19 mV 13.69 mV 13.07 mV 13.09 mV
3.0 V 21.82 mV 19.09 mV 18.70 mV 18.37 mV 18.37 mV
4.0 V 31.06 mV 26.01 mV 26.72 mV 25.35 mV 25.55 mV
5.0 V 35.25 mV 31.84 mV 31.58 mV 30.52 mV 30.62 mV
6.0 V 40.33 mV 36.97 mV 36.25 mV 35.91 mV 36.33 mV

Gain setting, full scale, BWE on DPO77002SX, DPO75902SX, DPO75002SX,
DPO73304SX TekConnect channels
100 GS/s 50 GS/s

62.5 mV 0.84 mV 0.84 mV
100 mV 0.93 mV 0.93 mV
150 mV 1.31 mV 1.29 mV
200 mV 1.52 mV 1.60 mV
300 mV 2.49 mV 2.52 mV
400 mV 2.92 mV 3.12 mV
500 mV 3.55 mV 3.80 mV
600 mV 4.86 mV 4.86 mV
700 mV 5.25 mV 5.39 mV
800 mV 5.76 mV 6.08 mV
900 mV 6.30 mV 6.66 mV
1 V 6.80 mV 7.30 mV
1.1 V 8.69 mV 9.02 mV
1.2 V 9.12 mV 9.60 mV
2.0 V 15.4 mV 14.53 mV
3.0 V 19.9 mV 19.82 mV
4.0 V 28.83 mV 27.85 mV
5.0 V 34.32 mV 32.80 mV
6.0 V 39.82 mV 38.96 mV

Gain setting, full
scale, BWE on

DPO72504SX DPO72304SX

100 GS/s 50 GS/s 100 GS/s 50 GS/s
62.5 mV 0.85 mV 0.82 mV 0.75 mV 0.72 mV
Table continued…
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Gain setting, full
scale, BWE on

DPO72504SX DPO72304SX

100 GS/s 50 GS/s 100 GS/s 50 GS/s
100 mV 0.91 mV 0.92 mV 0.78 mV 0.82 mV
150 mV 1.08 mV 1.19 mV
200 mV 1.38 mV 1.48 mV 1.14 mV 1.43 mV
300 mV 2.10 mV 2.29 mV
400 mV 2.58 mV 2.29 mV
500 mV 3.15 mV 3.40 mV 2.65 mV 3.38 mV
600 mV 4.14 mV 4.42 mV
700 mV 4.64 mV 4.96 mV
800 mV 5.08 mV 5.52 mV
900 mV 5.63 mV 6.13 mV
1 V 5.90 mV 6.7 mV 5.09 mV 6.54 mV
1.1 V 7.79 mV 8.20 mV
1.2 V 8.28 mV 8.72 mV
2.0 V 13.1 mV 14.74 mV 11.66 mV 14.65 mV
3.0 V 17.69 20.43 mV 15.31 mV 20.51 mV
4.0 V 25.46 mV 28.44 mV 21.61 mV 27.84 mV
5.0 V 29.61 mV 33.85 mV 25.69 mV 34.07 mV
6.0 V 35.04 mV 38.68 mV 29.65 mV 39.18 mV

Gain setting,
full scale,
BWE on

DPO72004SX DPO71604SX DPO71304SX

100 GS/s 50 GS/s 100 GS/s 50 GS/s 100 GS/s 50 GS/s
62.5 mV 0.76 mV 0.80 mV 0.78 mV 0.77 mV 0.71 mV 0.69 mV
100 mV 0.82 mV 0.88 mV 0.77 mV 0.81 mV 0.68 mV 0.73 mV
150 mV 0.94 mV 1.01 mV 0.88 mV 0.95 mV
200 mV 1.13 mV 1.38 mV 1.04 mV 1.18 mV 0.99 mV 1.14 mV
300 mV 1.58 mV 1.8 mV 1.57 mV 1.79 mV
400 mV 1.82 mV 2.20 mV 1.82 mV 2.21 mV
500 mV 2.55 mV 3.18 mV 2.17 mV 2.66 mV 2.2 mV 2.69 mV
600 mV 3.02 mV 3.46 mV 3.01 mV 3.43 mV
700 mV 3.28 mV 3.85 mV 3.25 mV 3.80 mV
800 mV 3.61 mV 4.37 mV 3.56 mV 4.29 mV
900 mV 3.96 mV 4.81 mV 3.89 mV 4.69 mV
1 V 5.04 mV 6.33 mV 4.29 mV 5.29 mV 4.2 mV 5.14 mV
1.1 V 5.48 mV 6.94 mV 5.45 mV 6.74 mV
Table continued…
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Gain setting,
full scale,
BWE on

DPO72004SX DPO71604SX DPO71304SX

100 GS/s 50 GS/s 100 GS/s 50 GS/s 100 GS/s 50 GS/s
1.2 V 5.75 mV 7.50 mV 5.73 mV 7.28 mV
2.0 V 11.19 mV 13.81 mV 9.70 mV 12.23 mV 9.88 mV 11.87 mV
3.0 V 15.12 mV 18.96 mV 12.98 mV 16.55 mV 13.19 mV 16.81 mV
4.0 V 21.3 mV 27.17 mV 19.56 mV 23.17 mV 18.64 mV 21.32 mV
5.0 V 25.0 mV 32.32 mV 22.82 mV 27.79 mV 21.82 mV 26.03 mV
6.0 V 29.53 mV 37.66 mV 26.65 mV 32.42 mV 25.74 mV 31.45 mV

Gain setting, full scale, ATI channel DPO77002SX, DPO75902SX, DPO75002SX
100 mV 1.19 mV
200 mV 1.76 mV
250 mV 2.10 mV
300 mV 2.49 mV

Channel-to-channel crosstalk
(channel isolation), typical

Input frequency range (up to the rated bandwidth). Assumes two channels with the same scale and
bandwidth settings. The limits apply up to the bandwidth of the particular instrument.

ATI models
Specified channels Instrument frequency

range
Isolation

ATI channels (isolation between any two [or more]
ATI channels in separate units), requires UltraSync

DC to 70 GHz 70 dB

TekConnect channels in an ATI unit (isolation
between channels 1 and 3)

DC to 33 GHz 60 dB

TekConnect channels to ATI channel (isolation
between channels 1 and 3 to channel 2)

DC to 4 GHz 55 dB
>4 GHz to 10 GHz 45 dB
>10 GHz to 20 GHz 35 dB
>20 GHz to 30 GHz 30 dB
>30 GHz to 33 GHz 27 dB

ATI channel to TekConnect (non-ATI) channels
(isolation between channel 2 and channels 1 or 3)

DC to 3 GHz 55 dB
>3 GHz to 12 GHz 40 dB
>12 GHz to 33 GHz 30 dB
>33 to 70 GHz 60 dB
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TekConnect models (non-ATI)
Specified channels Instrument frequency

range
Isolation

Isolation between channels 1 or 2 and channels 3 or
4

DC to 33 GHz 60 dB

Isolation between channels 1 and 2, or channels 3
and 4

DC to 2 GHz 60 dB
>2 to 10 GHz 42 dB
>10 to 20 GHz 35 dB
>20 to 33 GHz 30 dB

Measurement category The measuring terminals on this product are not rated for connection to mains or Measurement Category II,
III or IV circuits.

TekConnect interface The instrument TekConnect channels support the TekConnect interface.

Horizontal and acquisition system
Delay between channels, full
bandwidth, equivalent time,
BWE off, without deskew
(typical)

≤ 1 ps between any two channels at any gain setting at 25 °C ±5 °C.

Derate linearly to ≤3 ps at 5 °C and 45 °C

Delay between channels, BWE
(typical)

≤ 500 fs between any two channels within the same box at any gain setting at 25 °C ±5 °C prior to any user
adjustment. Manual adjustment available with 10 fs minimum resolution. Derate linearly to ≤ 1.5  ps at 5 °C
and 45 °C.

Channel skew stability,
UltraSync (typical)

≤ 250 fsRMS between any two channels between instruments at any gain setting at 25 °C ±5 °C. Derate
linearly to ≤ 3 ps at 5 °C and 45 °C.

Real-time sample rate range Channels Sample rate, maximum
(Standard)

TekConnect channels Up to 100 GS/s
ATI channels 200 GS/s only

Equivalent-time sample rate or interpolated waveform rate range
Equivalent-time acquisition can be enabled or disabled. When disabled, waveforms are interpolated at the fastest time base settings.

Up to 5 TS/s (waveform interval down to 0.2 ps) in E.T. and 0.2 ps resolution in trigger placement.

Maximum record length,
sample mode

The maximum record length depends on the installed record length options. Maximum record length is less
in serial trigger mode, hi-res mode, or when using the FIR filter.

500,000,000 points (all channels), 1 G samples on 1–2 channels at 50 GS/s and 100 GS/s sample rates or
greater (interpolated or equivalent time)
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Maximum record length, HiRes
mode

Half the record length of sample mode

Record length limits Operation 4 X 50 GS/s
Acquisition

2 x 100 GS/s Acquisition 1 x 200 GS/s
Acquisition

Display acquired
waveform

500 Msamples 1 Gsamples 1 Gsamples

Waveform data
CURVE? output any PI

500 Msamples 1 Gsamples 1 Gsamples

Math1 = Ch1 - Ch3 250 Msamples 250 Msamples 250 Msamples
Arbfilt (Ch1, "filter")
FFTmag(Ch1)
Reference Waveforms
(Rn)

1 Gsamples 1 Gsamples 1 Gsamples

Seconds division range Fastest sweep speed is 10 ps per division

Internal time-base reference
frequency

10 MHz

Electronically adjustable over about ±10 ppm.

Time base accuracy ±0.8 x 10-6 (within 1st year), ±0.3 x 10-6 aging/year after first year when operated within 23° C ±5° C after
30 minute warm-up.

Typical: ±0.1 x 10-6 initial accuracy after adjustment.

Timing jitter (aperture
uncertainty), (typical)

Measured at the maximum sample rate.

External Reference Low with ~0 dBm input drive at 10 MHz

TekConnect:

<100 fs rms for record durations less than 10 μs

<120 fs rms for record durations less than 100 μs

<140 fs rms for record durations less than 10 ms

<300 fs rms for record durations less than 10 s

ATI:

<65 fs rms for record durations less than 10 μs

External Reference Hi with ~0 dBm input drive at 10 MHz

TekConnect:

<100 fs rms for record durations less than 2 μs

<500 fs rms for record durations less than 10 s

ATI:

<65 fs rms for record durations less than 10 μs
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For external reference in high (tracking) mode, the input reference must be low noise and the edge slew
rate must exceed 1.5 V/ns to achieve the typical jitter results.

Internal Reference

TekConnect:

<100 fs rms for record durations less than 10 μs

<120 fs rms for record durations less than 100 μs

<140 fs rms for record durations less than 5 ms

ATI:

<65 fs rms for record durations less than 10 μs

For internal reference, specification assumes no signal attached to the external reference input.

Jitter noise floor (typical) Applies to time periods as long as 10.0 ns. Typical jitter noise floor is measured at the maximum, BWE
enabled bandwidth:

Calculate the jitter noise floor (JNF) for a given instrument setting using the following formula:

Ntyp = typical input-referred noise spec (volts rms)

FN = 1.3 for instrument bandwidth ≤9 GHz; 1.5 for instrument bandwidth ≥10 GHz

SR = slew rate around the measurement

FI = (1.7 x 10–2)/sqrt(2) = 1.2 x 10–2 

tr = rise time of the measurement edge

tj = timebase jitter or aperture uncertainty

The interpolated sample rate of the waveform must be at least 25 times the bandwidth of the signal being
measured.

Acquisition update rate (typical)

DPO models 300,000 waveforms per second maximum

Delta time measurement
accuracy

The formula to calculate the maximum delta-time measurement accuracy (DTAmax) for a given instrument
setting and input signal is given below (assumes insignificant signal content above Nyquist and insignificant
error due to aliasing, overdrive recovery and overdrive interpolation):

Ntyp = typical input-referred noise spec (volts rms)

FN = 1.3 for instrument bandwidth ≤9 GHz; 1.5 for instrument bandwidth ≥ 33GHz, 1.8 for instrument BW >
33GHz (ATI channels)

SR1 = slew rate around 1st point in measurement (1st edge)

SR2 = slew rate around 2nd point in measurement (2nd edge)

TBA = timebase accuracy (2 ppm)
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FI = 1.2 × 10–2 

tr1 = rise time of first edge

tr2 = rise time of second edge

tj = sample jitter/aperture uncertainty (100 fs TekConnect Channels, 65 fs ATI Channel for time durations
less than 10 μs)

treading = delta-time measurement (sec)

Peak-peak based on statistical accumulation of 500 waveforms.

RMS variation in measured values.

Time interval accuracy (two sigma) of single measurement.

The term under the square-root sign is the stability and is due to Time Interval Error (TIE). The errors due to
this term occur throughout a single-shot measurement.

Trigger specifications
Trigger jitter (typical) 10 fs using enhanced trigger placement.

Trigger jitter DC coupled A
edge (typical)

10 fs using enhanced trigger placement.

1.3 ps rms for low frequency, fast rise time signal, A edge, holdoff time = 30 μs

Trigger sensitivity (typical)

Internal DC coupled A-Event trigger, B-Event trigger ≤ 5%FS from DC to 50 MHz

≤ 7.5%FS at 5 GHz

≤ 10%FS at 10 GHz

≤ 15%FS at 15 GHz

≤ 35%FS at 20 GHz

≤ 50%FS at 25 GHz
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Aux input 50 Ω (external
trigger) Auxiliary input 100 mVpp from DC to 1 GHz

175 mVpp at 4 GHz

225 mVpp at 8 GHz

325 mVpp at 10 GHz

800 mVpp at 12 GHz

Trigger sensitivity TPC (typical)
The minimum signal levels required for stable triggering of a waveform when the hardware is incapable of doing so (excessive frequency, small
input).

Trigger Source Sensitivity
A Event trigger, Ch1 – Ch4 20%×FS from DC to instrument bandwidth

B Event trigger, Ch1 – Ch4 20%×FS from DC to instrument bandwidth

Edge trigger sensitivity, non-DC-coupled modes (typical)
All sources, positive or negative edge, for vertical scale settings ≥10 mV/div and ≤1 V/div

Trigger Coupling Sensitivity
NOISE REJ 15%FS from DC to 50 MHz

22.5% at 5 GHz

30%FS at 10 GHz

45%FS at 15 GHz

100%FS at 20 GHz

AC Same as DC-coupled limits for frequencies > 100 Hz,
attenuates signals <100 Hz

HF REJ Same as DC-coupled limits for frequencies < 20 kHz,
attenuates signals > 20 kHz

LF REJ Same as DC-coupled limits for frequencies >
200 kHz, attenuates signals < 200 kHz

Table continued…
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Trigger Coupling Sensitivity
RF Minimum hysteresis / High sensitivity

A TRIG TekConnect

2.5% FS from DC to 50 MHz

2.5% FS at 5 GHz

2.5% FS at 10 GHz

5% FS at 15 GHz

7.5% FS at 20 GHz

12.5% FS at 25 GHz

B TRIG TekConnect

2.5% FS from DC to 50 MHz

2.5% FS at 5 GHz

2.5% FS at 10 GHz

5% FS at 15 GHz

7.5% FS at 20 GHz

20% FS at 25 GHz

A TRIG ATI

2.5% FS from DC to 50 MHz

2.5% FS at 5 GHz

2.5% FS at 10 GHz

5% FS at 15 GHz

10% FS at 20 GHz

22.5% FS at 25 GHz

B TRIG ATI

2.5% FS from DC to 50 MHz

2.5% FS at 5 GHz

2.5% FS at 10 GHz

5% FS at 15 GHz

10% FS at 20 GHz

22.5% FS at 25 GHz

Trigger level or threshold range
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Trigger Source Range
Ch1, 2, 3, or 4 Full scale
Auxiliary input ±3.65 V
Line 0 V, Not settable

Trigger position error (typical)
Edge trigger, DC coupling, for a 5 division peak to peak 1 GHz sine wave signal.

Acquisition mode Trigger Position Error
Sample, Average ± (1 waveform sample interval + 50 ps)
Peak Detect, Envelope ± (2 waveform sample intervals + 50 ps)

Time range for time-qualified
triggers Setup/Hold Violation

Setup time

Hold time

Setup + hold time

-100 ns to +100 ns

-1 ns to +100 ns

500 ps minimum

Time qualified pattern 300 ps to 1 s
Timeout 40 ps to 1 s
Time qualified window, outside >t 40 ps to 1 s

All other types 40 ps to 1 s

Time-qualified trigger timer accuracy
For glitch, width, time qualified runt, transition, or window and timeout triggering (40 ps to 1.0 ns typical):

Time range Accuracy
40 ps to ≤50 ns ±(3% of setting + 15 ps)
40 ps to ≤1 ns ±(3% of setting + 15 ps) (typical)
1 ns to ≤50 ns ±(3% of setting + 15 ps)
500 ns to 1 s ±(150 ppm x setting + 500 ps)
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Setup/hold violation and time qualified pattern (40 ps to 1.0 ns typical):

300 ps to 1.01 μs ±(5% of setting + 200 ps)
1.02 μs to 1 s ±(TB 4 accuracy + 20 ns)

Advanced trigger sensitivity
(typical)

15% x FS from DC to 10 GHz (pattern and state trigger DC to 1 GHz), not violating the minimum
timing requirements for each type (for vertical settings from 6.5 mV/div to 600 mV/div at the TekConnect
connector)

Advanced trigger types minimum timing requirements (typical)

Minimum duration of
the pattern includes
delay mismatch between
channels.

Trigger Minimum
pulse width

Minimum rearm time Setup
time

Hold time

Width 40 ps 50 ps for time < 5 ns,

75 ps above 5 ns.

n/a n/a

Logic-Qualified Width 40 ps 50 ps for time < 5 ns,

75 ps above 5 ns.

0 ps 100 ps

Glitch 40 ps 50 ps for time < 5 ns,

75 ps above 5 ns.

n/a n/a

Logic-Qualified Glitch 40 ps 50 ps for time < 5 ns,

75 ps above 5 ns.

15 ps 85 ps

Timeout n/a 50 ps for time < 5 ns,

75 ps above 5 ns.

n/a n/a

Logic-Qualified Timeout 5 n/a 50 ps for time < 5 ns,

75 ps above 5 ns.

10 ps 90 ps

Table continued…

4 TB Accuracy is the Time Base Accuracy expressed as a percentage of setting
5 Hold Time for logic qualified Timeout is measured from the expiration of the timer that causes the trigger.
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Trigger Minimum
pulse width

Minimum rearm time Setup
time

Hold time

Window 6 Enters 50 ps Inside
window

75 ps rearm outside
window

n/a n/a

0 ps
transition
through
window

Exits 50 ps
Outside
window

75 ps rearm inside
window

Time-Qualified Window Inside > t 50 ps Inside
window

75 ps rearm outside
window

55 ps 145 ps

0 ps
transition
through
window

Outside > t 50 ps
Outside
window

75 ps rearm inside
window

Logic Qualified Window 50 ps Inside
window

75 ps rearm outside
window

70 ps 30 ps

0 ps
transition
through
window

50 ps
Outside
window

75 ps rearm inside
window

Runt 40 ps 50 ps n/a n/a
Time Qualified Runt 40 ps 50 ps for time < 5 ns,

75 ps above 5 ns.
n/a n/a

Logic-Qualified Runt 40 ps 50 ps 15 ps 85 ps
Table continued…

6 Window trigger for A trigger implemented with both triple masters basically performing edge trigger with the outputs or'ed together
so it could have much better specs for minimum pulse width and rearm time (40ps/40ps) than the Time Qualified Window trigger
which uses the actual window trigger circuitry and time qualifiers in the Tek46. However the B trigger also may have to use the
window trigger circuitry if triple master not available so we've used the reduced specs for all window trigger modes. If you adjust the
trigger levels you can get more performance out of window trigger.
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Trigger Minimum
pulse width

Minimum rearm time Setup
time

Hold time

Transition 7 0 ps.
Triggers
with equal
threshold
settings

50 ps for time < 5 ns,
75 ps above 5 ns.

n/a n/a

Logic-Qualified Transition 0 ps.
Triggers
with equal
threshold
settings

50 ps for time < 5 ns,
75 ps above 5 ns.

0 ps 100 ps

Pattern 150 ps 200 ps N.A. N.A.
Time qualified pattern 150 ps 300 ps N.A. N.A.
State 1.7 GHz 8 N.A. 25 ps 100 ps

Setup and hold times refer to the amount of time before and after a triggering "event" that the qualifying signal
must be true. In some cases (like Glitch) the "event" is the trailing edge of the glitch.

Setup/hold violation Clock active 9 Clock inactive

(Hold times ≥ 0) Hold time setting + 550 ps 500 ps
(Hold times < 0) Hold time setting + 1.6 ns 500 ps

Envelope trigger (typical) Minimum frequency Maximum frequency
500 MHz 20 GHz
Minimum Burst Time Minimum Gap
< 20 ns < 20 ns

Frequency Minimum sensitivity
500 MHz - 10 GHz 40% x FS
15 GHz 80% x FS
20 GHz 100% x FS

7 Rearm time for transition trigger is time below lower threshold and time above upper threshold. Neither rearm time may be violated.
8 Maximum frequency for clock signal in state trigger type
9 Clock Active time refers to the minimum time from active to inactive edge. Clock Inactive refers to the minimum time from inactive to active clock edge. Active edge

is the edge that does the clocking, inactive edge is the other edge. For example, for positive edge clock, clock active time refers to the positive pulse width and clock
inactive refers to the negative pulse width.
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B trigger after events minimum
timing requirements (typical) Minimum pulse width Maximum counting frequency Minimum time between

channels
40 ps 3.5 GHz 1 ns

B trigger after events, event
counter range

1 to 2,000,000,000 

B trigger after time, time delay
range

3.2 ns to 3 Ms

Variable A-Event trigger
holdoff range

250 ns to 12 s + random holdoff

Lowest frequency for
successful set level to 50%
(typical)

50 Hz

Low speed serial trigger

Number of bits 128 bits

Baud rate limits (typical) 10 Mbaud

Serial trigger specifications
High speed serial trigger
number of bits

160 bits for 8b/10b and generic NRZ data rates between 600 MBd and 14.1 GBd

Serial interface triggering
standards supported

I2C, CAN, SPI, USB, PCIe, LIN, FlexRay, RS232/422/485/UART, MIL-STD-1553, 10/100BASE-T Ethernet

Serial trigger baud rate limits 600 MBd to 14.1 GBd

Serial trigger decoding types 8b10b, NRZ

Input-output port specifications
Auxiliary trigger input
characteristics and range

50 Ω, ±5 V (DC plus peak AC) 

Auxiliary output logic polarity
and functionality

Default output is A trigger low true (a negative edge when the A trigger event occurs). You can also program
the output to A trigger high true, and B trigger low or high true.

Auxiliary output logic levels Vout high Vout low (true)

≥2.5 V into 1 MΩ load,

≥1.0 V into 50 Ω load to ground

≤0.7 V into 1 MΩ load

≤0.25 V into 50 Ω load to ground

Fast Edge output step
amplitude and offset

1200 mV differential into a 100 Ω load with a -300 mV common mode.
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Fast Edge output step
frequency

1 kHz ± 20%

Fast Edge output step rise
time (typical)

30 ps directly into an input channel. To deskew a probe, use a 50 Ω terminator in series with the deskew
fixture to minimize HF aberrations.

Fast Edge output step
aberrations (typical)

≤ ± 1% after the first 500 ns following the square wave transition. To deskew a probe, use a 50 Ω terminator
in series with the deskew fixture to minimize HF aberrations.

Fast Edge output skew
between differential outputs.

<0.8 ps skew between Positive and Negative Fast Edge Outputs.

Jitter of internal Fast Edge
trigger (typical)

2 ps rms

External reference input
frequency

10 MHz, 100 MHz, 12.5 GHz

The instrument scans for either 10 MHz or 100 MHz. 12.5 GHz supported on separate SMA input.

External reference input
frequency variation tolerance
(typical)

Low (stable) jitter mode: ± 15 ppm

High (tracking) mode: ± 1%

Run SPC whenever the external reference is more than 0.1% (1000 ppm) different from the nominal
reference frequency or the reference at which SPC was last run.

External reference input
sensitivity (typical)

≥ 200 mVp-p (-10.0 dBm)

External reference input
voltage, maximum

2.8 Vp-p (+13 dBm)

External reference input
impedance (typical)

Rin = 50 Ω

12.5 GHz Clock In 1.3 Vp-p (6 dBm)

B, C, D 12.5 GHz Clock Out
(UltraSync)

1.3 Vp-p (6 dBm)

Internal reference output voltage (typical)

10 MHz Vout pk-pk > 800 mV peak-peak into 50 Ω

> 1.6 V peak-peak into 1 MΩ (internally AC coupled).

Input and output ports

DVI-D Video port A female Digital Visual Interface (DVI-D) compatible port

VGA port A female Video Graphics Array (VGA) compatible port

DisplayPort Two connectors (primary, secondary) provide digital display interfaces

PCIe PCIe ports to configure multi-instrument systems

Trigger UltraSync trigger bus

Keyboard and Mouse ports PS-2 compatible, instrument must be powered down to make connection

LAN ports Two RJ-45 connectors (LAN1, LAN2), support 10BASE-T, 100BASE-TX, and Gigabit Ethernet

External audio ports External audio jacks for microphone input and line output
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USB ports Four front panel USB 2.0 connectors

Four rear panel USB 3.0/USB 2.0 connectors

One rear panel USB device connector

USB 3.0 Device Port 5 GBit/sec Rx and Tx (USB Super Speed native)

480 Mbit/sec (High Speed compatible)

12 Mbit/sec (Full Speed compatible)

PCIe Device Port PCI Express x4 Gen 2

5 Gbits/s per lane, 4 lanes Rx, 4 lanes Tx per port

20 Gbits/s upstream, 20 Gbits/s downstream per port

40 Gbits/s aggregate per port

UltraSync

Input/Output ports UltraSync Trigger, Data, Clock Input, and Clock Output Ports

Maximum number of
UltraSync connected
Instruments

4 synchronized Instruments

3 extensions per master

Cable length 1 Meter or 2 Meters

Number of clock outputs 3 SMA clock output ports to extensions (ports B,C,D)

Number of clock inputs 1 SMA clock input port from master (port A)

Number of data ports 3 bidirectional PCIe Express data communication ports (ports B,C,D). Port D is referred to as Port A when the
instrument is operating as an extension and Port D when the instrument is operating as the master. iPASS
Mini-SAS x4 Connector.

Data port bandwidth PCI Express x4 Gen2. 20 Gbits/s upstream, 20 Gbits/s downstream per port. 5 Gbits/s per lane, 4 lanes Rx, 4
lanes Tx per port. 40 Gbits/s aggregate per port.

Number of trigger
connection ports

3 bidirectional acquisition control and trigger synchronization ports (ports B,C,D). Port D is referred to as Port A
when the instrument is operating as an extension and Port D when the instrument is operating as the master.

Crosstalk (channel
isolation)

Channel isolation between any 2 channels in an Ultrasync configuration that do not reside within the same
chassis.

Input frequency range (stay within BW of
instrument)

Isolation

0-70 GHz 70 dB

Data storage specifications
Nonvolatile memory retention
time (typical)

>20 years

Solid state drive Waveforms and setups are stored on the solid state drive.

Specifications

36



Solid state drive is a ≥900 GB solid state drive (removable).

Power source specification
Power consumption

<980 W, single instrument, maximum

≤780 W, single unit (typical)

Source voltage and frequency 100 V to 240 VRMS, 50/60 Hz

115 V ±10%, 400 Hz

CAT II

Mechanical specifications
Weight

DPO70000SX models 19 kg (42 lbs) oscilloscope only

Dimensions

DPO70000SX models
157 mm (6.0 in) height

452 mm (17.8 in) width

553 mm (21.8 in) depth

DPO70000SX models,
Rackmount configuration 177 mm (7.0 in) height

440 mm (19.75 in) width

523 mm (20.6 in) depth (from rack mounting ear to back of instrument)

Cooling

Required clearances Fan-forced air circulation with no air filter
Top 0 mm (0 in)
Bottom 6.35 mm (0.25 in) minimum or 0 mm (0 in) when

standing on feet, flip stands down

Left side 76 mm (3 in)
Table continued…
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Fan-forced air circulation with no air filter
Right side 76 mm (3 in)

Rear 0 mm (0 in) on rear feet

Construction material Chassis parts are constructed of aluminum alloy, front panel is constructed of plastic laminate, circuit boards
are constructed of glass laminate

Environmental specifications
Temperature

Operating +5 °C to +45 °C

Nonoperating -20 °C to +60 °C

Temperature

Operating +5 °C to +45 °C (41 °F to +113 °F), with 11 °C per hour maximum gradient, noncondensing, derated 1 °C per
300 meters (984.25 feet) above 1500 meters (4921.25 feet) altitude

Nonoperating -20 °C to +60 °C (-4 °F to +140 °F), with 20 °C/hour maximum gradient

Humidity

Operating 8% to 80% relative humidity at up to +32 °C (+90 °F)

5% to 45% relative humidity above +32 °C (+90 °F) up to +45 °C (+113 °F), noncondensing, and is limited by
a maximum wet-bulb temperature of +29.4 °C (+85 °F) (derates relative humidity to 32% at +45 °C (+113 °F)

Nonoperating 5% to 95% relative humidity at up to +30 °C (+86 °F),
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5% to 45% relative humidity above +30 °C (+86 °F), up to +60 °C (+140 °F), noncondensing, and is limited by
a maximum wet-bulb temperature of +29.4 °C (+85 °F) (derates relative humidity to 11% at +60 °C (+140 °F))

Altitude

Operating Up to 3,000 meters

Nonoperating Up to 12,000 meters

Altitude

Operating Up to 3,000 meters (9,843 feet), derate maximum operating temperature by 1 °C per 300 meters (984.25 feet)
above 1500 meters (4921.25 feet) altitude

Nonoperating Up to 12,000 meters (39,370 feet)
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Performance verification

Performance verification
Two types of Performance Verification procedures can be performed on these products: Brief Procedures and Performance Tests. You may
not need to perform all of these procedures, depending on what you want to accomplish.

If you are not familiar with operating this instrument, read the instrument user manual or explore the online help. 

• To rapidly confirm that the instrument functions and was adjusted properly, perform only the brief procedures under Self Tests.

Advantages. These procedures are quick to do, require no external equipment or signal sources, and perform extensive functional
and accuracy testing to provide high confidence that the instrument will perform properly. They can be used as a quick check before
making a series of important measurements.

• To further check functionality, first do the Self Tests just mentioned; then do the brief procedures under Functional Tests.

Advantages. These procedures require minimal additional time to perform, require no additional equipment other than cables and
adapters, and these procedures more completely test the internal hardware of the instrument. They can be used to quickly determine if
the instrument is suitable for putting into service, such as when it is first received.

• If more extensive confirmation of performance is desired, perform the Performance Tests after performing the Functional and Self Tests
mentioned above. Performance tests on page 47

Advantages. These procedures add direct checking of the warranted specifications that are marked with the  symbol. These
procedures require specific test equipment. Equipment required on page 48

Conventions
Throughout these procedures the following conventions apply:

• Each test procedure uses the following general format:

• Title of Test
• Equipment Required
• Prerequisites
• Procedure

• Each procedure consists of as many steps, substeps, and subparts as required to do the test. Steps, substeps, and subparts are
sequenced as follows:

1. First Step

a. First Substep

• First Subpart
• Second Subpart

b. Second Substep
2. Second Step

• In steps and substeps, the lead-in statement in italics instructs you what to do, while the instructions that follow tell you how to do it, as
in the example step below:

Initialize the instrument: Pull down the File menu, select Recall Default Setup.

STOP. The STOP notation at the left is accompanied by information you must read to do the procedure properly.
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• The term "toolbar" refers to a row of buttons at the top of the display. The term "menu bar" refers to a row of menus at the top of the
display. You can switch between toolbar and menu bar operating modes by using the menu at the top right of the toolbar or menu bar.
(See Figure 1 on page 41.)

• Item numbers in the equipment required lists refer to the equipment. (See Equipment required on page 48.)

Figure 1: Toolbar and menu bar

• The procedures assume you have connected a mouse to the instrument so you can click on the screen controls. If you have not
connected a mouse, you can use the touch screen to operate the screen controls.

Brief procedures
The Self Tests use internal routines to confirm basic functionality and proper adjustment. No test equipment is required to do these test
procedures. 

The Functional Tests utilize the probe-compensation output at the front panel as a test-signal source for further verifying that the instrument
functions properly. A BNC cable and an adaptor or a probe, depending on your instrument model are required to do these test procedures.

Self tests
This procedure uses internal routines to verify that the instrument functions and was adjusted properly. No test equipment or hookups are
required.

Equipment required Prerequisites

None Power on the instrument and allow a 20 minute warm-up before
doing this procedure.

1. Verify that internal diagnostics pass: Do the following substeps to verify passing of internal diagnostics.

a. Display the System diagnostics menu:

If the instrument is in toolbar mode, put the instrument into menu bar mode.

Pull down the Utilities menu and select Instrument Diagnostics. . . . This displays the diagnostics control window.
b. Run the System Diagnostics:

• First disconnect any input signals from all channels.
• Click the Run button in the diagnostics control window.
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c. Wait: The internal diagnostics do an exhaustive verification of proper instrument function. This verification may take several
minutes. When the verification is finished, the resulting status will appear in the diagnostics control window.

d. Verify that no failures are found and reported on-screen. All tests should pass.
e. Run the signal-path compensation routine:

Pull down the Utilities menu and select Instrument Calibration. . . . This displays the instrument calibration control window.

If required because the instrument is in service mode, select the Signal Path button under Calibration Area.

Click the Run SPC button to start the routine.
f. Wait: Signal-path compensation may take five to fifteen minutes to run.
g. Confirm signal-path compensation returns passed status: Verify that the word Pass appears in the instrument calibration control

window.
2. Return to regular service: Click the X (close) button to exit the instrument calibration control window.

Functional tests
The purpose of these procedures is to confirm that the instrument functions properly. The only equipment required is a BNC or SMA cable
and an adapter or the instrument probe. If you need to store settings during these procedures, access the local C: drive and store them in
the TekScope > Setups directory. 

STOP. These procedures verify functions; that is, they verify that the instrument features operate. They do not verify that they operate
within limits.

Therefore, when the instructions in the functional tests that follow call for you to verify that a signal appears on-screen "that is about five
divisions in amplitude" or "has a period of about six horizontal divisions," etc., do NOT interpret the quantities given as limits. Operation
within limits is checked in Performance Tests. (See Performance tests on page 47.)

STOP. DO NOT make changes to the front-panel settings that are not called out in the procedures. Each verification procedure will require
you to set the instrument to certain default settings before verifying functions. If you make changes to these settings, other than those
called out in the procedure, you may obtain invalid results. In this case, just redo the procedure from step 1.

When you are instructed to press a front-panel or screen button, the button may already be selected (its label will be highlighted). If this is
the case, it is not necessary to press the button.

Verify all analog input channels
Equipment required Prerequisites

One SMA cable (item 19 on page 50)

One adapter (item 18 on page 50)

One termination (item 4 on page 48)

one attenuator (item 3 on page 48)

None

1. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
2. Hook up the signal source: Connect the equipment as shown in the following figure to the channel input you want to test (beginning

with Ch 1). Terminate the unused Fast Edge output.
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Figure 2: Universal test hookup for functional tests - Ch 1 shown

3. Turn off all channels:

Pull down the Vertical menu, select Vertical Setup. Select each Channel tab and verify that the Display is off.
4. Select the channel to test: Press the Display button for the channel you are currently testing. The channel display comes on.
5. Set up the instrument:

Note: If the AutoSet Undo window appears, click the X.

• Pull down the Horiz/Acq menu, select Autoset. This sets the horizontal and vertical scale and vertical offset for a usable display
and sets the trigger source to the channel you are testing.

• Pull down the Vertical menu, select Vertical Setup. Confirm that the Ch1 Offset is about -300 mV.
6. Verify that the channel is operational: Confirm that the following statements are true.

• Verify that the vertical scale readout and the waveform amplitude for the channel under test. (See Table 2 on page 43.)

Table 2: Vertical settings

Setting Without probe ATI input with attenuator

Scale 100 mV 30 mV

Waveform amplitude about 4.5 to 6.5 divisions about 6 divisions

• The vertical Position control (for the channel you are testing) moves the signal up and down the screen.
• Increasing the vertical Scale (for the channel you are testing) decreases the amplitude of the waveform on-screen,

decreasing the scale increases the amplitude, and returning the scale to the original scale setting returns the original
amplitude for that scale setting. (See Table 2 on page 43.)

7. Verify that the channel acquires in all acquisition modes: Pull down the Horiz/Acq menu to select Horizontal/Acquisition Setup. . . .
Click the Acquisition tab in the control window that displays. Click each of the acquisition modes and confirm that the following
statements are true.

• Sample mode displays an actively acquiring waveform on-screen. (Note that there is a small amount of noise present on the
square wave).

• Peak Detect mode displays an actively acquiring waveform on-screen with the noise present in Sample mode "peak detected".
• Hi Res mode displays an actively acquiring waveform on-screen with the noise that was present in Sample mode reduced.
• Average mode displays an actively acquiring waveform on-screen with the noise reduced.
• Envelope mode displays an actively acquiring waveform on-screen with the noise displayed.

Note: Default setup enables enhanced triggering. Enhanced triggering can cause a slower acquisition rate that can be
noticed in waveform database mode. As waveform database mode acquires 100,000 samples, the display intensity will
increase, be cleared, and then the process will start over. When enhanced triggering is turned off, and with the specified
settings and input signal, the display reaches full intensity right away.
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• Waveform Database mode displays an actively acquiring waveform on-screen with the noise displayed.
8. Test all channels: Repeat steps 2 on page 42 through 7 on page 43 until all TekConnect input channels are verified.
9. If your instrument has an ATI input, repeat steps 2 on page 42 through 7 on page 43 with the Fast Edge signal connected to the ATI

input channel through an attenuator (you may need to adjust the position).
10. Remove the test hookup: Disconnect the equipment from the instrument.

Verify the time base
Equipment required Prerequisites

One SMA cable (item 19 on page 50)

One adapter (item 18 on page 50)

One termination (item 4 on page 48)

None

1. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
2. Hook up the signal source: Connect the fast edge output to the Ch 1 input as shown in the following figure. Terminate the unused Fast

Edge output.

Figure 3: Setup for time base test

3. Set up the instrument:Pull down the Horiz/Acq menu, select Autoset.
4. Set the Vertical Scale to 100 mV/div.
5. Set the time base: Set the horizontal Scale to 200  μs/div. The time-base readout is displayed at the bottom of the graticule.
6. Verify that the time base operates: Confirm the following statements.

• One period of the square-wave signal is about five horizontal divisions on-screen for the 200 μs/div horizontal scale setting.
• Decreasing the horizontal Scale expands the waveform on-screen (more horizontal divisions per waveform period), increasing the

scale contracts it, and returning the horizontal scale to 200 μs/div returns the period to about five divisions.
• Changing the horizontal Position positions the signal left and right on-screen.

7. Verify horizontal delay:

a. Center a rising edge on screen:

• Set the horizontal Position so that the rising edge where the waveform is triggered is lined up with the center horizontal
graticule.

• Change the horizontal Scale to 20  μs/div. The rising edge of the waveform should remain near the center graticule and the
falling edge should be off screen.

b. Turn on and set horizontal delay:

• Pull down the Horiz/Acq menu to select Horizontal/Acquisition Setup. . . .
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• Click the Horizontal tab in the control window that displays.
• Click the Delay Mode button to turn delay on.
• Double click the Horiz Delay control in the control window to display the pop-up keypad. Click the keypad buttons to set the

horizontal delay to 1 ms   and then click the ENTER key.
c. Verify the waveform: Verify that a rising edge of the waveform is within a few divisions of center screen.
d. Adjust the horizontal delay: Change the horizontal delay setting. Verify that the rising edge shifts horizontally.
e. Verify the delay toggle function:

• Adjust the delay setting to center the rising edge horizontally on the screen.
• Change the horizontal Scale to 40 ns/div. The rising edge of the waveform should remain near the center graticule.
• Readjust the delay setting to position the rising edge 2 divisions to the right of the center graticule line.
• Click the Delay Mode button several times to toggle delay off and on and back off again. Verify that the display switches

quickly between two different points in time (the rising edge shifts horizontally on the display).
8. Remove the test hookup: Disconnect the test hookup from the instrument.

Verify the A (Main) and B (Delayed) trigger systems
Equipment required Prerequisites

One SMA cable (item 19 on page 50)

One adapter (item 18 on page 50)

One termination (item 4 on page 48)

None

1. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
2. Hook up the signal source: Connect the probe fast edge output to the Ch 1 input as shown in the following figure. Terminate the

unused Fast Edge output.

Figure 4: Setup for trigger test

3. Set up the instrument: Pull down the Horiz/Acq menu, select Autoset.
4. Set the Vertical Scale to 120 mV/div.
5. Verify that the main trigger system operates: Confirm that the following statements are true.

• Pull down the Trig menu, select A Event (Main) Trigger Setup.
• The trigger level readout for the A (main) trigger system changes with the trigger-Level control.
• The trigger-Level control can trigger and untrigger the square-wave signal as you level setting. (Leave the signal untriggered).
• Pushing the Set to 50% button sets the trigger level to the 50% amplitude point of the signal and triggers the signal that you just

left untriggered. (Leave the signal triggered.)
6. Verify that the delayed trigger system operates:
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a. Set up the delayed trigger:

Pull down the Trig menu and select A – B Trigger Sequence. . . . This displays the A →B Sequence tab of the trigger setup
control window.

Click the Trig After Time button under A Then B.

Click the B Trig Level control in the control window.

Select the Options tab and then set the trigger mode to Norm.
b. Confirm that the following statements are true:

• The trigger-level readout for the B trigger system changes as you adjust the B trigger level.
• As you adjust the trigger level, the square-wave signal can become triggered and untriggered. (Leave the signal triggered.)

c. Verify the delayed trigger counter:

• Double click the Trigger Delay control to pop up a numeric keypad for that control.
• Click the keypad to enter a trigger delay time of 1 second (click 1 and None) and then click Enter.
• If you have the optional front panel, verify that the trigger Ready indicator on the front panel flashes about once every second

as the waveform is updated on-screen.
• If you do not have the optional front panel, verify that the number of acquisitions increases about once every second as the

waveform is updated on-screen.
7. Remove the test hookup: Disconnect the test hookup from the instrument.

Verify the file system
Equipment required Prerequisites

One SMA cable (item 19 on page 50)

One adapter (item 18 on page 50)

One termination (item 4 on page 48)

None

1. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
2. Hook up the signal source: Connect the fast edge output to the Ch 1 input as shown in the following figure. Terminate the unused Fast

Edge output.

Figure 5: Setup for the file system test

3. Set up the instrument: Pull down the Horiz/Acq menu, select Autoset.
4. Set the Vertical Scale to 120 mV/div.
5. Set the time base: Set the horizontal Scale to 1 ms/div. The time-base readout is displayed at the bottom of the graticule.
6. Save the settings:
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a. Pull down the File menu to select Save As. . . >Setup. . . . This displays the instrument Save As control window.
b. Note the default location and file name and then click the Save button to save the setup to the default file name and location.

7. Change the settings again: Set the horizontal SCALE to 200 μs/div.
8. Verify the file system works:

a. Pull down the File menu to select Recall. This displays the instrument Recall control window.
b. Click Recall What > Setup.
c. Locate and then double click the setup file that you previously stored.
d. Verify that the instrument retrieved the saved setup. Do this by noticing the horizontal SCALE is again 1 ms and the waveform

shows ten cycles just as it did when you saved the setup.
9. Remove the test hookup: Disconnect the test hookup from the instrument.

Performance tests
This section contains a collection of manual procedures for checking that the instrument performs as warranted. 

The procedures are arranged in logical groupings: Signal Acquisition System Checks, Time Base System Checks, Triggering System
Checks, and Output Ports Checks. They check all the characteristics that are designated as checked in Specifications. (The characteristics
that are checked appear with a  in Specifications).

STOP. These procedures extend the confidence level provided by the basic procedures. The basic procedures should be done first, then
these procedures performed if desired.

CAUTION:

Using settings not asked for by these procedures could damage the instrument. These procedures operate the instrument near its
maximum limits. Using settings similar to, but not the settings called for by the procedures, could damage the input circuitry of the
instrument. See the Maximum input voltage specification for the maximum nondestructive input voltage level.

Prerequisites
The tests in this section comprise an extensive, valid confirmation of performance and functionality when the following requirements are
met:

• The cabinet must be installed on the instrument.
• You must have performed and passed the procedures under Self Tests, and those under Functional Tests. (See Functional

tests on page 42.)
• A signal-path compensation must have been done within the recommended calibration interval and at a temperature within ±5 ºC

(±9 ºF) of the present operating temperature. (If at the time you did the prerequisite Self Tests, the temperature was within the limits
just stated, consider this prerequisite met). A signal-path compensation must have been done at an ambient humidity within 25% of the
current ambient humidity and after having been at that humidity for at least 4 hours.

• The instrument must have been last adjusted at an ambient temperature between +18 °C (+64 °F) and +28 °C (+82 °F), and must
have been operating for a warm-up period of at least 20 minutes (60 minutes for the DPO70000SX instruments if the humidity is
>60%), and, unless otherwise noted in the procedure, the performance tests may be run with the instrument operating at an ambient
temperature between +18 °C (+64 °F) and +28 °C (+82 °F). (The warm-up requirement is usually met in the course of meeting the Self
Tests and Functional Tests prerequisites listed above).

• Support sensor, probe, and adapter setups to avoid stress or torque when connected to the device under test (DUT).
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Equipment required
The performance verification procedures use external, traceable signal sources to directly check warranted characteristics. The following
table lists the required equipment.

1. Attenuator, 10X (two required)

Minimum requirements Example Purpose

Ratio: 10X; impedance 50 Ω; connectors:
female input, male output

BNC ≤ 2 GHz Tektronix part number
011-0059-03 

SMA ≤ 18 GHz Tektronix part number
015-1003-00 

Signal attenuation, bandwidth, trigger
sensitivity

2. Attenuator, 5X

Ratio: 5X; impedance 50 Ω; connectors:
female input, male output

BNC ≤ 2 GHz Tektronix part number
011-0060-02 

SMA ≤ 18 GHz Tektronix part number
015-1002-01 

Signal attenuation, bandwidth, trigger
sensitivity

3. Attenuator, 10 dB

2.92 mm female to 2.92 mm male, 50 Ω,
10 dB, 2 Watts

2.92 mm ≤ 40 GHz Tektronix part number
011-0221-00 

Signal attenuation

4. Termination, 50 Ω

Impedance 50 Ω; connector: male SMA Tektronix part number
015-1022-01 (18 GHz)

Signal termination for channel delay test,
trigger sensitivity

5. Cable, Precision 50 Ω Coaxial (three required)

50 Ω, 36 in, male-to-male BNC connectors Tektronix part number 012-0482-00 Signal interconnection, Trigger out, time
qualified trigger, timebase delay time,
bandwidth, input resistance, delta time,
generator leveling

6. Connector, Dual-Banana (two required)

Female BNC-to-dual banana Tektronix part number 103-0090-00 Various accuracy tests, input resistance

7. Generator, DC Calibration

Variable amplitude to ±7 V; accuracy to
0.1%

Keithly 2400 Checking DC offset, gain, measurement
accuracy, probe compensation out, and
maximum input voltage

8. Timer-counter

10 MHz and 100 MHz, 1 s gate Tektronix FCA3000 with Option MS Checking long-term sample rate and delay
time accuracy
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9. Generator, Sine-Wave

TekConnect channels:50 MHz to at
least the instrument bandwidth. Variable
amplitude from 60 mV to 2.0 Vp-p into
50 Ω. Frequency error <2.0%

Anritsu MG3690C RF/Microwave Signal
Generator

Checking analog bandwidth, trigger
sensitivity, sample-rate, external clock,
trigger sensitivity, time qualified trigger,
and delay-time accuracy

ATI channel: 100 MHz to at least the
instrument bandwidth. Variable amplitude
from 60 mV to 2.0 Vp-p into 50 Ω.
Frequency error <2.0%

Anritsu MG3697C RF/Microwave Signal
Generator

10. Meter, Level and Power Sensor

TekConnect channels, frequency range:
50 MHz to the instrument bandwidth.
Amplitude range: 6 mVp-p to 2 Vp-p

Rohde & Schwarz NRVS and NRV-Z15
(40 GHz)

Checking analog bandwidth and trigger
sensitivity

ATI channel, frequency range: 100 MHz
to the instrument bandwidth. Amplitude
range: 6 mVp-p to 2 Vp-p

Rhode & Schwartz NRP2 and NRP-Z57
(67 GHz)

11. Splitter, Power

Instrument bandwidth ≤3 GHz: Frequency
range: DC to 18 GHz. Tracking: <2.0%

Agilent part number 11667A Checking analog bandwidth and trigger
sensitivity

Instrument bandwidth >3 GHz: Frequency
range: DC to 40 GHz. Tracking: <2.0%

Anritsu K241C (40 GHz)

12. Cable

2.92 mm male-to-female Gore PhaseFlex cable EL0CQ0CP0360
(40 GHz)

Checking analog bandwidth

13. Adapter

K male-to-male DC to 40 GHz Anritsu K220B Checking analog bandwidth

14. Adapter (four required)

Male N-to-female BNC Tektronix part number 103-0045-00 Checking analog bandwidth

15. Adapter (three required)

SMA female-to-female Tektronix part number
015-1012-00 (18 GHz)

Checking trigger sensitivity

16. Adapter (three required)

SMA male-to-female BNC Tektronix part number 015-1018-00 Checking the delay between channels,
delta time

17. Adapter
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BNC to Minigrabber Tektronix part number 013-0342-xx Checking fast edge output

18. Adapter (four required)

SMA male-to-BNC female TCA-BNC or TCA-292mm and, if
required, SMA male-to-BNC female
adapter (Tektronix part number
015-0554-00 (4 GHz) or 015-1018-00)

Signal interconnection, measurement
accuracy, delay time, time qualified
trigger, trigger sensitivity, DC gain, offset,
bandwidth, input resistance, fast edge out

TCA-292D

19. Cable, Coaxial (three required)

50 Ω, 20 in, male-to-male SMA connectors Tektronix part number 174-1427-00 Checking delta time measurement
accuracy, fast edge out, trigger sensitivity

20. Adapter

SMA "T", male to 2 SMA female Tektronix part number
015-1016-00 (18 GHz)

Checking delta time measurement
accuracy

21. Adapter

SMA female to BNC male Tektronix part number
015-0572-00 (4 GHz)

Used to test delta time measurement
accuracy and trigger sensitivity

22. Termination

Short circuit, SMA connector, female Tektronix part number
015-1021-00 (18 GHz)

Checking delta time measurement
accuracy

23. Attenuator, 2X

Ratio: 2X; impedance 50 Ω; connectors:
female BNC input, male BNC output

Tektronix part number
011-0069-02 (2 GHz)

Checking delta time measurement
accuracy, pulse trigger accuracy, time
qualified trigger, trigger sensitivity, and
channel isolation

24. Digital Multimeter

Ohms: <60 Ohms Keithley 2700 Checking input impedance

25. Adapter

BNC “T”, male to 2 females Tektronix part number 103-0030-xx Checking DC gain and offset accuracy

26. Attenuator 2X

Ratio: 2X; impedance 50 Ω; connectors:
female input, male output

BNC ≤ 2 GHz Tektronix part number
011-0069-xx

Checking output signals

27. Connector saver

Connector saver; ATI; 1.85 mm Tektronix part number 103-0474-xx ATI connector protection
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28. Torque wrench

Torque wrench Tektronix part number 067-2362-xx Making connections

29. Backing wrench

Backing wrench; ATI connector saver Tektronix part number 103-1942-xx Making connections

30. Adapter

40 GHz, 1.85 mm female to 2.92 mm
female

Tektronix part number 103-0483-xx Making connections

18 GHz, 1.85 mm female to SMA female Tektronix part number 103-0484-xx

31. Cable, coaxial

1.85 mm male to 1.85 mm female Gore 0F0CA0CB036.0 Checking bandwidth

Test record
Photocopy the test record tables and use them to record the performance test results for your instrument. 

Table 3: Test information

Item Recorded value

Instrument Serial Number

Technician

Certificate Number

Date of Calibration

Temperature

RH %
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DC voltage measurement accuracy (averaged), ATI channel

Instrument performance test Minimum Incoming Outgoing Maximum

Ch2 10 mV Vert scale setting, 0 Div position setting

0 V offset, +30 mV input

0 V offset, -30 mV input

-0.2 V offset, -170 mV input

+0.2 V offset, 170 mV input

+0.2 V offset, 230 mV input

-0.2 V offset, -230 mV input

    

26.0 mV

-34.0 mV

-174.7 mV

+165.3 mV

225.3 V

-234.7 mV

    

__________

__________

__________

__________

__________

__________

    

__________

__________

__________

__________

__________

__________

    

34.0 mV

-26.0 mV

-165.3 mV

+174.7 mV

234.7 mV

-225.3 V

Ch2 20 mV Vert scale setting, 0 Div position setting

0 V offset, 60 mV input

0 V offset, -60 mV input

-0.1 V offset, -40 mV input

+0.1 V offset, 40 mV input

+0.1 V offset, 160 mV input

-0.1 V offset, -160 mV input

    

54.0 mV

-66.0 mV

-46.4 mV

+33.7 mV

153.7 mV

-166.4 mV

    

__________

__________

__________

__________

__________

__________

    

__________

__________

__________

__________

__________

__________

    

66.0 mV

-54.0 mV

-33.7 mV

+46.4 mV

166.4 mV

-153.7 mV

Ch2 30 mV Vert scale setting, 0 Div position setting

0 V offset, 90 mV input

0 V offset, -90 mV input

    

82.0 mV

-98.0 mV

    

__________

__________

    

__________

__________

    

98.0 mV

-82.0 mV
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch1 6.25 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 18.75 mV input

0 V offset, -18.75 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

 

 

3.4012 V

2.4032 V

 

2.503 V

1.509 V

511.0 mV

 

15.0 mV

-22.5 mV

-991 mV

1.009 V

 

-3.3988 V

-2.3968 V

 

-2.497 V

-1.491 V

-489 mV

 

 

__________

__________

 

__________

__________

__________

 

__________

__________

__________

__________

 

__________

__________

 

__________

__________

__________

 

 

__________

__________

 

__________

__________

__________

 

__________

__________

__________

__________

 

__________

__________

 

__________

__________

__________

 

 

3.4363 V

2.4343 V

 

2.5345 V

1.5285 V

526.5 mV

 

22.5 mV

-15.0 mV

-971.5 mV

1.0285 V

 

-3.3637 V

-2.3657 V

 

-2.4655 V

-1.4715 V

-473.5 mV

Table continued…

Performance verification
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch1 10 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 30 mV input

0 V offset, -30 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.4117 V

2.4137 V

    

2.5135 V

1.5195 V

521.5 mV

    

25.5 mV

-34.5 mV

-980.5 mV

1.0195 V

    

-3.3883 V

-2.3863 V

    

-2.4865 V

-1.4805 V

-478.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.4483 V

2.4463 V

    

2.5465 V

1.5405 V

538.5 mV

    

34.5 mV

-25.5 mV

-959.5 mV

1.0405 V

    

-3.3517 V

-2.3537 V

    

-2.4535 V

-1.4595 V

-461.5 mV

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch1 20 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 60 mV input

0 V offset, -60 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.4397 V

2.4417 V

    

2.5415 V

1.5475 V

549.5 mV

    

53.5 mV

-66.5 mV

-952.5 mV

1.0475 V

    

-3.3603 V

-2.3583 V

    

-2.4585 V

-1.4525 V

-450.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.4803 V

2.4783 V

    

2.5785 V

1.5725 V

570.5 mV

    

66.5 mV

-53.5 mV

-927.5 mV

1.0725 V

    

-3.3197 V

-2.3217 V

    

-2.4215 V

-1.4275 V

-429.5 mV

Table continued…

Performance verification
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch1 50 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 150 mV input

0 V offset, -150 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.5237 V

2.5257 V

    

2.6255 V

1.6315 V

633.5 mV

    

137.5 mV

-162.5 mV

-868.5 mV

1.1315 V

    

-3.2763 V

-2.2745 V

    

-2.3745 V

-1.3685 V

-366.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.5763 V

2.5743 V

    

2.6745 V

1.6685 V

666.5 mV

    

162.5 mV

-137.5 mV

-831.5 mV

1.1685 V

    

-3.2237 V

-2.2257 V

    

-2.3255 V

-1.3315 V

-333.5 mV

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch1 100 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 300 mV input

0 V offset, -300 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.6637 V

2.6657 V

    

2.7655 V

1.7715 V

773.5 mV

    

277.5 mV

-322.5 mV

-728.5 mV

1.2715 V

    

-3.1363 V

-2.1343 V

    

-2.2345 V

-1.2285 V

-226.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.7363 V

2.7343 V

    

2.8345 V

1.8285 V

826.5 mV

    

322.5 mV

-277.5 mV

-671.5 mV

1.3285 V

    

-3.0637 V

-2.0657 V

    

-2.1655 V

-1.1715 V

-173.5 mV

Table continued…

Performance verification
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch1 120 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 360 mV input

0 V offset, -360 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.7197 V

2.7217 V

    

2.8215 V

1.8275 V

829.5 mV

    

333.5 mV

-386.5 mV

-672.5 mV

1.3275 V

    

-3.0803 V

-2.0783 V

    

-2.1785 V

-1.1725 V

-170.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.8003 V

2.7983 V

    

2.8985 V

1.8925 V

890.5 mV

    

386.5 mV

-333.5 mV

-607.5 mV

1.3925 V

    

-2.9997 V

-2.0017 V

    

-2.1015 V

-1.1075 V

-109.5 mV

Ch1 140 mV Vert scale setting, 0 Div position setting

0 V termination

–1 V offset

0 V offset

+1 V offset

    

    

-627.4 mV

378.6 mV

1.3726 V

    

    

__________

__________

__________

    

    

__________

__________

__________

    

    

-532.6 mV

461.4 mV

1.4674 V

Ch1 200 mV Vert scale setting, 0 Div position setting

0 V termination

–1 V offset

0 V offset

+1 V offset

    

    

-459.4 mV

546.6 mV

1.5406 V

    

    

__________

__________

__________

    

    

__________

__________

__________

    

    

-340.6 mV

653.4 mV

1.6594 V

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch1 400 mV Vert scale setting, 0 Div position setting

0 V termination

–1 V offset

0 V offset

+1 V offset

    

    

100.6 mV

1.1066 V

2.1006 V

    

    

__________

__________

__________

    

    

__________

__________

__________

    

    

299.4 mV

1.2934 V

2.2994 V

Ch2 6.25 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 18.75 mV input

0 V offset, -18.75 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

 

 

3.4012 V

2.4032 V

 

2.503 V

1.509 V

511.0 mV

 

15.0 mV

-22.5 mV

-991 mV

1.009 V

 

-3.3988 V

-2.3968 V

 

-2.497 V

-1.491 V

-489 mV

 

 

__________

__________

 

__________

__________

__________

 

__________

__________

__________

__________

 

__________

__________

 

__________

__________

__________

 

 

__________

__________

 

__________

__________

__________

 

__________

__________

__________

__________

 

__________

__________

 

__________

__________

__________

 

 

3.4363 V

2.4343 V

 

2.5345 V

1.5285 V

526.5 mV

 

22.5 mV

-15.0 mV

-971.5 mV

1.0285 V

 

-3.3637 V

-2.3657 V

 

-2.4655 V

-1.4715 V

-473.5 mV

Table continued…

Performance verification
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch2 10 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 30 mV input

0 V offset, -30 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.4117 V

2.4137 V

    

2.5135 V

1.5195 V

521.5 mV

    

25.5 mV

-34.5 mV

-980.5 mV

1.0195 V

    

-3.3883 V

-2.3863 V

    

-2.4865 V

-1.4805 V

-478.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.4483 V

2.4463 V

    

2.5465 V

1.5405 V

538.5 mV

    

34.5 mV

-25.5 mV

-959.5 mV

1.0405 V

    

-3.3517 V

-2.3537 V

    

-2.4535 V

-1.4595 V

-461.5 mV

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch2 20 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 60 mV input

0 V offset, -60 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.4397 V

2.4417 V

    

2.5415 V

1.5475 V

549.5 mV

    

53.5 mV

-66.5 mV

-952.5 mV

1.0475 V

    

-3.3603 V

-2.3583 V

    

-2.4585 V

-1.4525 V

-450.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.4803 V

2.4783 V

    

2.5785 V

1.5725 V

570.5 mV

    

66.5 mV

-53.5 mV

-927.5 mV

1.0725 V

    

-3.3197 V

-2.3217 V

    

-2.4215 V

-1.4275 V

-429.5 mV

Table continued…

Performance verification
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch2 50 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 150 mV input

0 V offset, -150 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.5237 V

2.5257 V

    

2.6255 V

1.6315 V

633.5 mV

    

137.5 mV

-162.5 mV

-868.5 mV

1.1315 V

    

-3.2763 V

-2.2745 V

    

-2.3745 V

-1.3685 V

-366.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.5763 V

2.5743 V

    

2.6745 V

1.6685 V

666.5 mV

    

162.5 mV

-137.5 mV

-831.5 mV

1.1685 V

    

-3.2237 V

-2.2257 V

    

-2.3255 V

-1.3315 V

-333.5 mV

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch2 100 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 300 mV input

0 V offset, -300 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.6637 V

2.6657 V

    

2.7655 V

1.7715 V

773.5 mV

    

277.5 mV

-322.5 mV

-728.5 mV

1.2715 V

    

-3.1363 V

-2.1343 V

    

-2.2345 V

-1.2285 V

-226.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.7363 V

2.7343 V

    

2.8345 V

1.8285 V

826.5 mV

    

322.5 mV

-277.5 mV

-671.5 mV

1.3285 V

    

-3.0637 V

-2.0657 V

    

-2.1655 V

-1.1715 V

-173.5 mV

Table continued…

Performance verification
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch2 120 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 360 mV input

0 V offset, -360 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.7197 V

2.7217 V

    

2.8215 V

1.8275 V

829.5 mV

    

333.5 mV

-386.5 mV

-672.5 mV

1.3275 V

    

-3.0803 V

-2.0783 V

    

-2.1785 V

-1.1725 V

-170.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.8003 V

2.7983 V

    

2.8985 V

1.8925 V

890.5 mV

    

386.5 mV

-333.5 mV

-607.5 mV

1.3925 V

    

-2.9997 V

-2.0017 V

    

-2.1015 V

-1.1075 V

-109.5 mV

Ch2 140 mV Vert scale setting, 0 Div position setting

0 V termination

–1 V offset

0 V offset

+1 V offset

    

    

-627.4 mV

378.6 mV

1.3726 V

    

    

__________

__________

__________

    

    

__________

__________

__________

    

    

-532.6 mV

461.4 mV

1.4674 V

Ch2 200 mV Vert scale setting, 0 Div position setting

0 V termination

–1 V offset

0 V offset

+1 V offset

    

    

-459.4 mV

546.6 mV

1.5406 V

    

    

__________

__________

__________

    

    

__________

__________

__________

    

    

-340.6 mV

653.4 mV

1.6594 V

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch2 400 mV Vert scale setting, 0 Div position setting

0 V termination

–1 V offset

0 V offset

+1 V offset

    

    

100.6 mV

1.1066 V

2.1006 V

    

    

__________

__________

__________

    

    

__________

__________

__________

    

    

299.4 mV

1.2934 V

2.2994 V

Ch3 6.25 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 18.75 mV input

0 V offset, -18.75 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

 

 

3.4012 V

2.4032 V

 

2.503 V

1.509 V

511.0 mV

 

15.0 mV

-22.5 mV

-991 mV

1.009 V

 

-3.3988 V

-2.3968 V

 

-2.497 V

-1.491 V

-489 mV

 

 

__________

__________

 

__________

__________

__________

 

__________

__________

__________

__________

 

__________

__________

 

__________

__________

__________

 

 

__________

__________

 

__________

__________

__________

 

__________

__________

__________

__________

 

__________

__________

 

__________

__________

__________

 

 

3.4363 V

2.4343 V

 

2.5345 V

1.5285 V

526.5 mV

 

22.5 mV

-15.0 mV

-971.5 mV

1.0285 V

 

-3.3637 V

-2.3657 V

 

-2.4655 V

-1.4715 V

-473.5 mV

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch3 10 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 30 mV input

0 V offset, -30 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.4117 V

2.4137 V

    

2.5135 V

1.5195 V

521.5 mV

    

25.5 mV

-34.5 mV

-980.5 mV

1.0195 V

    

-3.3883 V

-2.3863 V

    

-2.4865 V

-1.4805 V

-478.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.4483 V

2.4463 V

    

2.5465 V

1.5405 V

538.5 mV

    

34.5 mV

-25.5 mV

-959.5 mV

1.0405 V

    

-3.3517 V

-2.3537 V

    

-2.4535 V

-1.4595 V

-461.5 mV

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch3 20 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 60 mV input

0 V offset, -60 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.4397 V

2.4417 V

    

2.5415 V

1.5475 V

549.5 mV

    

53.5 mV

-66.5 mV

-952.5 mV

1.0475 V

    

-3.3603 V

-2.3583 V

    

-2.4585 V

-1.4525 V

-450.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.4803 V

2.4783 V

    

2.5785 V

1.5725 V

570.5 mV

    

66.5 mV

-53.5 mV

-927.5 mV

1.0725 V

    

-3.3197 V

-2.3217 V

    

-2.4215 V

-1.4275 V

-429.5 mV

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch3 50 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 150 mV input

0 V offset, -150 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.5237 V

2.5257 V

    

2.6255 V

1.6315 V

633.5 mV

    

137.5 mV

-162.5 mV

-868.5 mV

1.1315 V

    

-3.2763 V

-2.2745 V

    

-2.3745 V

-1.3685 V

-366.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.5763 V

2.5743 V

    

2.6745 V

1.6685 V

666.5 mV

    

162.5 mV

-137.5 mV

-831.5 mV

1.1685 V

    

-3.2237 V

-2.2257 V

    

-2.3255 V

-1.3315 V

-333.5 mV

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch3 100 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 300 mV input

0 V offset, -300 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.6637 V

2.6657 V

    

2.7655 V

1.7715 V

773.5 mV

    

277.5 mV

-322.5 mV

-728.5 mV

1.2715 V

    

-3.1363 V

-2.1343 V

    

-2.2345 V

-1.2285 V

-226.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.7363 V

2.7343 V

    

2.8345 V

1.8285 V

826.5 mV

    

322.5 mV

-277.5 mV

-671.5 mV

1.3285 V

    

-3.0637 V

-2.0657 V

    

-2.1655 V

-1.1715 V

-173.5 mV

Table continued…

Performance verification
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch3 120 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 360 mV input

0 V offset, -360 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.7197 V

2.7217 V

    

2.8215 V

1.8275 V

829.5 mV

    

333.5 mV

-386.5 mV

-672.5 mV

1.3275 V

    

-3.0803 V

-2.0783 V

    

-2.1785 V

-1.1725 V

-170.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.8003 V

2.7983 V

    

2.8985 V

1.8925 V

890.5 mV

    

386.5 mV

-333.5 mV

-607.5 mV

1.3925 V

    

-2.9997 V

-2.0017 V

    

-2.1015 V

-1.1075 V

-109.5 mV

Ch3 140 mV Vert scale setting, 0 Div position setting

0 V termination

–1 V offset

0 V offset

+1 V offset

    

    

-627.4 mV

378.6 mV

1.3726 V

    

    

__________

__________

__________

    

    

__________

__________

__________

    

    

-532.6 mV

461.4 mV

1.4674 V

Ch3 200 mV Vert scale setting, 0 Div position setting

0 V termination

–1 V offset

0 V offset

+1 V offset

    

    

-459.4 mV

546.6 mV

1.5406 V

    

    

__________

__________

__________

    

    

__________

__________

__________

    

    

-340.6 mV

653.4 mV

1.6594 V

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch3 400 mV Vert scale setting, 0 Div position setting

0 V termination

–1 V offset

0 V offset

+1 V offset

    

    

100.6 mV

1.1066 V

2.1006 V

    

    

__________

__________

__________

    

    

__________

__________

__________

    

    

299.4 mV

1.2934 V

2.2994 V

Ch4 6.25 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 18.75 mV input

0 V offset, -18.75 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

 

 

3.4012 V

2.4032 V

 

2.503 V

1.509 V

511.0 mV

 

15.0 mV

-22.5 mV

-991 mV

1.009 V

 

-3.3988 V

-2.3968 V

 

-2.497 V

-1.491 V

-489 mV

 

 

__________

__________

 

__________

__________

__________

 

__________

__________

__________

__________

 

__________

__________

 

__________

__________

__________

 

 

__________

__________

 

__________

__________

__________

 

__________

__________

__________

__________

 

__________

__________

 

__________

__________

__________

 

 

3.4363 V

2.4343 V

 

2.5345 V

1.5285 V

526.5 mV

 

22.5 mV

-15.0 mV

-971.5 mV

1.0285 V

 

-3.3637 V

-2.3657 V

 

-2.4655 V

-1.4715 V

-473.5 mV

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch4 10 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 30 mV input

0 V offset, -30 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.4117 V

2.4137 V

    

2.5135 V

1.5195 V

521.5 mV

    

25.5 mV

-34.5 mV

-980.5 mV

1.0195 V

    

-3.3883 V

-2.3863 V

    

-2.4865 V

-1.4805 V

-478.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.4483 V

2.4463 V

    

2.5465 V

1.5405 V

538.5 mV

    

34.5 mV

-25.5 mV

-959.5 mV

1.0405 V

    

-3.3517 V

-2.3537 V

    

-2.4535 V

-1.4595 V

-461.5 mV

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch4 20 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 60 mV input

0 V offset, -60 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.4397 V

2.4417 V

    

2.5415 V

1.5475 V

549.5 mV

    

53.5 mV

-66.5 mV

-952.5 mV

1.0475 V

    

-3.3603 V

-2.3583 V

    

-2.4585 V

-1.4525 V

-450.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.4803 V

2.4783 V

    

2.5785 V

1.5725 V

570.5 mV

    

66.5 mV

-53.5 mV

-927.5 mV

1.0725 V

    

-3.3197 V

-2.3217 V

    

-2.4215 V

-1.4275 V

-429.5 mV

Table continued…

Performance verification
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch4 50 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 150 mV input

0 V offset, -150 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.5237 V

2.5257 V

    

2.6255 V

1.6315 V

633.5 mV

    

137.5 mV

-162.5 mV

-868.5 mV

1.1315 V

    

-3.2763 V

-2.2745 V

    

-2.3745 V

-1.3685 V

-366.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.5763 V

2.5743 V

    

2.6745 V

1.6685 V

666.5 mV

    

162.5 mV

-137.5 mV

-831.5 mV

1.1685 V

    

-3.2237 V

-2.2257 V

    

-2.3255 V

-1.3315 V

-333.5 mV

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch4 100 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 300 mV input

0 V offset, -300 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.6637 V

2.6657 V

    

2.7655 V

1.7715 V

773.5 mV

    

277.5 mV

-322.5 mV

-728.5 mV

1.2715 V

    

-3.1363 V

-2.1343 V

    

-2.2345 V

-1.2285 V

-226.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.7363 V

2.7343 V

    

2.8345 V

1.8285 V

826.5 mV

    

322.5 mV

-277.5 mV

-671.5 mV

1.3285 V

    

-3.0637 V

-2.0657 V

    

-2.1655 V

-1.1715 V

-173.5 mV

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch4 120 mV Vert scale setting, 0 Div position setting

+3.5 V termination

+3.4 V offset

+2.4 V offset

+1.5 V termination

+2.5 V offset

+1.5 V offset

+0.5 V offset

0 V termination

0 V offset, 360 mV input

0 V offset, -360 mV input

-1 V offset

+1 V offset

-3.5 V termination

-3.4 V offset

-2.4 V offset

-1.5 V termination

-2.5 V offset

-1.5 V offset

-0.5 V offset

    

    

3.7197 V

2.7217 V

    

2.8215 V

1.8275 V

829.5 mV

    

333.5 mV

-386.5 mV

-672.5 mV

1.3275 V

    

-3.0803 V

-2.0783 V

    

-2.1785 V

-1.1725 V

-170.5 mV

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

__________

__________

    

__________

__________

__________

    

__________

__________

__________

__________

    

__________

__________

    

__________

__________

__________

    

    

3.8003 V

2.7983 V

    

2.8985 V

1.8925 V

890.5 mV

    

386.5 mV

-333.5 mV

-607.5 mV

1.3925 V

    

-2.9997 V

-2.0017 V

    

-2.1015 V

-1.1075 V

-109.5 mV

Ch4 140 mV Vert scale setting, 0 Div position setting

0 V termination

–1 V offset

0 V offset

+1 V offset

    

    

-627.4 mV

378.6 mV

1.3726 V

    

    

__________

__________

__________

    

    

__________

__________

__________

    

    

-532.6 mV

461.4 mV

1.4674 V

Ch4 200 mV Vert scale setting, 0 Div position setting

0 V termination

–1 V offset

0 V offset

+1 V offset

    

    

-459.4 mV

546.6 mV

1.5406 V

    

    

__________

__________

__________

    

    

__________

__________

__________

    

    

-340.6 mV

653.4 mV

1.6594 V

Table continued…
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DC voltage measurement accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch4 400 mV Vert scale setting, 0 Div position setting

0 V termination

–1 V offset

0 V offset

+1 V offset

    

    

100.6 mV

1.1066 V

2.1006 V

    

    

__________

__________

__________

    

    

__________

__________

__________

    

    

299.4 mV

1.2934 V

2.2994 V

DC gain accuracy (averaged), ATI channel

Instrument performance test Minimum Incoming Outgoing Maximum

Ch2 10 mV Vert scale setting,

0 Div position setting, 0 V offset

0 Div position setting, +0.2 V offset

0 Div position setting, -0.2 V offset

 

+76.44 mV

+76.44 mV

+76.44 mV

 

__________

__________

__________

 

__________

__________

__________

 

+79.56 mV

+79.56 mV

+79.56 mV

Ch2 20 mV Vert scale setting,

0 Div position setting, 0 V offset

0 Div position setting, +0.1 V offset

0 Div position setting, -0.1 V offset

 

+152.9 mV

+152.9 mV

+152.9 mV

 

__________

__________

__________

 

__________

__________

__________

 

+159.1 mV

+159.1 mV

+159.1 mV

Ch2 30 mV Vert scale setting,

0 Div position setting, 0 V offset

 

+ 176.4 mV

 

__________

 

__________

 

+ 183.6 mV

Performance verification

DPO70000SX Series Oscilloscopes Specifications and Performance Verification 77



DC gain accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch1 6.25 mV Vert scale setting

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+48.02 mV

+48.02 mV

+48.02 mV

 

+48.02 mV

+48.02 mV

 

+48.02 mV

+48.02 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+49.98 mV

+49.98 mV

+49.98 mV

 

+49.98 mV

+49.98 mV

 

+49.98 mV

+49.98 mV

Ch1 10 mV Vert scale setting,

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+76.44 mV

+76.44 mV

+76.44 mV

 

+76.44 mV

+76.44 mV

 

+76.44 mV

+76.44 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+79.56 mV

+79.56 mV

+79.56 mV

 

+79.56 mV

+79.56 mV

 

+79.56 mV

+79.56 mV
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DC gain accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch1 20 mV Vert scale setting,

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+152.9 mV

+152.9 mV

+152.9 mV

 

+152.9 mV

+152.9 mV

 

+152.9 mV

+152.9 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+159.1 mV

+159.1 mV

+159.1 mV

 

+159.1 mV

+159.1 mV

 

+159.1 mV

+159.1 mV

Ch1 50 mV Vert scale setting,

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+382.2 mV

+382.2 mV

+382.2 mV

 

+382.2 mV

+382.2 mV

 

+382.2 mV

+382.2 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+397.8 mV

+397.8 mV

+397.8 mV

 

+397.8 mV

+397.8 mV

 

+397.8 mV

+397.8 mV
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DC gain accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch1 100 mV Vert scale setting,

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+764 mV

+764 mV

+764 mV

 

+764 mV

+764 mV

 

+764 mV

+764 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+796 mV

+796 mV

+796 mV

 

+796 mV

+796 mV

 

+796 mV

+796 mV

Ch1 120 mV Vert scale setting,

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

–5 Div position setting, +3.4 V offset

—5Div position setting, +2.4 V offset

-3.4 V termination

5 Div position setting, -3.4 V offset

5Div position setting, -2.4 V offset

 

 

+917.3 mV

+917.3 mV

+917.3 mV

 

+917.3 mV

+917.3 mV

 

+917.3 mV

+917.3 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+954.7 mV

+954.7 mV

+954.7 mV

 

+954.7 mV

+954.7 mV

 

+954.7 mV

+954.7 mV

Ch1 140 mV Vert scale setting,

0 V termination

0 Div position setting, -1 V offset

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

 

 

+823.2 mV

+1.070 V

+823.2 mV

 

 

__________

__________

__________

 

 

__________

__________

__________

 

 

+856.8 mV

+1.114 V

+856.8 mV
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DC gain accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch1 200 mV Vert scale setting,

0 V termination

0 Div position setting, -0.9 V offset

0 Div position setting, 0 V offset

0 Div position setting, +0.9 V offset

 

 

+1.176 V

+1.529 V

+1.176 V

 

 

__________

__________

__________

 

 

__________

__________

__________

 

 

+1.224 V

+1.591 V

+1.224 V

Ch1 400 mV Vert scale setting,

0 V termination

0 Div position setting, -0.3 V offset

0 Div position setting, 0 V offset

0 Div position setting, +0.3 V offset

 

 

+2.352 V

+2.352 V

+2.352 V

 

 

__________

__________

__________

 

 

__________

__________

__________

 

 

+2.448 V

+2.448 V

+2.448 V

Ch2 6.25 mV Vert scale setting (non-ATI channel)

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+1.5 V termination

0 Div position setting, +2.5 V offset

0 Div position setting, +1.5 V offset

0 Div position setting, +0.5 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+48.02 mV

+48.02 mV

+48.02 mV

 

+48.02 mV

+48.02 mV

+48.02 mV

 

+48.02 mV

+48.02 mV

 

+48.02 mV

+48.02 mV

 

 

__________

__________

__________

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+49.98 mV

+49.98 mV

+49.98 mV

 

+49.98 mV

+49.98 mV

+49.98 mV

 

+49.98 mV

+49.98 mV

 

+49.98 mV

+49.98 mV
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DC gain accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch2 10 mV Vert scale setting (non-ATI channel),

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+76.44 mV

+76.44 mV

+76.44 mV

 

+76.44 mV

+76.44 mV

 

+76.44 mV

+76.44 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+79.56 mV

+79.56 mV

+79.56 mV

 

+79.56 mV

+79.56 mV

 

+79.56 mV

+79.56 mV

Ch2 20 mV Vert scale setting (non-ATI channel),

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+152.9 mV

+152.9 mV

+152.9 mV

 

+152.9 mV

+152.9 mV

 

+152.9 mV

+152.9 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+159.1 mV

+159.1 mV

+159.1 mV

 

+159.1 mV

+159.1 mV

 

+159.1 mV

+159.1 mV
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DC gain accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch2 50 mV Vert scale setting (non-ATI channel),

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+382.2 mV

+382.2 mV

+382.2 mV

 

+382.2 mV

+382.2 mV

 

+382.2 mV

+382.2 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+397.8 mV

+397.8 mV

+397.8 mV

 

+397.8 mV

+397.8 mV

 

+397.8 mV

+397.8 mV

Ch2 100 mV Vert scale setting (non-ATI channel),

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+764 mV

+764 mV

+764 mV

 

+764 mV

+764 mV

 

+764 mV

+764 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+796 mV

+796 mV

+796 mV

 

+796 mV

+796 mV

 

+796 mV

+796 mV
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DC gain accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch2 120 mV Vert scale setting (non-ATI channel),

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+917.3 mV

+917.3 mV

+917.3 mV

 

+917.3 mV

+917.3 mV

 

+917.3 mV

+917.3 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+954.7 mV

+954.7 mV

+954.7 mV

 

+954.7 mV

+954.7 mV

 

+954.7 mV

+954.7 mV

Ch2 140 mV Vert scale setting (non-ATI channel),

0 V termination

0 Div position setting, -1 V offset

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

 

 

+823.2 mV

+1.070 V

+823.2 mV

 

 

__________

__________

__________

 

 

__________

__________

__________

 

 

+856.8 mV

+1.114 V

+856.8 mV

Ch2 200 mV Vert scale setting (non-ATI channel),

0 V termination

0 Div position setting, -0.9 V offset

0 Div position setting, 0 V offset

0 Div position setting, +0.9 V offset

 

 

+1.176 V

+1.529 V

+1.176 V

 

 

__________

__________

__________

 

 

__________

__________

__________

 

 

+1.224 V

+1.591 V

+1.224 V

Ch2 400 mV Vert scale setting (non-ATI channel),

0 V termination

0 Div position setting, -0.3 V offset

0 Div position setting, 0 V offset

0 Div position setting, +0.3 V offset

 

 

+2.352 V

+2.352 V

+2.352 V

 

 

__________

__________

__________

 

 

__________

__________

__________

 

 

+2.448 V

+2.448 V

+2.448 V
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DC gain accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch3 6.25 mV Vert scale setting

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+48.02 mV

+48.02 mV

+48.02 mV

 

+48.02 mV

+48.02 mV

 

+48.02 mV

+48.02 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+49.98 mV

+49.98 mV

+49.98 mV

 

+49.98 mV

+49.98 mV

 

+49.98 mV

+49.98 mV

Ch3 10 mV Vert scale setting,

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+76.44 mV

+76.44 mV

+76.44 mV

 

+76.44 mV

+76.44 mV

 

+76.44 mV

+76.44 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+79.56 mV

+79.56 mV

+79.56 mV

 

+79.56 mV

+79.56 mV

 

+79.56 mV

+79.56 mV
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DC gain accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch3 20 mV Vert scale setting,

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+152.9 mV

+152.9 mV

+152.9 mV

 

+152.9 mV

+152.9 mV

 

+152.9 mV

+152.9 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+159.1 mV

+159.1 mV

+159.1 mV

 

+159.1 mV

+159.1 mV

 

+159.1 mV

+159.1 mV

Ch3 50 mV Vert scale setting,

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+382.2 mV

+382.2 mV

+382.2 mV

 

+382.2 mV

+382.2 mV

 

+382.2 mV

+382.2 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+397.8 mV

+397.8 mV

+397.8 mV

 

+397.8 mV

+397.8 mV

 

+397.8 mV

+397.8 mV
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DC gain accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch3 100 mV Vert scale setting,

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+764 mV

+764 mV

+764 mV

 

+764 mV

+764 mV

 

+764 mV

+764 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+796 mV

+796 mV

+796 mV

 

+796 mV

+796 mV

 

+796 mV

+796 mV

Ch3 120 mV Vert scale setting,

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+917.3 mV

+917.3 mV

+917.3 mV

 

+917.3 mV

+917.3 mV

 

+917.3 mV

+917.3 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+954.7 mV

+954.7 mV

+954.7 mV

 

+954.7 mV

+954.7 mV

 

+954.7 mV

+954.7 mV

Ch3 140 mV Vert scale setting,

0 V termination

0 Div position setting, -1 V offset

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

 

 

+823.2 mV

+1.070 V

+823.2 mV

 

 

__________

__________

__________

 

 

__________

__________

__________

 

 

+856.8 mV

+1.114 V

+856.8 mV
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DC gain accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch3 200 mV Vert scale setting,

0 V termination

0 Div position setting, -0.9 V offset

0 Div position setting, 0 V offset

0 Div position setting, +0.9 V offset

 

 

+1.176 V

+1.529 V

+1.176 V

 

 

__________

__________

__________

 

 

__________

__________

__________

 

 

+1.224 V

+1.591 V

+1.224 V

Ch3 400 mV Vert scale setting,

0 V termination

0 Div position setting, -0.3 V offset

0 Div position setting, 0 V offset

0 Div position setting, +0.3 V offset

 

 

+2.352 V

+2.352 V

+2.352 V

 

 

__________

__________

__________

 

 

__________

__________

__________

 

 

+2.448 V

+2.448 V

+2.448 V

Ch4 6.25 mV Vert scale setting

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+48.02 mV

+48.02 mV

+48.02 mV

 

+48.02 mV

+48.02 mV

 

+48.02 mV

+48.02 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+49.98 mV

+49.98 mV

+49.98 mV

 

+49.98 mV

+49.98 mV

 

+49.98 mV

+49.98 mV
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DC gain accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch4 10 mV Vert scale setting,

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+76.44 mV

+76.44 mV

+76.44 mV

 

+76.44 mV

+76.44 mV

 

+76.44 mV

+76.44 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+79.56 mV

+79.56 mV

+79.56 mV

 

+79.56 mV

+79.56 mV

 

+79.56 mV

+79.56 mV

Ch4 20 mV Vert scale setting,

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+152.9 mV

+152.9 mV

+152.9 mV

 

+152.9 mV

+152.9 mV

 

+152.9 mV

+152.9 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+159.1 mV

+159.1 mV

+159.1 mV

 

+159.1 mV

+159.1 mV

 

+159.1 mV

+159.1 mV
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DC gain accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch4 50 mV Vert scale setting,

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+382.2 mV

+382.2 mV

+382.2 mV

 

+382.2 mV

+382.2 mV

 

+382.2 mV

+382.2 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+397.8 mV

+397.8 mV

+397.8 mV

 

+397.8 mV

+397.8 mV

 

+397.8 mV

+397.8 mV

Ch4 100 mV Vert scale setting,

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+764 mV

+764 mV

+764 mV

 

+764 mV

+764 mV

 

+764 mV

+764 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+796 mV

+796 mV

+796 mV

 

+796 mV

+796 mV

 

+796 mV

+796 mV
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DC gain accuracy (averaged), TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch4 120 mV Vert scale setting,

0 V termination

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

0 Div position setting, -1 V offset

+3.4 V termination

0 Div position setting, +3.4 V offset

0 Div position setting, +2.4 V offset

-3.4 V termination

0 Div position setting, -3.4 V offset

0 Div position setting, -2.4 V offset

 

 

+917.3 mV

+917.3 mV

+917.3 mV

 

+917.3 mV

+917.3 mV

 

+917.3 mV

+917.3 mV

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

__________

__________

__________

 

__________

__________

 

__________

__________

 

 

+954.7 mV

+954.7 mV

+954.7 mV

 

+954.7 mV

+954.7 mV

 

+954.7 mV

+954.7 mV

Ch4 140 mV Vert scale setting,

0 V termination

0 Div position setting, -1 V offset

0 Div position setting, 0 V offset

0 Div position setting, +1 V offset

 

 

+823.2 mV

+1.070 V

+823.2 mV

 

 

__________

__________

__________

 

 

__________

__________

__________

 

 

+856.8 mV

+1.114 V

+856.8 mV

Ch4 200 mV Vert scale setting,

0 V termination

0 Div position setting, -0.9 V offset

0 Div position setting, 0 V offset

0 Div position setting, +0.9 V offset

 

 

+1.176 V

+1.529 V

+1.176 V

 

 

__________

__________

__________

 

 

__________

__________

__________

 

 

+1.224 V

+1.591 V

+1.224 V

Ch4 400 mV Vert scale setting,

0 V termination

0 Div position setting, -0.3 V offset

0 Div position setting, 0 V offset

0 Div position setting, +0.3 V offset

 

 

+2.352 V

+2.352 V

+2.352 V

 

 

__________

__________

__________

 

 

__________

__________

__________

 

 

+2.448 V

+2.448 V

+2.448 V
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Offset accuracy, ATI channel

Instrument performance test Minimum Incoming Outgoing Maximum

Ch2 10 mV Vert scale, 0 Div position setting,

0 V offset

+0.2 V offset

-0.2 V offset

 

–3.0 mV

+0.1963 V

-0.2037 V

 

__________

__________

__________

 

__________

__________

__________

 

+3.0 mV

+0.2037 V

-0.1963 V

Ch2 20 mV Vert scale, 0 Div position setting,

0 V offset

+0.1 V offset

-0.1 V offset

 

–4.0 mV

+0.0957 V

–0.1044 V

 

__________

__________

__________

 

__________

__________

__________

 

+4.0 mV

+0.1044 V

–0.0957 V

Ch2 30 mV Vert scale, 0 Div position setting,

0 V offset

 

–5.0 mV

 

__________

 

__________

 

+5.0 mV

Offset accuracy, TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch1 6.25 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–3.125 mV

+3.3831 V

–3.4169 V

 

__________

__________

__________

 

__________

__________

__________

 

+3.125 mV

+3.4169 V

–3.3831 V

Ch1 10 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–3.5 mV

+3.3827 V

–3.4173 V

 

__________

__________

__________

 

__________

__________

__________

 

+3.5 mV

+3.4173 V

–3.3827 V

Ch1 20 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–4.5 mV

+3.3817 V

–3.4183 V

 

__________

__________

__________

 

__________

__________

__________

 

+4.5 mV

+3.4183 V

–3.3817 V

Ch1 50 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–7.5 mV

+3.3787 V

–3.4213 V

 

__________

__________

__________

 

__________

__________

__________

 

+7.5 mV

+3.4213 V

–3.3787 V
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Offset accuracy, TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch1 100 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–12.5 mV

+3.3737 V

–3.4263 V

 

__________

__________

__________

 

__________

__________

__________

 

+12.5 mV

+3.4263 V

–3.3737 V

Ch1 120 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–14.5 mV

+3.3717 V

–3.4283 V

 

__________

__________

__________

 

__________

__________

__________

 

+14.5 mV

+3.4283 V

–3.3717 V

Ch1 140 mV Vert scale, 0 Div position setting,

-6 V offset, 0 V termination

0 V offset, 0 V termination

+6 V offset, 0 V termination

 

–6.0634 V

–27.4 mV

+5.9366 V

 

__________

__________

__________

 

__________

__________

__________

 

–5.9366 V

+27.4 mV

+6.0634 V

Ch1 200 mV Vert scale, 0 Div position setting,

-6 V offset, 0 V termination

0 V offset, 0 V termination

+6 V offset, 0 V termination

 

–6.0694 V

–33.4 mV

+5.9306 V

 

__________

__________

__________

 

__________

__________

__________

 

–5.9306 V

+33.4 mV

+6.0694 V

Ch1 400 mV Vert scale, 0 Div position setting,

-6 V offset, 0 V termination

0 V offset, 0 V termination

+6 V offset, 0 V termination

 

–6.0894 mV

–53.4 mV

+5.9106 V

 

__________

__________

__________

 

__________

__________

__________

 

–5.9106 mV

+53.4 mV

+6.0894 V

Ch2 6.25 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–3.125 mV

+3.3831 V

–3.4169 V

 

__________

__________

__________

 

__________

__________

__________

 

+3.125 mV

+3.4169 V

–3.3831 V

Ch2 10 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–3.5 mV

+3.3827 V

–3.4173 V

 

__________

__________

__________

 

__________

__________

__________

 

+3.5 mV

+3.4173 V

–3.3827 V
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Offset accuracy, TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch2 20 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–4.5 mV

+3.3817 V

–3.4183 V

 

__________

__________

__________

 

__________

__________

__________

 

+4.5 mV

+3.4183 V

–3.3817 V

Ch2 50 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–7.5 mV

+3.3787 V

–3.4213 V

 

__________

__________

__________

 

__________

__________

__________

 

+7.5 mV

+3.4213 V

–3.3787 V

Ch2 100 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–12.5 mV

+3.3737 V

–3.4263 V

 

__________

__________

__________

 

__________

__________

__________

 

+12.5 mV

+3.4263 V

–3.3737 V

Ch2 120 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–14.5 mV

+3.3717 V

–3.4283 V

 

__________

__________

__________

 

__________

__________

__________

 

+14.5 mV

+3.4283 V

–3.3717 V

Ch2 140 mV Vert scale, 0 Div position setting,

-6 V offset, 0 V termination

0 V offset, 0 V termination

+6 V offset, 0 V termination

 

–6.0634 V

–27.4 mV

+5.9366 V

 

__________

__________

__________

 

__________

__________

__________

 

–5.9366 V

+27.4 mV

+6.0634 V

Ch2 200 mV Vert scale, 0 Div position setting,

-6 V offset, 0 V termination

0 V offset, 0 V termination

+6 V offset, 0 V termination

 

–6.0694 V

–33.4 mV

+5.9306 V

 

__________

__________

__________

 

__________

__________

__________

 

–5.9306 V

+33.4 mV

+6.0694 V

Ch2 400 mV Vert scale, 0 Div position setting,

-6 V offset, 0 V termination

0 V offset, 0 V termination

+6 V offset, 0 V termination

 

–6.0894 mV

–53.4 mV

+5.9106 V

 

__________

__________

__________

 

__________

__________

__________

 

–5.9106 mV

+53.4 mV

+6.0894 V
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Offset accuracy, TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch3 6.25 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–3.125 mV

+3.3831 V

–3.4169 V

 

__________

__________

__________

 

__________

__________

__________

 

+3.125 mV

+3.4169 V

–3.3831 V

Ch3 10 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–3.5 mV

+3.3827 V

–3.4173 V

 

__________

__________

__________

 

__________

__________

__________

 

+3.5 mV

+3.4173 V

–3.3827 V

Ch3 20 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–4.5 mV

+3.3817 V

–3.4183 V

 

__________

__________

__________

 

__________

__________

__________

 

+4.5 mV

+3.4183 V

–3.3817 V

Ch3 50 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–7.5 mV

+3.3787 V

–3.4213 V

 

__________

__________

__________

 

__________

__________

__________

 

+7.5 mV

+3.4213 V

–3.3787 V

Ch3 100 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–12.5 mV

+3.3737 V

–3.4263 V

 

__________

__________

__________

 

__________

__________

__________

 

+12.5 mV

+3.4263 V

–3.3737 V

Ch3 120 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–14.5 mV

+3.3717 V

–3.4283 V

 

__________

__________

__________

 

__________

__________

__________

 

+14.5 mV

+3.4283 V

–3.3717 V

Ch3 140 mV Vert scale, 0 Div position setting,

-6 V offset, 0 V termination

0 V offset, 0 V termination

+6 V offset, 0 V termination

 

–6.0634 V

–27.4 mV

+5.9366 V

 

__________

__________

__________

 

__________

__________

__________

 

–5.9366 V

+27.4 mV

+6.0634 V
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Offset accuracy, TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch3 200 mV Vert scale, 0 Div position setting,

-6 V offset, 0 V termination

0 V offset, 0 V termination

+6 V offset, 0 V termination

 

–6.0694 V

–33.4 mV

+5.9306 V

 

__________

__________

__________

 

__________

__________

__________

 

–5.9306 V

+33.4 mV

+6.0694 V

Ch3 400 mV Vert scale, 0 Div position setting,

-6 V offset, 0 V termination

0 V offset, 0 V termination

+6 V offset, 0 V termination

 

–6.0894 mV

–53.4 mV

+5.9106 V

 

__________

__________

__________

 

__________

__________

__________

 

–5.9106 mV

+53.4 mV

+6.0894 V

Ch4 6.25 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–3.125 mV

+3.3831 V

–3.4169 V

 

__________

__________

__________

 

__________

__________

__________

 

+3.125 mV

+3.4169 V

–3.3831 V

Ch4 10 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–3.5 mV

+3.3827 V

–3.4173 V

 

__________

__________

__________

 

__________

__________

__________

 

+3.5 mV

+3.4173 V

–3.3827 V

Ch4 20 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–4.5 mV

+3.3817 V

–3.4183 V

 

__________

__________

__________

 

__________

__________

__________

 

+4.5 mV

+3.4183 V

–3.3817 V

Ch4 50 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–7.5 mV

+3.3787 V

–3.4213 V

 

__________

__________

__________

 

__________

__________

__________

 

+7.5 mV

+3.4213 V

–3.3787 V

Ch4 100 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–12.5 mV

+3.3737 V

–3.4263 V

 

__________

__________

__________

 

__________

__________

__________

 

+12.5 mV

+3.4263 V

–3.3737 V
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Offset accuracy, TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch4 120 mV Vert scale, 0 Div position setting,

0 V offset, 0 V termination

+3.4 V offset, +3.5 V termination

-3.4 V offset, -3.5 V termination

 

–14.5 mV

+3.3717 V

–3.4283 V

 

__________

__________

__________

 

__________

__________

__________

 

+14.5 mV

+3.4283 V

–3.3717 V

Ch4 140 mV Vert scale, 0 Div position setting,

-6 V offset, 0 V termination

0 V offset, 0 V termination

+6 V offset, 0 V termination

 

–6.0634 V

–27.4 mV

+5.9366 V

 

__________

__________

__________

 

__________

__________

__________

 

–5.9366 V

+27.4 mV

+6.0634 V

Ch4 200 mV Vert scale, 0 Div position setting,

-6 V offset, 0 V termination

0 V offset, 0 V termination

+6 V offset, 0 V termination

 

–6.0694 V

–33.4 mV

+5.9306 V

 

__________

__________

__________

 

__________

__________

__________

 

–5.9306 V

+33.4 mV

+6.0694 V

Ch4 400 mV Vert scale, 0 Div position setting,

-6 V offset, 0 V termination

0 V offset, 0 V termination

+6 V offset, 0 V termination

 

–6.0894 mV

–53.4 mV

+5.9106 V

 

__________

__________

__________

 

__________

__________

__________

 

–5.9106 mV

+53.4 mV

+6.0894 V

Channel bandwidth, ATI channel

Instrument performance test Minimum Incoming Outgoing Maximum

Ch2

10 mV

20 mV

30 mV

 

24.7 mV

49.5 mV

74.2 mV

 

__________

__________

__________

 

__________

__________

__________

 

N/A

N/A

N/A
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Channel bandwidth, TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch1

6.25 mV

10 mV

20 mV

50 mV

100 mV

120 mV

140 mV

200 mV

400 mV

 

15.5 mV

24.7 mV

50 mV

124 mV

248 mV

297 mV

346 mV

495 mV

990 mV

 

__________

__________

__________

__________

__________

__________

__________

__________

__________

 

__________

__________

__________

__________

__________

__________

__________

__________

__________

 

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

Ch2 (non-ATI instruments only)

6.25 mV

10 mV

20 mV

50 mV

100 mV

120 mV

140 mV

200 mV

400 mV

 

15.5 mV

24.7 mV

50 mV

124 mV

248 mV

297 mV

346 mV

495 mV

990 mV

 

__________

__________

__________

__________

__________

__________

__________

__________

__________

 

__________

__________

__________

__________

__________

__________

__________

__________

__________

 

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

Ch3

6.25 mV

10 mV

20 mV

50 mV

100 mV

120 mV

140 mV

200 mV

400 mV

 

15.5 mV

24.7 mV

50 mV

124 mV

248 mV

297 mV

346 mV

495 mV

990 mV

 

__________

__________

__________

__________

__________

__________

__________

__________

__________

 

__________

__________

__________

__________

__________

__________

__________

__________

__________

 

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A
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Channel bandwidth, TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Ch4

6.25 mV

10 mV

20 mV

50 mV

100 mV

120 mV

140 mV

200 mV

400 mV

 

15.5 mV

24.7 mV

50 mV

124 mV

248 mV

297 mV

346 mV

495 mV

990 mV

 

__________

__________

__________

__________

__________

__________

__________

__________

__________

 

__________

__________

__________

__________

__________

__________

__________

__________

__________

 

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

Input resistance, ATI channel

Instrument performance test Minimum Incoming Outgoing Maximum

Input resistance

Ch2 10 mV/div

Ch2 20 mV/div

Ch2 30 mV/div

 

48.5 Ω

48.5 Ω

48.5 Ω

 

__________

__________

__________

 

__________

__________

__________

 

51.5 Ω

51.5 Ω

51.5 Ω

Input resistance, TekConnect channels

Instrument performance test Minimum Incoming Outgoing Maximum

Input resistance,

Ch1 6.25 mV/div

Ch2 6.25 mV/div (non ATI instruments only)

Ch3 6.25 mV/div

Ch4 6.25 mV/div

Ch1 140 mV/div

Ch2 140 mV/div

Ch3 140 mV/div

Ch4 140 mV/div

 

48.5 Ω

48.5 Ω

48.5 Ω

48.5 Ω

47.8 Ω

47.8 Ω

47.8 Ω

47.8 Ω

 

__________

__________

__________

__________

__________

__________

__________

__________

 

__________

__________

__________

__________

__________

__________

__________

__________

 

51.5 Ω

51.5 Ω

51.5 Ω

51.5 Ω

52.2 Ω

52.2 Ω

52.2 Ω

52.2 Ω
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Time base system

Instrument performance test Minimum Incoming Outgoing Maximum

Time base, delay time, and internal reference
accuracy

10 MHz

 

Pass/Fail

 

__________

__________

 

__________

__________

 

Pass/Fail

External reference

10 MHz

 

Pass/Fail

 

__________

 

__________

 

Pass/Fail

Time base system

Instrument performance test Minimum Incoming Outgoing Maximum

Delta time measurement

DPO77002SX, Ch2, BWE on

10 mV, rms

10 mV, pk-pk

30 mV, rms

30 mV, pk-pk

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

0.560 ps

5.60 ps

0.400 ps

4.00 ps

DPO77002SX, Ch1, BWE on

6.25 mV, rms

6.25 mV, pk-pk

50 mV, rms

50 mV, pk-pk

100 mV, rms

100 mV, pk-pk

N/A

N/A

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

0.620 ps

6.20 ps

0.400 ps

4.00 ps

0.400 ps

4.00 ps

DPO77002SX, Ch3, BWE on

6.25 mV, rms

6.25 mV, pk-pk

50 mV, rms

50 mV, pk-pk

100 mV, rms

100 mV, pk-pk

N/A

N/A

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

0.620 ps

6.20 ps

0.400 ps

4.00 ps

0.400 ps

4.00 ps
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DPO75902SX, Ch2, BWE on

10 mV, rms

10 mV, pk-pk

30 mV, rms

30 mV, pk-pk

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

0.560 ps

5.60 ps

0.400 ps

4.00 ps

DPO75902SX, Ch1, BWE on

6.25 mV, rms

6.25 mV, pk-pk

50 mV, rms

50 mV, pk-pk

100 mV, rms

100 mV, pk-pk

N/A

N/A

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

0.620 ps

6.20 ps

0.400 ps

4.00 ps

0.400 ps

4.00 ps

DPO75902SX, Ch3, BWE on

6.25 mV, rms

6.25 mV, pk-pk

50 mV, rms

50 mV, pk-pk

100 mV, rms

100 mV, pk-pk

N/A

N/A

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

0.620 ps

6.20 ps

0.400 ps

4.00 ps

0.400 ps

4.00 ps

DPO75002SX, Ch2, BWE on

10 mV, rms

10 mV, pk-pk

30 mV, rms

30 mV, pk-pk

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

0.560 ps

5.60 ps

0.400 ps

4.00 ps

DPO75002SX, Ch1, BWE on
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6.25 mV, rms

6.25 mV, pk-pk

50 mV, rms

50 mV, pk-pk

100 mV, rms

100 mV, pk-pk

N/A

N/A

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

0.620 ps

6.20 ps

0.400 ps

4.00 ps

0.400 ps

4.00 ps

DPO75002SX, Ch3, BWE on

6.25 mV, rms

6.25 mV, pk-pk

50 mV, rms

50 mV, pk-pk

100 mV, rms

100 mV, pk-pk

N/A

N/A

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

0.620 ps

6.20 ps

0.400 ps

4.00 ps

0.400 ps

4.00 ps

DPO73304SX, Ch1, BWE on

6.25 mV, rms

6.25 mV, pk-pk

50 mV, rms

50 mV, pk-pk

100 mV, rms

100 mV, pk-pk

N/A

N/A

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

0.620 ps

6.20 ps

0.400 ps

4.00 ps

0.400 ps

4.00 ps

DPO73304SX, Ch2, BWE on

6.25 mV, rms

6.25 mV, pk-pk

50 mV, rms

50 mV, pk-pk

100 mV, rms

100 mV, pk-pk

N/A

N/A

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

0.620 ps

6.20 ps

0.400 ps

4.00 ps

0.400 ps

4.00 ps

DPO73304SX, Ch3, BWE on

Table continued…
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6.25 mV, rms

6.25 mV, pk-pk

50 mV, rms

50 mV, pk-pk

100 mV, rms

100 mV, pk-pk

N/A

N/A

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

0.620 ps

6.20 ps

0.400 ps

4.00 ps

0.400 ps

4.00 ps

DPO73304SX, Ch4, BWE on

6.25 mV, rms

6.25 mV, pk-pk

50 mV, rms

50 mV, pk-pk

100 mV, rms

100 mV, pk-pk

N/A

N/A

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

0.620 ps

6.20 ps

0.400 ps

4.00 ps

0.400 ps

4.00 ps

DPO72304SX, Ch1, BWE on

10 mV, rms

6.25 mV, pk-pk

6.25 mV, rms

50 mV, pk-pk

100 mV, rms

100 mV, pk-pk

N/A

N/A

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

0.620 ps

6.20 ps

0.400 ps

4.00 ps

0.400 ps

4.00 ps

DPO72304SX, Ch2, BWE on

6.25 mV, rms

6.25 mV, pk-pk

50 mV, rms

50 mV, pk-pk

100 mV, rms

100 mV, pk-pk

N/A

N/A

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

0.620 ps

6.20 ps

0.400 ps

4.00 ps

0.400 ps

4.00 ps

DPO72304SX, Ch3, BWE on

Table continued…
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6.25 mV, rms

6.25 mV, pk-pk

50 mV, rms

50 mV, pk-pk

100 mV, rms

100 mV, pk-pk

N/A

N/A

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

0.620 ps

6.20 ps

0.400 ps

4.00 ps

0.400 ps

4.00 ps

DPO72304SX, Ch4, BWE on

6.25 mV, rms

6.25 mV, pk-pk

50 mV, rms

50 mV, pk-pk

100 mV, rms

100 mV, pk-pk

N/A

N/A

N/A

N/A

N/A

N/A

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

0.620 ps

6.20 ps

0.400 ps

4.00 ps

0.400 ps

4.00 ps

Trigger system accuracy

Instrument performance test Minimum Incoming Outgoing Maximum

Time accuracy for time qualified triggers

time range < 1 ms

Lower Limit

Upper Limit

time range ≥ 1 μs

Lower Limit

Upper Limit

 

4.835 ns

4.835 ns

 

1.47 μs

1.47 μs

 

__________

__________

 

__________

__________

 

__________

__________

 

__________

__________

 

5.165 ns

5.165 ns

 

2.53 μs

2.53 μs

Ch1 trigger sensitivity, 50 MHz Pass/Fail __________ __________ Pass/Fail

Ch1 delayed trigger sensitivity, 50 MHz Pass/Fail __________ __________ Pass/Fail

AUX trigger input sensitivity, 50 MHz Pass/Fail __________ __________ Pass/Fail

Ch1 trigger sensitivity

Table continued…
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Trigger system accuracy

Instrument performance test Minimum Incoming Outgoing Maximum

5 GHz

10 GHz

15 GHz

20 GHz

25 GHz

Pass/Fail

Pass/Fail

Pass/Fail

Pass/Fail

Pass/Fail

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

Pass/Fail

Pass/Fail

Pass/Fail

Pass/Fail

Pass/Fail

Ch1 B trigger sensitivity

5 GHz

10 GHz

15 GHz

20 GHz

25 GHz

Pass/Fail

Pass/Fail

Pass/Fail

Pass/Fail

Pass/Fail

__________

__________

__________

__________

__________

__________

__________

__________

__________

__________

Pass/Fail

Pass/Fail

Pass/Fail

Pass/Fail

Pass/Fail

Ch1 AUX trigger input

11 GHz Pass/Fail __________ __________ Pass/Fail

Fast Edge output signal Voltage (difference)

Positive 450 mV __________ __________ 650 mV

Negative 450 mV __________ __________ 650 mV

Signal acquisition system checks
These procedures check those characteristics that relate to the signal-acquisition system and are listed as checked under Warranted
Characteristics in Specifications. See Equipment required on page 48 for test equipment specifications. 

Performance verification

DPO70000SX Series Oscilloscopes Specifications and Performance Verification 105



Check DC voltage measurement accuracy, ATI channel
Equipment Required Prerequisites

One DC calibration generator (Item 7 on page 48)

Two Dual-Banana Connectors, (Item 6 on page 48)

Two cables, BNC, (Item 5 on page 48)

One BNC T, (Item 25 on page 50)

One 1.85 mm female to SMA female adapter ( Item 30 on page 51)

One SMA male-to-BNC female adapter (Item 16 on page 49)

The instrument must meet the prerequisites. (See
Prerequisites on page 47.)

WARNING: The generator is capable of outputting dangerous voltages. Be sure to set the DC calibration generator to off or
0 volts before connecting, disconnecting, and/or moving the test hookup during the performance of this procedure.

1. Install the test hookup and preset the instrument controls:

a. Hook up the test-signal source:

• Set the output of a DC calibration generator to off or 0 volts.
• Connect the output of a DC calibration generator. (See Figure 6 on page 106.)

b. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
c. Modify the default settings:

• From the button bar, select Horiz/Acq and select the Acquisition tab.
• Set the Horizontal Scale to 1 ms/div.
• Set the Record Length to 5000.
• Select Average and set the number of averages to 16.
• Set the Trigger Source to Line.

Figure 6: DC voltage accuracy test hookup

2. Confirm input channels are within limits for DC accuracy at maximum offset, position, and termination voltage: Do the following
substeps.

a. Select the ATI channel:

• Set the generator output to 0 V.
• From the button bar, select Vertical and then Vertical Setup.
• Select the tab that corresponds to the channel you are to confirm. Click the Display Off button.

b. Turn on the measurement Mean for the channel:
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• From the button bar, select Measure and select the Ampl tab, More, and then select Mean to measure the mean of the current
channel.

• Press the X (Close) button.

Note: If any of the voltages supplied by your generator are not calibrated, verify those generator voltages using a digital
multimeter, item 24 on page 50.

c. Set the vertical scale: Set the vertical Scale to one of the settings listed in the following table that is not yet checked, starting with
the first setting listed.

Table 4: DC voltage measurement accuracy

Scale setting Offset setting 10 Generator setting Accuracy limits

10 mV 0 V 30 mV 26.0 mV to 34.0 mV

0 V -30 mV -34.0 mV to -26.0 mV

–0.2 V -170 mV -174.7 mV to -165.3 mV

+0.2 V +170 mV +165.3 mV to +174.7 mV

+0.2 V 0.23 V 225.3 mV to 234.7 mV

-0.2 V -0.23 V -234.7 mV to -225.3 mV

20 mV 0 V 60 mV 54.0 mV to 66.0 mV

0 V -60 mV -66.0 mV to -54.0 mV

–0.1 V -40 mV -46.4 mV to -33.7 mV

+0.1 V +40 mV +33.7 mV to +46.4 mV

+0.1 V 160 mV 153.7 mV to 166.4 mV

-0.1 V -160 mV -166.4 mV to -153.7 mV

30 mV 0 V 90 mV 82.0 mV to 98.0 mV

0 V -90 mV -98.0 mV to -82.0 mV

d. Display the test signal:

• Display the Vertical Setup menu.
• Use the keypad to set the Offset vertical setting as listed in the table for the current vertical scale setting. The baseline level

may move off screen.
• Set the generator to the level and polarity indicated in the table for the vertical scale and offset settings you have made.

e. Measure the test signal: Press the X (close) button. Read the measurement results at the measurement statistics Mean
measurement readout. See the following figure.

10 Set as precisely as the instrument's offset resolution permits.
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Figure 7: Measurement of DC accuracy

f. Check against limits:

• CHECK that the readout for the measurement Mean readout on screen is within the limits listed for the current vertical scale
and termination/offset/generator settings. Enter the value on test record.

• Repeat substeps 2.c on page 107 through 2.f on page 108 until all vertical scale settings are checked for the channel under
test. (See Table 5 on page 110.)

3. Disconnect the hookup:

a. Set the generator output to 0 V.
b. Disconnect the equipment from the generator output and the input connector of the channel last tested.

Check DC voltage measurement accuracy, TekConnect channels
Equipment Required Prerequisites

One DC calibration generator, (Item 7 on page 48)

Two Dual-Banana Connectors, (Item 6 on page 48)

Two cables, (Item 5 on page 48)

One BNC T adapter, (Item 25 on page 50)

One SMA male-to-BNC female adapter, (Item 18 on page 50)

The instrument must meet the prerequisites. (See
Prerequisites on page 47.)

WARNING: The generator is capable of outputting dangerous voltages. Be sure to set the DC calibration generator to off or
0 volts before connecting, disconnecting, and/or moving the test hookup during the performance of this procedure.

1. Install the test hookup and preset the instrument controls:
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a. Hook up the test-signal source:

• Set the output of a DC calibration generator to off or 0 volts.
• Connect the output of a DC calibration generator. (See Figure 8 on page 109.)

b. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
c. Modify the default settings:

• From the button bar, select Horiz/Acq and select the Acquisition tab.
• Set the Horizontal Scale to 1 ms/div.
• Set the Record Length to 5000.
• Set the Acquisition Mode to Hi Res.
• Set the Trigger Source to Line.

Figure 8: DC voltage accuracy test hookup

2. Confirm input channels are within limits for DC accuracy at maximum offset, position, and termination voltage: Do the following
substeps - test Ch 1 first, skipping substep 2.a on page 109 of this step since Ch 1 is already selected from step 1 on page 108.

a. Select an unchecked channel:

• From the button bar, select Measure and then Clear All to remove the previous measurement.
• From the button bar, select Vertical and then Vertical Setup Click the Display On button of the channel just confirmed to

remove the channel from the display.
• Select the tab that corresponds to the channel you are to confirm. Click the Display Off button.
• Set the generator output to 0 V.
• Move the test hookup to the channel you selected.

b. Turn on the measurement Mean for the channel:

• From the button bar, select Measure and select the Ampl tab, More, and then select Mean to measure the mean of the current
channel.

• Press the X (Close) button.
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Note: If any of the voltages supplied by your generator are not calibrated, verify those generator voltages using a digital
multimeter, item 24 on page 50.

c. Set the vertical scale: Set the vertical Scale to one of the settings listed in the following table that is not yet checked, starting with
the first setting listed.

Table 5: DC voltage measurement accuracy

Scale setting Termination setting Offset setting 11 Generator setting Accuracy limits

6.25 mV +3.5 V +3.4 V 3.419 V 3.4012 V to 3.4363 V

+3.5 V +2.4 V 2.419 V 2.4032 V to 2.4343 V

+1.5 V +2.5 V 2.519 V 2.503 V to 2.5345 V

+1.5 V +1.5 V 1.519 V 1.509 V to 1.5285 

+1.5 V +0.5 V 519 mV 511.0 mV to 526.5mV

0 V 0 V 18.75 mV 15.0 mV to 22.5 mV

0 V 0 V -18.75 mV -22.5 mV to -15.0 mV

0 V –1.0 V -981 mV -991 mV to -971.5 mV

0 V +1.0 V 1.019 V 1.009 mV to 1.0285 V

-3.5 V -3.4 V -3.381 V -3.3988 V to -3.3637 V

-3.5 V -2.4 V -2.381 V -2.3968 V to -2.3657 V

-1.5 V -2.5 V -2.481 V -2.497 V to -2.4655 V

-1.5 V -1.5 V -1.481 V -1.491 V to -1.4715 V

-1.5 V -0.5 V -481 mV -489 mV to -473.5 mV

10 mV +3.5 V +3.4 V 3.43 V 3.4117 V to 3.4483 V

+3.5 V +2.4 V 2.43 V 2.4137 V to 2.4463 V

+1.5 V +2.5 V 2.53 V 2.5135 V to 2.5465 V

+1.5 V +1.5 V 1.53 V 1.5195 V to 1.5405 V

+1.5 V +0.5 V 530 mV 521.5 mV to 538.5 mV

0 V 0 V 30 mV 25.5 mV to 34.5 mV

Table continued…

11 Set as precisely as the instrument's offset resolution permits.
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Scale setting Termination setting Offset setting 11 Generator setting Accuracy limits

0 V 0 V -30 mV -34.5 mV to -25.5 mV

0 V –1.0 V -970 mV -980.5 mV to -959.5 mV

0 V +1.0 V 1.03 V 1.0195 V to 1.0405 V

-3.5 V -3.4 V -3.37 V -3.3883 V to -3.3517 V

-3.5 V -2.4 V -2.37V -2.3863 V to -2.3537 V

-1.5 V -2.5 V -2.47 V -2.4865 V to -2.4535 V

-1.5 V -1.5 V -1.47 V -1.4805 V to -1.4595 V

-1.5 V -0.5 V -470 mV -478.5 mV to -461.5 mV

20 mV +3.5 V +3.4 V 3.46 V 3.4397 V to 3.4803 V

+3.5 V +2.4 V 2.46 V 2.4417 V to 2.4783 V

+1.5 V +2.5 V 2.56 V 2.5415 V to 2.5785 V

+1.5 V +1.5 V 1.56 V 1.5475 V to 1.5725 V

+1.5 V +0.5 V 560 mV 549.5 mV to 570.5 mV

0 V 0 V 60 mV 53.5 mV to 66.5 mV

0 V 0 V -60 mV -66.5 mV to -53.5 mV

0 V –1.0 V -940 mV -952.5 mV to -927.5 mV

0 V +1.0 V 1.06 V 1.0475 V to 1.0725 V

-3.5 V -3.4 V -3.34 V -3.3603 V to -3.3197 V

-3.5 V -2.4 V -2.34 V -2.3583 V to -2.3217 V

-1.5 V -2.5 V -2.44 V -2.4585 V to -2.4215 V

-1.5 V -1.5 V -1.44 V -1.4525 V to -1.4275 V

-1.5 V -0.5 V -440 mV -450.5 mV to -429.5 mV

50 mV +3.5 V +3.4 V 3.55 V 3.5237 V to 3.5763 V

Table continued…

11 Set as precisely as the instrument's offset resolution permits.
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Scale setting Termination setting Offset setting 11 Generator setting Accuracy limits

+3.5 V +2.4 V 2.55 V 2.5257 V to 2.5743 V

+1.5 V +2.5 V 2.65 V 2.6255 V to 2.6745 V

+1.5 V +1.5 V 1.65 V 1.6315 V to 1.6685 V

+1.5 V +0.5 V 650 mV 633.5 mV to 666.5 mV

0 V 0 V 150 mV 137.5 mV to 162.5 mV

0 V 0 V -150 mV -162.5 mV to -137.5 mV

0 V –1.0 V -850 mV -868.5 mV to -831.5 mV

0 V +1.0 V 1.15 V 1.1315 V to 1.1685 V

-3.5 V -3.4 V -3.25 V -3.2763 V to -3.2237 V

-3.5 V -2.4 V -2.25 V -2.2743 V to -2.2257 V

-1.5 V -2.5 V -2.35 V -2.3745 V to -2.3255 V

-1.5 V -1.5 V -1.35 V -1.3685 V to -1.3315 V

-1.5 V -0.5 V -350 mV -366.5 mV to -333.5 mV

100 mV +3.5 V +3.4 V 3.7 V 3.6637 V to 3.7363 V

+3.5 V +2.4 V 2.7 V 2.6657 V to 2.7343 V

+1.5 V +2.5 V 2.8 V 2.7655 V to 2.8345 V

+1.5 V +1.5 V 1.8 V 1.7715 V to 1.8285 V

+1.5 V +0.5 V 800 mV 773.5 mV to 826.5 mV

0 V 0 V 300 mV 277.5 mV to 322.5 mV

0 V 0 V -300 mV -322.5 mV to -277.5 mV

0 V –1.0 V -700 mV -728.5 mV to -671.5 mV

0 V +1.0 V 1.3 V 1.2715 V to 1.3285 V

-3.5 V -3.4 V -3.1 V -3.1363 V to -3.0637 V

Table continued…

11 Set as precisely as the instrument's offset resolution permits.
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Scale setting Termination setting Offset setting 11 Generator setting Accuracy limits

-3.5 V -2.4 V -2.1 V -2.1343 V to -2.0657 V

-1.5 V -2.5 V -2.2 V -2.2345 V to -2.1655 V

-1.5 V -1.5 V -1.2 V -1.2285 V to -1.1715 V

-1.5 V -0.5 V -200 mV -226.5 mV to -173.5 mV

120 mV +3.5 V +3.4 V 3.76 V 3.7197 V to 3.8003 V

+3.5 V +2.4 V 2.76 V 2.7217 V to 2.7983 V

+1.5 V +2.5 V 2.86 V 2.8215 V to 2.8985 V

+1.5 V +1.5 V 1.86 V 1.8275 V to 1.8925 V

+1.5 V +0.5 V 860 mV 829.5 mV to 890.5 mV

0 V 0 V 360 mV 333.5 mV to 386.5 mV

0 V 0 V -360 mV -386.5 mV to -333.5 mV

0 V –1.0 V -640 mV -672.5 mV to -607.5 mV

0 V +1.0 V 1.36 V 1.3275 V to 1.3925 V

-3.5 V -3.4 V -3.04 V -3.0803 V to -2.9997 V

-3.5 V -2.4 V -2.04 V -2.0783 V to -2.0017 V

-1.5 V -2.5 V -2.14 V -2.1785 V to -2.1015 V

-1.5 V -1.5 V -1.14 V -1.1725 V to -1.1075 V

-1.5 V -0.5 V -140 mV -170.5 mV to -109.5 mV

140 mV 0 V –1.0 V -580 mV -627.4 mV to -532.6 mV

0 V 0 V 420 mV 378.6 mV to 461.4 mV

0 V +1.0 V 1.42 V 1.3726 V to 1.4674 V

200 mV 0 V –1.0 V -400 mV -459.4 mV to -340.6 mV

0 V 0 V 600 mV 546.6 mV to 653.4 mV

Table continued…

11 Set as precisely as the instrument's offset resolution permits.

Performance verification

DPO70000SX Series Oscilloscopes Specifications and Performance Verification 113



Scale setting Termination setting Offset setting 11 Generator setting Accuracy limits

0 V +1.0 V 1.60 V 1.5406 V to 1.6594 V

400 mV 0 V –1.0 V 200 mV 100.6 mV to 299.4 mV

0 V 0 V 1.20 V 1.1066 V to 1.2934 V

0 V +1.0 V 2.20 V 2.1006 V to 2.2994 V

d. Display the test signal:

• Display the Vertical Setup menu.
• Use the keypad to set the Termination Voltage and Offset vertical settings as listed in the table for the current vertical scale

setting. The baseline level may move off screen.
• Set the generator to the level and polarity indicated in the table for the vertical scale, termination voltage, and offset settings

you have made.
e. Measure the test signal: Press the X (close) button. Read the measurement results at the measurement statistics Mean

measurement readout. See the following figure.

Figure 9: Measurement of DC accuracy

f. Check against limits:

• CHECK that the readout for the measurement Mean readout on screen is within the limits listed for the current vertical scale
and termination/offset/generator settings. Enter the value on test record.

• Repeat substeps 2.c on page 110 through 2.f on page 114 until all vertical scale settings are checked for the channel under
test. (See Table 5 on page 110.)

g. Test all channels: Repeat substeps 2.a on page 109 through 2.f on page 114 for all TekConnect channels.

11 Set as precisely as the instrument's offset resolution permits.
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3. Disconnect the hookup:

a. Set the generator output to 0 V.
b. Disconnect the equipment from the generator output and the input connector of the channel last tested.

Check DC gain accuracy, ATI channel
Equipment required Prerequisites

One DC calibration generator, (Item 7 on page 48)

Two dual-banana connectors, (Item 6 on page 48)

Two cables, (Item 5 on page 48)

One BNC “T”, male to 2 females, (Item 25 on page 50)

One SMA male-to-female BNC adapter, (Item 16 on page 49)

On adapter, SMA female-to-female 1.85, (Item 30 on page 51)

The instrument must meet the prerequisites. (See
Prerequisites on page 47.)

WARNING: The generator is capable of outputting dangerous voltages. To avoid injury, be sure to set the DC calibration
generator to off or 0 volts before connecting, disconnecting, and/or moving the test hookup during this procedure.

CAUTION: The generator is capable of outputting voltages that exceed the maximum input voltage of the instrument. To avoid
damaging the instrument, be sure to set the DC calibration generator to off or 0 volts before connecting or disconnecting the test
hookup during this procedure.

1. Install the test hookup and preset the instrument controls:

a. Hook up the test-signal source:

• Set the output of a DC calibration generator to off or 0 volts. Set the DC impedance of the generator to 50 Ω.
• Connect the generator to Ch 2 through an adapter. Refer to the following figure.

Figure 10: DC gain accuracy test hookup

b. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
c. Modify the default settings:

• From the button bar, select Horiz/Acq and select the Acquisition tab.
• Set the Horizontal Scale to 1 ms/div.
• Set the Record Length to 5000.
• Select Average and set the number of averages to 16.
• Set the Trigger Source to Line.
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2. Confirm input channels are within limits for DC gain accuracy.

a. Select channel 2:

• Set the generator output to 0 V.
• Select channel 2.

b. Turn on the measurement Mean for the channel:

• From the tool bar, select Measure and select the Ampl tab, More, and then select Mean to measure the mean of the channel.
• Press the X (Close) button.

c. Set the vertical scale: Set the vertical Scale to one of the settings in the following table that is not yet checked, starting with the first
setting.

Table 6: Gain accuracy

Ch Scale setting
Position
setting (Divs) Offset setting Generator setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch2 10 mV 0 0 V 30 mV +58.8 mV to
+61.2 mV

-30 mV

0 +0.2 V 170 mV +58.8 mV to
+61.2 mV

230 mV

0 -0.2 V -230 mV +58.8 mV to
+61.2 mV

-170 mV

Ch2 20 mV 0 0 V 60 mV +117.6 mV to
+122.4 mV

-60 mV

0 +0.1 V 40 mV +117.6 mV to
+122.4 mV

160 mV

0 -0.1 V -160 mV +117.6 mV to
+122.4 mV

-40 mV

Ch2 30 mV 0 0 V 90 mV +176.4 mV to
+183.6 mV

-90 mV

d. Display the test signal:

• Display the Vertical Setup menu.
• Use the keypad to set the Position and Offset vertical settings as listed in the table for the current vertical scale setting. The

baseline level may move off screen.
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• Set the generator so that its Sense value and polarity matches the generator setting in the table for the vertical scale, position,
and offset settings you have made. The DC test level should appear at about 3 division on screen. Using the Vertical Position,
move the test level to 3 divisions above the center screen.

Note: It’s important to use the Sense reading of the generator instead of the Output level when adjusting the generator to
the specified voltage setting.

e. Measure the test signal: Press the Close button.

• Read the measurement results at the measurement statistics Mean measurement readout. Refer to the following figure.
• Record the Mean in the Measurement Mean column. (See Table 6 on page 116.)

Figure 11: Measurement of DC gain accuracy

f. Measure second mean:

• Set the generator to the second level and polarity indicated in the table for the vertical scale, position, and offset settings you
have made.

• Repeat substep 2.e on page 117 using the current vertical scale, position, offset, and new generator setting for the second
mean.

g. Check against limits:

• Subtract the second measurement mean from the first measurement mean for the current vertical scale, termination voltage,
position, and offset.

• Record the difference of the two mean measurements in the Difference of Measurement Means column of the table. (See Table
6 on page 116.)

• CHECK that the Difference of Measurement Mean is within the limits listed for the current vertical scale/position/offset/
generator settings. Enter measurement mean difference value on test record.

h. Repeat substeps 2.d on page 116 through 2.g on page 117, using the next position, offset and generator settings listed in the table
for the current vertical scale.

i. Repeat substeps 2.c on page 116 through 2.h on page 117 until all vertical scale settings, listed in the table are checked. (See
Table 6 on page 116.)

3. Disconnect the hookup:

a. Set the generator output to 0 V.
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b. Disconnect the generator output from the channel last tested.

Check DC gain accuracy, TekConnect channels
Equipment required Prerequisites

One DC calibration generator (Item 7 on page 48)

Two, dual-banana connectors, (Item 6 on page 48)

Two cables, (Item 5 on page 48)

One SMA male-to-female BNC adapter (Item 18 on page 50)

One BNC “T”, male to 2 females (Item 25 on page 50)

The instrument must meet the prerequisites. (See
Prerequisites on page 47.)

WARNING: The generator is capable of outputting dangerous voltages. To avoid injury, be sure to set the DC calibration
generator to off or 0 volts before connecting, disconnecting, and/or moving the test hookup during this procedure.

1. Install the test hookup and preset the instrument controls:

a. Hook up the test-signal source:

• Set the output of a DC calibration generator to off or 0 volts. Set the DC impedance of the generator to 50 Ω.
• Connect the generator to Ch 1 through an adapter. Refer to the following figure.

Figure 12: DC gain accuracy test hookup

b. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
c. Modify the default settings:

• From the button bar, select Horiz/Acq and select the Acquisition tab.
• Set the Horizontal Scale to 1 ms/div.
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• Set the Record Length to 5000.
• Set the Acquisition Mode to Hi Res.
• Set the Trigger Source to Line.

2. Confirm input channels are within limits for DC gain accuracy. Do the following substeps - test Ch 1 first, skipping substep
2.a on page 119 of this step since Ch 1 is already selected from step 1 on page 118.

a. Select an unchecked channel:

• From the tool bar, select Measure and then Clear All to remove the previous measurement.
• Press the Display button of the channel just confirmed to remove the channel from the display.
• Press the Channel tab and the Display button that corresponds to the channel you are to confirm. On instruments with an ATI

channel, do not check Channel 2.
• Set the generator output to 0 V.
• Move the test hookup to the channel you selected.

b. Turn on the measurement Mean for the channel:

• From the tool bar, select Measure and select the Ampl tab, More, and then select Mean to measure the mean of the current
channel.

• Press the X (Close) button.
c. Set the vertical scale: Set the vertical Scale to one of the settings in the following table that is not yet checked, starting with the first

setting.

Table 7: Gain accuracy

Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch1 6.25 mV 0 V 0 0 V 24.5 mV +48.02 mV to
+49.98 mV

-24.5 mV

0 +1 V 1.025 V +48.02 mV to
+49.98 mV

976 mV

0 -1 V -976 mV +48.02 mV to
+49.98 mV

-1.026 V

3.4 V -5 3.4 V 3.456 V +48.02 mV to
+49.98 mV

3.407 V

-5 2.4 V 2.456 V +48.02 mV to
+49.98 mV

2.407 V

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

-3.4 V 5 -3.4 V -3.407 V +48.02 mV to
+49.98 mV

-3.456 V

5 -2.4 V -2.407 V +48.02 mV to
+49.98 mV

-2.456 V

Ch1 10 mV 0 V 0 0 V 39 mV +76.44 mV to
+79.56 mV

-39 mV

0 +1 V 1.039 V +76.44 mV to
+79.56 mV

961 mV

0 -1 V -961 mV +76.44 mV to
+79.56 mV

-1.039 V

3.4 V -5 3.4 V 3.489 V +76.44 mV to
+79.56 mV

3.411 V

-5 2.4 V 2.489 V +76.44 mV to
+79.56 mV

2.411 V

-3.4 V 0 -3.4 V -3.411 V +76.44 mV to
+79.56 mV

-3.489 V

0 -2.4 V -2.411 V +76.44 mV to
+79.56 mV

-2.489 V

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch1 20 mV 0 V 0 0 V 78 mV +152.9 mV to
+159.1 mV

-78 mV

0 +1 V 1.078 V +152.9 mV to
+159.1 mV

922 mV

0 -1 V -922 mV +152.9 mV to
+159.1 mV

-1.078 V

3.4 V -5 3.4 V 3.578 V +152.9 mV to
+159.1 mV

3.422 V

-5 2.4 V 2.578 V +152.9 mV to
+159.1 mV

2.422 V

-3.4 V 5 -3.4 V -3.422 V +152.9 mV to
+159.1 mV

-3.578 V

5 -2.4 V -2.422 V +152.9 mV to
+159.1 mV

-2.578 V

Ch1 50 mV 0 V 0 0 V 195 mV +382.2 mV to
+397.8 mV

-195 mV

0 +1 V 1.195 V +382.2 mV to
+397.8 mV

805 mV

0 -1 V -805 mV +382.2 mV to
+397.8 mV

-1.195 V

Table continued…

Performance verification

DPO70000SX Series Oscilloscopes Specifications and Performance Verification 121



Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

3.4 V -5 3.4 V 3.845 V +382.2 mV to
+397.8 mV

3.455 V

-5 2.4 V 2.845 V +382.2 mV to
+397.8 mV

2.455 V

-3.4 V 5 -3.4 V -3.455 V +382.2 mV to
+397.8 mV

-3.845 V

5 -2.4 V -2.455 V +382.2 mV to
+397.8 mV

-2.845 V

Ch1 100 mV 0 V 0 0 V 390 mV +764 mV to
+796 mV

-390 mV

0 +1 V 1.39 V +764 mV to
+796 mV

610 mV

0 -1 V -610 mV +764 mV to
+796 mV

-1.39 V

3.4 V -5 3.4 V 4.29 V +764 mV to
+796 mV

3.51 V

-5 2.4 V 3.29 V +764 mV to
+796 mV

2.51 V

-3.4 V 5 -3.4 V -3.51 V +764 mV to
+796 mV

-4.29 V

5 -2.4 V -2.51 V +764 mV to
+796 mV

-3.29 V

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch1 120 mV 0 V 0 0 V 468 mV +917.3 mV to
+954.7 mV

-468 mV

0 +1 V 1.468 V +917.3 mV to
+954.7 mV

532 mV

0 -1 V -532 mV +917.3 mV to
+954.7 mV

-1.468 V

3.4 V -5 3.4 V 4.468 V +917.3 mV to
+954.7 mV

3.532 V

-5 2.4 V 3.468 V +917.3 mV to
+954.7 mV

2.532 V

-3.4 V 5 -3.4 V -3.532 V +917.3 mV to
+954.7 mV

-4.468 V

5 -2.4 V -2.532 V +917.3 mV to
+954.7 mV

-3.468 V

Ch1 140 mV 0 V 0 –1 V –580 mV +823.2 mV to
+856.8 mV

–1.42 V

0 0 V 546 mV +1.070 V to
+1.114 V

–546 mV

0 +1 V 1.42 V +823.2 mV to
+856.8 mV

580 mV

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch1 200 mV 0 V 0 –0.9 V –300 mV +1.176 V to
+1.224 V

–1.50 V

0 0 V 780 mV +1.529 V to
+1.591 V

–780 mV

0 +0.9 V 1.50 V +1.176 V to
+1.224 V

300 mV

Ch1 400 mV 0 V 0 –0.3 V 900 mV +2.352 V to
+2.448 V

–1.50 V

0 0 V 1.20 V +2.352 V to
+2.448 V

–1.20 V

0 +0.3 V 1.50 V +2.352 V to
+2.448 V

–900 mV

Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch2
(non-
ATI)

6.25 mV 0 V 0 0 V 24.5 mV +48.02 mV to
+49.98 mV

-24.5 mV

0 +1 V 1.025 V +48.02 mV to
+49.98 mV

976 mV

0 -1 V -976 mV +48.02 mV to
+49.98 mV

-1.026 V

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

3.4 V -5 3.4 V 3.456 V +48.02 mV to
+49.98 mV

3.407 V

-5 2.4 V 2.456 V +48.02 mV to
+49.98 mV

2.407 V

-3.4 V 5 -3.4 V -3.407 V +48.02 mV to
+49.98 mV

-3.456 V

5 -2.4 V -2.407 V +48.02 mV to
+49.98 mV

-2.456 V

Ch2
(non-
ATI)

10 mV 0 V 0 0 V 39 mV +76.44 mV to
+79.56 mV

-39 mV

0 +1 V 1.039 V +76.44 mV to
+79.56 mV

961 mV

0 -1 V -961 mV +76.44 mV to
+79.56 mV

-1.039 V

3.4 V -5 3.4 V 3.489 V +76.44 mV to
+79.56 mV

3.411 V

-5 2.4 V 2.489 V +76.44 mV to
+79.56 mV

2.411 V

-3.4 V 0 -3.4 V -3.411 V +76.44 mV to
+79.56 mV

-3.489 V

0 -2.4 V -2.411 V +76.44 mV to
+79.56 mV

-2.489 V

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch2
(non-
ATI)

20 mV 0 V 0 0 V 78 mV +152.9 mV to
+159.1 mV

-78 mV

0 +1 V 1.078 V +152.9 mV to
+159.1 mV

922 mV

0 -1 V -922 mV +152.9 mV to
+159.1 mV

-1.078 V

3.4 V -5 3.4 V 3.578 V +152.9 mV to
+159.1 mV

3.422 V

-5 2.4 V 2.578 V +152.9 mV to
+159.1 mV

2.422 V

-3.4 V 5 -3.4 V -3.422 V +152.9 mV to
+159.1 mV

-3.578 V

5 -2.4 V -2.422 V +152.9 mV to
+159.1 mV

-2.578 V

Ch2
(non-
ATI)

50 mV 0 V 0 0 V 195 mV +382.2 mV to
+397.8 mV

-195 mV

0 +1 V 1.195 V +382.2 mV to
+397.8 mV

805 mV

0 -1 V -805 mV +382.2 mV to
+397.8 mV

-1.195 V

Table continued…

Performance verification

126



Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

3.4 V -5 3.4 V 3.845 V +382.2 mV to
+397.8 mV

3.455 V

-5 2.4 V 2.845 V +382.2 mV to
+397.8 mV

2.455 V

-3.4 V 5 -3.4 V -3.455 V +382.2 mV to
+397.8 mV

-3.845 V

5 -2.4 V -2.455 V +382.2 mV to
+397.8 mV

-2.845 V

Ch2
(non-
ATI)

100 mV 0 V 0 0 V 390 mV +764 mV to
+796 mV

-390 mV

0 +1 V 1.39 V +764 mV to
+796 mV

610 mV

0 -1 V -610 mV +764 mV to
+796 mV

-1.39 V

3.4 V -5 3.4 V 4.29 V +764 mV to
+796 mV

3.51 V

-5 2.4 V 3.29 V +764 mV to
+796 mV

2.51 V

-3.4 V 5 -3.4 V -3.51 V +764 mV to
+796 mV

-4.29 V

5 -2.4 V -2.51 V +764 mV to
+796 mV

-3.29 V

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch2
(non-
ATI)

120 mV 0 V 0 0 V 468 mV +917.3 mV to
+954.7 mV

-468 mV

0 +1 V 1.468 V +917.3 mV to
+954.7 mV

532 mV

0 -1 V -532 mV +917.3 mV to
+954.7 mV

-1.468 V

3.4 V -5 3.4 V 4.468 V +917.3 mV to
+954.7 mV

3.532 V

-5 2.4 V 3.468 V +917.3 mV to
+954.7 mV

2.532 V

-3.4 V 5 -3.4 V -3.532 V +917.3 mV to
+954.7 mV

-4.468 V

5 -2.4 V -2.532 V +917.3 mV to
+954.7 mV

-3.468 V

Ch2
(non-
ATI)

140 mV 0 V 0 –1 V –580 mV +823.2 mV to
+856.8 mV

–1.42 V

0 0 V 546 mV +1.070 V to
+1.114 V

–546 mV

0 +1 V 1.42 V +823.2 mV to
+856.8 mV

580 mV

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch2
(non-
ATI)

200 mV 0 V 0 –0.9 V –300 mV +1.176 V to
+1.224 V

–1.50 V

0 0 V 780 mV +1.529 V to
+1.591 V

–780 mV

0 +0.9 V 1.50 V +1.176 V to
+1.224 V

300 mV

Ch2
(non-
ATI)

400 mV 0 V 0 –0.3 V 900 mV +2.352 V to
+2.448 V

–1.50 V

0 0 V 1.20 V +2.352 V to
+2.448 V

–1.20 V

0 +0.3 V 1.50 V +2.352 V to
+2.448 V

–900 mV

Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch3 6.25 mV 0 V 0 0 V 24.5 mV +48.02 mV to
+49.98 mV

-24.5 mV

0 +1 V 1.025 V +48.02 mV to
+49.98 mV

976 mV

0 -1 V -976 mV +48.02 mV to
+49.98 mV

-1.026 V

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

3.4 V -5 3.4 V 3.456 V +48.02 mV to
+49.98 mV

3.407 V

-5 2.4 V 2.456 V +48.02 mV to
+49.98 mV

2.407 V

-3.4 V 5 -3.4 V -3.407 V +48.02 mV to
+49.98 mV

-3.456 V

5 -2.4 V -2.407 V +48.02 mV to
+49.98 mV

-2.456 V

Ch3 10 mV 0 V 0 0 V 39 mV +76.44 mV to
+79.56 mV

-39 mV

0 +1 V 1.039 V +76.44 mV to
+79.56 mV

961 mV

0 -1 V -961 mV +76.44 mV to
+79.56 mV

-1.039 V

3.4 V -5 3.4 V 3.489 V +76.44 mV to
+79.56 mV

3.411 V

-5 2.4 V 2.489 V +76.44 mV to
+79.56 mV

2.411 V

-3.4 V 0 -3.4 V -3.411 V +76.44 mV to
+79.56 mV

-3.489 V

0 -2.4 V -2.411 V +76.44 mV to
+79.56 mV

-2.489 V

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch3 20 mV 0 V 0 0 V 78 mV +152.9 mV to
+159.1 mV

-78 mV

0 +1 V 1.078 V +152.9 mV to
+159.1 mV

922 mV

0 -1 V -922 mV +152.9 mV to
+159.1 mV

-1.078 V

3.4 V -5 3.4 V 3.578 V +152.9 mV to
+159.1 mV

3.422 V

-5 2.4 V 2.578 V +152.9 mV to
+159.1 mV

2.422 V

-3.4 V 5 -3.4 V -3.422 V +152.9 mV to
+159.1 mV

-3.578 V

5 -2.4 V -2.422 V +152.9 mV to
+159.1 mV

-2.578 V

Ch3 50 mV 0 V 0 0 V 195 mV +382.2 mV to
+397.8 mV

-195 mV

0 +1 V 1.195 V +382.2 mV to
+397.8 mV

805 mV

0 -1 V -805 mV +382.2 mV to
+397.8 mV

-1.195 V

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

3.4 V -5 3.4 V 3.845 V +382.2 mV to
+397.8 mV

3.455 V

-5 2.4 V 2.845 V +382.2 mV to
+397.8 mV

2.455 V

-3.4 V 5 -3.4 V -3.455 V +382.2 mV to
+397.8 mV

-3.845 V

5 -2.4 V -2.455 V +382.2 mV to
+397.8 mV

-2.845 V

Ch3 100 mV 0 V 0 0 V 390 mV +764 mV to
+796 mV

-390 mV

0 +1 V 1.39 V +764 mV to
+796 mV

610 mV

0 -1 V -610 mV +764 mV to
+796 mV

-1.39 V

3.4 V -5 3.4 V 4.29 V +764 mV to
+796 mV

3.51 V

-5 2.4 V 3.29 V +764 mV to
+796 mV

2.51 V

-3.4 V 5 -3.4 V -3.51 V +764 mV to
+796 mV

-4.29 V

5 -2.4 V -2.51 V +764 mV to
+796 mV

-3.29 V

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch3 120 mV 0 V 0 0 V 468 mV +917.3 mV to
+954.7 mV

-468 mV

0 +1 V 1.468 V +917.3 mV to
+954.7 mV

532 mV

0 -1 V -532 mV +917.3 mV to
+954.7 mV

-1.468 V

3.4 V -5 3.4 V 4.468 V +917.3 mV to
+954.7 mV

3.532 V

-5 2.4 V 3.468 V +917.3 mV to
+954.7 mV

2.532 V

-3.4 V 5 -3.4 V -3.532 V +917.3 mV to
+954.7 mV

-4.468 V

5 -2.4 V -2.532 V +917.3 mV to
+954.7 mV

-3.468 V

Ch3 140 mV 0 V 0 –1 V –580 mV +823.2 mV to
+856.8 mV

–1.42 V

0 0 V 546 mV +1.070 V to
+1.114 V

–546 mV

0 +1 V 1.42 V +823.2 mV to
+856.8 mV

580 mV

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch3 200 mV 0 V 0 –0.9 V –300 mV +1.176 V to
+1.224 V

–1.50 V

0 0 V 780 mV +1.529 V to
+1.591 V

–780 mV

0 +0.9 V 1.50 V +1.176 V to
+1.224 V

300 mV

Ch3 400 mV 0 V 0 –0.3 V 900 mV +2.352 V to
+2.448 V

–1.50 V

0 0 V 1.20 V +2.352 V to
+2.448 V

–1.20 V

0 +0.3 V 1.50 V +2.352 V to
+2.448 V

–900 mV

Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch4 6.25 mV 0 V 0 0 V 24.5 mV +48.02 mV to
+49.98 mV

-24.5 mV

0 +1 V 1.025 V +48.02 mV to
+49.98 mV

976 mV

0 -1 V -976 mV +48.02 mV to
+49.98 mV

-1.026 V

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

3.4 V -5 3.4 V 3.456 V +48.02 mV to
+49.98 mV

3.407 V

-5 2.4 V 2.456 V +48.02 mV to
+49.98 mV

2.407 V

-3.4 V 5 -3.4 V -3.407 V +48.02 mV to
+49.98 mV

-3.456 V

5 -2.4 V -2.407 V +48.02 mV to
+49.98 mV

-2.456 V

Ch4 10 mV 0 V 0 0 V 39 mV +76.44 mV to
+79.56 mV

-39 mV

0 +1 V 1.039 V +76.44 mV to
+79.56 mV

961 mV

0 -1 V -961 mV +76.44 mV to
+79.56 mV

-1.039 V

3.4 V -5 3.4 V 3.489 V +76.44 mV to
+79.56 mV

3.411 V

-5 2.4 V 2.489 V +76.44 mV to
+79.56 mV

2.411 V

-3.4 V 0 -3.4 V -3.411 V +76.44 mV to
+79.56 mV

-3.489 V

0 -2.4 V -2.411 V +76.44 mV to
+79.56 mV

-2.489 V

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch4 20 mV 0 V 0 0 V 78 mV +152.9 mV to
+159.1 mV

-78 mV

0 +1 V 1.078 V +152.9 mV to
+159.1 mV

922 mV

0 -1 V -922 mV +152.9 mV to
+159.1 mV

-1.078 V

3.4 V -5 3.4 V 3.578 V +152.9 mV to
+159.1 mV

3.422 V

-5 2.4 V 2.578 V +152.9 mV to
+159.1 mV

2.422 V

-3.4 V 5 -3.4 V -3.422 V +152.9 mV to
+159.1 mV

-3.578 V

5 -2.4 V -2.422 V +152.9 mV to
+159.1 mV

-2.578 V

Ch4 50 mV 0 V 0 0 V 195 mV +382.2 mV to
+397.8 mV

-195 mV

0 +1 V 1.195 V +382.2 mV to
+397.8 mV

805 mV

0 -1 V -805 mV +382.2 mV to
+397.8 mV

-1.195 V

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

3.4 V -5 3.4 V 3.845 V +382.2 mV to
+397.8 mV

3.455 V

-5 2.4 V 2.845 V +382.2 mV to
+397.8 mV

2.455 V

-3.4 V 5 -3.4 V -3.455 V +382.2 mV to
+397.8 mV

-3.845 V

5 -2.4 V -2.455 V +382.2 mV to
+397.8 mV

-2.845 V

Ch4 100 mV 0 V 0 0 V 390 mV +764 mV to
+796 mV

-390 mV

0 +1 V 1.39 V +764 mV to
+796 mV

610 mV

0 -1 V -610 mV +764 mV to
+796 mV

-1.39 V

3.4 V -5 3.4 V 4.29 V +764 mV to
+796 mV

3.51 V

-5 2.4 V 3.29 V +764 mV to
+796 mV

2.51 V

-3.4 V 5 -3.4 V -3.51 V +764 mV to
+796 mV

-4.29 V

5 -2.4 V -2.51 V +764 mV to
+796 mV

-3.29 V

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch4 120 mV 0 V 0 0 V 468 mV +917.3 mV to
+954.7 mV

-468 mV

0 +1 V 1.468 V +917.3 mV to
+954.7 mV

532 mV

0 -1 V -532 mV +917.3 mV to
+954.7 mV

-1.468 V

3.4 V -5 3.4 V 4.468 V +917.3 mV to
+954.7 mV

3.532 V

-5 2.4 V 3.468 V +917.3 mV to
+954.7 mV

2.532 V

-3.4 V 5 -3.4 V -3.532 V +917.3 mV to
+954.7 mV

-4.468 V

5 -2.4 V -2.532 V +917.3 mV to
+954.7 mV

-3.468 V

Ch4 140 mV 0 V 0 –1 V –580 mV +823.2 mV to
+856.8 mV

–1.42 V

0 0 V 546 mV +1.070 V to
+1.114 V

–546 mV

0 +1 V 1.42 V +823.2 mV to
+856.8 mV

580 mV

Table continued…
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Ch Scale setting
Termination
setting

Position
setting (Divs)

Offset
setting

Generato
r setting

Measurement
mean

Difference of
measurement
means Accuracy limits

Ch4 200 mV 0 V 0 –0.9 V –300 mV +1.176 V to
+1.224 V

–1.50 V

0 0 V 780 mV +1.529 V to
+1.591 V

–780 mV

0 +0.9 V 1.50 V +1.176 V to
+1.224 V

300 mV

Ch4 400 mV 0 V 0 –0.3 V 900 mV +2.352 V to
+2.448 V

–1.50 V

0 0 V 1.20 V +2.352 V to
+2.448 V

–1.20 V

0 +0.3 V 1.50 V +2.352 V to
+2.448 V

–900 mV

d. Display the test signal:

• Display the Vertical Setup menu.
• Use the keypad to set the Termination Voltage, Position, and Offset vertical settings as listed in the table for the current vertical

scale setting. The baseline level may move off screen.
• Set the generator so that its Sense value and polarity matches the generator setting in the table for the vertical scale, position,

offset, and termination settings you have made. The DC test level should appear at about 3 division on screen. Using the
Vertical Position, move the test level to 3 divisions above the center screen.

Note: It’s important to use the Sense reading of the generator instead of the Output level when adjusting the generator to
the specified voltage setting.

e. Measure the test signal: Press the Close button.

• Read the measurement results at the measurement statistics Mean measurement readout. Refer to the following figure.
• Record the Mean in the Measurement Mean column. (See Table 7 on page 119.)
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Figure 13: Measurement of DC gain accuracy

f. Measure second mean:

• Set the generator to the second level and polarity indicated in the table for the vertical scale, termination voltage, position, and
offset settings you have made.

• Repeat substep 2.e on page 139 using the current vertical scale, termination voltage, position, offset, and new generator
setting for the second mean.

g. Check against limits:

• Subtract the second measurement mean from the first measurement mean for the current vertical scale, termination voltage,
position, and offset.

• Record the difference of the two mean measurements in the Difference of Measurement Means column of the table. (See Table
7 on page 119.)

• CHECK that the Difference of Measurement Mean is within the limits listed for the current vertical scale/termination/position/
offset/generator settings. Enter measurement mean difference value on the test record.

h. Repeat substeps 2.d on page 139 through 2.g on page 140, using the next position, offset and generator settings listed in the table
for the current vertical scale.

i. Repeat substeps 2.c on page 119 through 2.h on page 140 until all vertical scale settings, listed in the table, are checked for the
channel under test. (See Table 7 on page 119.)

j. Test all channels: Repeat substeps 2.a on page 119 through 2.i on page 140 for all TekConnect channels.

3. Disconnect the hookup:

a. Set the generator output to 0 V.
b. Disconnect the generator output from the channel last tested.
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Check offset accuracy, ATI channel
Equipment Required Prerequisites

One DC calibration generator, (Item 7 on page 48)

Two dual-banana connectors, (Item 6 on page 48)

Two cables, (Item 5 on page 48)

One SMA male-to-female BNC adapter, (Item 16 on page 49)

One BNC “T” adapter, (Item 25 on page 50)

The instrument must meet the prerequisites. (See
Prerequisites on page 47.)

WARNING: The generator is capable of outputting dangerous voltages. To avoid injury, be sure to set the DC calibration
generator to off or 0 volts before connecting, disconnecting, and/or moving the test hookup during this procedure.

1. Install the test hookup and preset the instrument controls:

a. Hook up the test-signal source:

• Set the output of a DC calibration generator to off or 0 volts. Set the DC impedance of the generator to 50 Ω.
• Connect the output of a DC calibration generator to Ch 2 through an adapter. Refer to the following figure.

Figure 14: Offset accuracy test hookup

b. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
c. Modify the default settings:

• Set the Horizontal Scale to 1 ms/div.
• Set the Record Length to 5000.
• Select Average and set the number of averages to 16.
• Set the Trigger Source to Line.

2. Confirm input channel is within limits for offset accuracy.

a. • Set the generator output to 0 V.
• Select the tab that corresponds to the channel you are to confirm and then its Display Off button to display the channel.

b. Turn on the measurement Mean for the channel:

• From the tool bar, select Measure and select the Ampl tab, More, and then select Mean to measure the mean of the current
channel.

• Press the X (Close) button.
c. Set the vertical scale: Set the vertical Scale to one of the settings in the following table that is not yet checked.
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Table 8: Offset accuracy

Scale setting Position setting (Divs) Offset setting 12 Generator setting Accuracy limits

10 mV 0 0 V 0 V –3.0 mV to +3.0 mV

+0.2 V +0.2 V +0.1963 V to +0.2037 V 

-0.2 V -0.2 V –0.2037 V to –0.1963 V

20 mV 0 0 V 0 V –4.0 mV to +4.0 mV

+0.1 V +0.1 V +0.0957 V to +0.1044 V 

-0.1 V -0.1 V –0.1044 V to –0.0957 V

30 mV 0 0 V 0 V –5.0 mV to +5.0 mV

d. Display the test signal:

• Display the Vertical Setup menu.
• Use the keypad to set the Position, and Offset vertical settings as listed in the table for the current vertical scale setting. The

baseline level may move off screen.
• Set the generator so that its Sense value and polarity matches the generator setting in the table for the vertical scale, position,

and offset settings you have made.

Note: It’s important to use the Sense reading of the generator instead of the Output level when adjusting the generator to
the specified voltage setting.

e. Measure the test signal: Press Close. Read the measurement results at the Mean measurement readout. Refer to the following
figure.

Figure 15: Measurement of offset accuracy

12 Set as precisely as the instrument's offset resolution permits.
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f. Check against limits:

• CHECK that the readout for the measurement Mean readout on screen is within the limits listed for the current vertical scale
and position/offset/generator settings. Enter the value on the test record.

• Repeat substep 2.d on page 142, using the offset and generator settings as is listed in the table.
• CHECK that the Mean measurement readout on screen is within the limits listed for the current vertical scale setting and

position/offset/generator settings. Enter the value on the test record.
• Repeat substep 2.d on page 142, using the negative-polarity offset and generator settings as is listed in the table.
• CHECK that the Mean measurement readout on screen is within the limits listed for the current vertical scale setting and

position/offset/generator settings. Enter the value on the test record.
• Repeat substeps 2.c on page 141 through 2.f on page 143 until all vertical scale settings, are checked. (See Table

8 on page 142.)
3. Disconnect the hookup:

a. Set the generator output to 0 V.
b. Disconnect the generator from the channel.

Check offset accuracy, TekConnect channels
Equipment Required Prerequisites

One DC calibration generator (Item 7 on page 48)

Two dual-banana connectors, (Item 6 on page 48)

Two cables, (Item 5 on page 48)

One BNC “T” adapter (Item 25 on page 50)

One SMA male-to-female BNC adapter (Item 18 on page 50)

The instrument must meet the prerequisites. (See
Prerequisites on page 47.)

WARNING: The generator is capable of outputting dangerous voltages. To avoid injury, be sure to set the DC calibration
generator to off or 0 volts before connecting, disconnecting, and/or moving the test hookup during this procedure.

1. Install the test hookup and preset the instrument controls:

a. Hook up the test-signal source:

• Set the output of a DC calibration generator to off or 0 volts. Set the DC impedance of the generator to 50 Ω.
• Connect the output of a DC calibration generator to Ch 1 through an adapter. Refer to the following figure.
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Figure 16: Offset accuracy test hookup

b. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
c. Modify the default settings:

• Set the Horizontal Scale to 1 ms/div.
• Set the Record Length to 5000.
• Set the Acquisition Mode to Hi Res.
• Set the Trigger Source to Line.

2. Confirm input channels are within limits for offset accuracy. Do the following substeps - test Ch 1 first, skipping substep
2.a on page 144 since Ch 1 is already selected from step 1 on page 143.

a. Select an unchecked channel:

• From the tool bar, select Measure and then Clear All to remove the previous measurement.
• From the tool bar, select Vertical and then Display On button of the channel just confirmed to remove the channel from the

display.
• Select the tab that corresponds to the channel you are to confirm and then its Display Off button to display the channel.
• Set the generator output to 0 V.
• Move the test hookup to the channel you selected.

b. Turn on the measurement Mean for the channel:

• From the tool bar, select Measure and select the Ampl tab, More, and then select Mean to measure the mean of the current
channel.

• Press the X (Close) button.
c. Set the vertical scale: Set the vertical Scale to one of the settings in the following table that is not yet checked.
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Table 9: Offset accuracy

Scale setting
Position setting
(Divs)

Termination
setting Offset setting 13 Generator setting Accuracy limits

6.25 mV 0 0 V 0 V 0 V –3.125 mV to +3.125 mV

+3.5 V +3.4 V +3.4 V +3.3831 V to +3.4169 V 

-3.5 V -3.4 V -3.4 V –3.4169 V to –3.3831 V 

10 mV 0 0 V 0 V 0 V –3.5 mV to +3.5 mV

+3.5 V +3.4 V +3.4 V +3.3827 V to +3.4173 V 

-3.5 V -3.4 V -3.4 V –3.4173 V to –3.3827 V

20 mV 0 0 V 0 V 0 V –4.5 mV to +4.5 mV

+3.5 V +3.4 V +3.4 V +3.3817 V to +3.4183 V 

-3.5 V -3.4 V -3.4 V –3.4183 V to –3.3817 V

50 mV 0 0 V 0 V 0 V –7.5 mV to +7.5 mV

+3.5 V +3.4 V +3.4 V +3.3787 V to +3.4213 V 

-3.5 V -3.4 V -3.4 V –3.4213 V to –3.3787 V

100 mV 0 0 V 0 V 0 V –12.5 mV to +12.5 mV

+3.5 V +3.4 V +3.4 V +3.3737 V to +3.4263 V

-3.5 V -3.4 V -3.4 V –3.4263 V to –3.3737 V

120 mV 0 0 V 0 V 0 V –14.5 mV to +14.5 mV

+3.5 V +3.4 V +3.4 V +3.3717 V to +3.4283 V

-3.5 V -3.4 V -3.4 V –3.4283 V to –3.3717 V

140 mV 0 0 V –6 V –6 V –6.0634 V to +5.9366 V

0 V 0 V 0 V –27.4 mV to +27.4 mV

0 V +6 V +6 V –5.9366 V to +6.0634 V

Table continued…

13 Set as precisely as the instrument's offset resolution permits.

Performance verification

DPO70000SX Series Oscilloscopes Specifications and Performance Verification 145



Scale setting
Position setting
(Divs)

Termination
setting Offset setting 13 Generator setting Accuracy limits

200 mV 0 0 V –6 V –6 V –6.0694 V to –5.9306 V

0 V 0 V 0 V –33.4 V to +33.4 V

0 V +6 V +6 V +5.9306 V to +6.0694 V

400 mV 0 0 V –6 V –6 V –6.0894 V to –5.9106 V

0 V 0 V 0 V –53.4 mV to +53.4 mV

0 V +6 V +6 V +5.9106 mV to +6.0894 mV

d. Display the test signal:

• Display the Vertical Setup menu.
• Use the keypad to set the Termination Voltage, Position, and Offset vertical settings as listed in the table for the current vertical

scale setting. The baseline level may move off screen.
• Set the generator so that its Sense value and polarity matches the generator setting in the table for the vertical scale,

termination voltage, position, and offset settings you have made.

Note: It’s important to use the Sense reading of the generator instead of the Output level when adjusting the generator to
the specified voltage setting.

e. Measure the test signal: Press Close. Read the measurement results at the Mean measurement readout. Refer to the following
figure.

Figure 17: Measurement of offset accuracy

f. Check against limits:

13 Set as precisely as the instrument's offset resolution permits.
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• CHECK that the readout for the measurement Mean readout on screen is within the limits listed for the current vertical scale
and position/offset/generator settings. Enter the value on the test record.

• Repeat substep 2.d on page 146, using the offset and generator settings as is listed in the table.
• CHECK that the Mean measurement readout on screen is within the limits listed for the current vertical scale setting and

position/offset/termination/generator settings. Enter the value on the test record.
• Repeat substep 2.d on page 146, using the negative-polarity offset and generator settings as is listed in the table.
• CHECK that the Mean measurement readout on screen is within the limits listed for the current vertical scale setting and

position/offset/termination/generator settings. Enter the value on the test record.
• Repeat substeps 2.c on page 144 through 2.f on page 146 until all vertical scale settings, are checked for the channel under

test. (See Table 9 on page 145.)
g. Test all channels: Repeat substeps 2.a on page 144 through 2.f on page 146 for all TekConnect channels.

3. Disconnect the hookup:

a. Set the generator output to 0 V.
b. Disconnect the generator from the channel last tested.

Check analog bandwidth, ATI channel
Equipment Required Prerequisites

One sine wave generator (Item 9 on page 49)

One level meter and power sensor (Item 10 on page 49)

One cable, (Item 31 on page 51)

(See Prerequisites on page 47.)

1. Install the test hookup and preset the instrument controls:

a. Initialize the instrument:

• Pull down the File menu, select Recall Default Setup.
b. Hook up the test-signal source: Connect the sine wave output of the sine wave generator to Ch 2. Set the output of the generator

to a reference frequency of 100 MHz. (See Figure 18 on page 148.)
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Figure 18: Channel bandwidth test hookup

c. Modify the default settings:

• From the button bar, select Horiz/Acq and select the Horizontal tab. Set the Sample Rate to 200 GS/s.
• Set the horizontal Scale to 40 ns.
• Set Mode to Manual.
• Set the Record Length to 1000000.
• Select Vertical, select Vertical Setup.
• Press Display Off to turn off Chan 1.
• Select the Chan 2 tab.
• Press Display Off to turn on Chan 2.
• Check Force Constant Sample Rate (Digital filters ensured).
• From the Bandwidth drop-down list, select the maximum bandwidth for your instrument.

2. Confirm the input channels are within limits for bandwidth:

Table 10: Channel bandwidth

Vertical scale
Reference amplitude
(3.5 div) Horizontal scale

Test frequency

-3 dB limitsDPO77002SX

10 mV 35 mV 1 ns 67 GHz ≥24.7 mV

20 mV 70 mV 1 ns 67 GHz ≥49.5 mV

30 mV 105 mV 1 ns 67 GHz ≥74.2 mV
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Table 11: Channel bandwidth

Vertical scale

Reference
amplitude
(3.5 div)

Horizontal
scale

Test frequency

-3 dB limitsDPO77002SX DPO75902SX DPO75002SX

10 mV 35 mV 400 ps 67 GHz 59 GHz 49.94445 GHz ≥24.7 mV

20 mV 70 mV 400 ps 67 GHz 59 GHz 49.94445 GHz ≥49.5 mV

30 mV 105 mV 400 ps 67 GHz 59 GHz 49.94445 GHz ≥74.2 mV

a. Set the trigger source: Set the trigger Source to Line.
b. Set the vertical scale:

For the channel you are testing, set the vertical Scale to the setting listed in the tables (starting with the lowest setting). See the
preceding Channel bandwidth table that applies to your instrument.

c. Set the trigger coupling: From the button bar, select Trigger and select Coupling DC.
d. Display the test signal: Do the following subparts to first display the reference signal and then the test signal.

• From the button bar select Measure; then select the Time tab.
• Select the Freq button to measure the frequency of the current channel.
• Select the Ampl tab. Select the Amplitude button.
• From the Annotation drop-down list, select None.
• Select the Statistics button, then select the Mean button.
• Click the X (Close) button.
• Set the generator output so the Ch 2 Amplitude mean readout equals the reference amplitude. See the preceding Channel

Bandwidth table that applies to your oscilloscope model. This corresponds to the vertical scale set in substep 2.d on page 149.
• Remove the cable from the CH 2 input and connect it to the power sensor.
• Record the reading on the power meter.
• Set the trigger as follows: Click the Trigger button. Click the Set to 50% button as necessary to trigger a stable display.

e. Measure the test signal:

• Set the frequency of the generator, to the test frequency in the tables that corresponds to the vertical scale set in substep
2.d on page 149.

• Set the horizontal Scale to the horizontal scale setting in the tables that corresponds to the vertical scale set in substep
2.d on page 149.

• Adjust the output of the generator until the reading on the power meter is equal to the reading recorded on the power meter in
step 2.f on page 150. If required by your level meter, input the correction factor for the new frequency.

• Remove the cable from the power sensor and connect it to the Ch 2 input.
• Read the results at the Ch 2 Amplitude mean readout, which will automatically measure the amplitude of the test signal. (See

Figure 19 on page 150.)
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Figure 19: Measurement of analog bandwidth

f. Check against limits:

• CHECK that the measured amplitude is within the limits for the current vertical scale setting in the table.
• Enter the voltage on the test record.
• When finished checking, set the horizontal Scale back to the 20 ns.

g. Check remaining vertical scale settings against limits:

• Check the remaining vertical scale settings for the channel under test by repeating substeps 2.a on page 149 through
2.g on page 150 for each of the remaining scale settings for the channel under test.

• When doing substep 2.d on page 149, skip the subparts that turn on the Chx Amplitude mean measurement.
3. Disconnect the hookup: Disconnect the test hook up from the input connector of the channel last tested.

Check channel bandwidth, TekConnect channels
Equipment Required Prerequisites

One sine wave generator (Item 9 on page 49)

One level meter and power sensor (Item 10 on page 49)

One power splitter (Item 11 on page 49)

50 Ω precision cable 2.92 mm male-to-female (Item 12 on page 49)

One K male-to-male adapter (Item 13 on page 49)

SMA male-to-BNC female adapter (Item 18 on page 50)

(See Prerequisites on page 47.)

1. Install the test hookup and preset the instrument controls:

a. Initialize the instrument:

• Pull down the File menu, select Recall Default Setup.
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b. Modify the default settings:

• Select Vertical, select Vertical Setup.
• From the Bandwidth drop-down list, select the maximum bandwidth for your instrument.
• From the button bar, select Horiz/Acq and select the Horizontal tab. Select Constant Sample Rate mode. Set the Sample

Rate to 250 GS/s or 200 GS/s, depending on instrument setup.
• Set the horizontal Scale to 40 ns.
• From the button bar, select Horiz/Acq and select the Acquisition tab. Set the acquisition mode as follows: Select Sample.
• Set the sampling mode as follows: Select the Interpolate IT button.
• From the button bar, Select Measure. Select Setups Ref Levs; then select the Histogram Mode button.
• If your instrument has enhanced bandwidth, from the toolbar, select Vertical and check Force Constant Sample Rate (Digital

filters ensured). Select Apply to All Channels.
c. Hook up the test-signal source: Connect the sine wave output of the sine wave generator to Ch 1 through a power splitter. Connect

the power sensor of the power meter to the power splitter. Set the output of the generator to a reference frequency of 50 MHz. (See
Figure 20 on page 151.)

Figure 20: Channel bandwidth test hookup
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2. Confirm the input channels are within limits for bandwidth: Do the following substeps - test Ch 1 first, skipping substeps
2.a on page 152 and 2.b on page 152 since Ch 1 is already set up for testing from step 1 on page 150.

a. Select an unchecked channel:

• From the button bar, select Measure and then Clear All to remove the previous measurement.
• From the button bar select Vertical and then Vertical Setup. Click the Display On button of the channel just confirmed to

remove the channel from the display.
• Select the tab that corresponds to the channel you are to confirm, and then click Display OFF.
• Move the test setup to the channel you selected.

Table 12: Channel bandwidth

Vertical scale
Reference
amplitude (3.5 div) Horizontal scale

Test frequency

-3 dB limitsDPO77002SX DPO73304SX

6.25 mV 21.9 mV 1 ns 33 GHz 33 GHz ≥15.5 mV

10 mV 35 mV 1 ns 33 GHz 33 GHz ≥24.7 mV

20 mV 70 mV 1 ns 33 GHz 33 GHz ≥50 mV

50 mV 175 mV 1 ns 33 GHz 33 GHz ≥124 mV

100 mV 350 mV 1 ns 33 GHz 33 GHz ≥248 mV

120 mV 420 mV 1 ns 33 GHz 33 GHz ≥297 mV

140 mV 490 mV 1 ns 33 GHz 33 GHz ≥346 mV

200 mV 700 mV 14 1 ns 33 GHz 33 GHz ≥495 mV

400 mV 1400 mV 15 1 ns 33 GHz 33 GHz ≥990 mV

b. Set the trigger source: Set the trigger Source to Line.
c. Set the vertical scale:

For the channel you are testing, set the vertical Scale to the setting listed in the tables (starting with the lowest setting). See the
preceding Channel bandwidth table that applies to your instrument.

d. Set the trigger coupling: From the button bar, select Trigger and select Coupling DC.
e. Display the test signal: Do the following subparts to first display the reference signal and then the test signal.

• From the button bar select Measure; then select the Time tab.
• Select the Freq button to measure the frequency of the current channel.
• Select the Ampl tab. Select the Amplitude button.
• From the Annotation drop-down list, select None.
• Select the Statistics button, then select the Mean button.

14 If your generator cannot output the required amplitude, determine its maximum output at the Test frequency, and use this for the reference amplitude. The -3 dB limit
can be calculated as: 0.707 × reference amplitude.

15 If your generator cannot output the required amplitude, determine its maximum output at the Test frequency, and use this for the reference amplitude. The -3 dB limit
can be calculated as: 0.707 × reference amplitude.
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• Click the X (Close) button.
• Set the generator output so the Chx Amplitude mean readout equals the reference amplitude. See the preceding Channel

Bandwidth table that applies to your oscilloscope model. This corresponds to the vertical scale set in substep 2.c on page 152.
• Record the reading on the power meter.
• Set the trigger as follows: Click the Trigger button. Click the Set to 50% button as necessary to trigger a stable display. At full

bandwidth, you may also want to make small, manual adjustments to the trigger level.

Note: If you are using Line trigger, the test signal is not shown as a stable display.

f. Measure the test signal:

• Set the frequency of the generator to the test frequency in the tables that corresponds to the vertical scale set in substep
2.c on page 152.

• Set the frequency of the generator, as shown on screen, to the test frequency in the tables that corresponds to the vertical
scale set in substep 2.c on page 152.

• Set the horizontal Scale to the horizontal scale setting in the tables that corresponds to the vertical scale set in substep
2.c on page 152. Click SET to 50% as necessary to trigger the signal.

• Adjust the output of the generator until the reading on the power meter is equal to the reading recorded on the power meter in
step 2.e on page 152.

• Read the results at the Chx Amplitude mean readout, which will automatically measure the amplitude of the test signal. (See
Figure 21 on page 153.)

Figure 21: Measurement of analog bandwidth

g. Check against limits:

• CHECK that the measured amplitude is within the limits for the current vertical scale setting in the table.
• Enter the voltage on the test record.
• When finished checking, set the horizontal Scale back to the 20 ns.

h. Check remaining vertical scale settings against limits:

• Check the remaining vertical scale settings for the channel under test by repeating substeps 2.a on page 152 through
2.g on page 153 for each of the remaining scale settings for the channel under test.
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• When doing substep 2.e on page 152, skip the subparts that turn on the Chx Amplitude mean measurement until you check a
new channel.

• When selecting a new channel and before doing substep 2.d on page 152, click the Clear All button to remove the previous
channel measurements.

i. Test all channels: Repeat substeps 2.a on page 152 through 2.h on page 153 for all TekConnect channels.
3. Disconnect the hookup: Disconnect the test hook up from the input connector of the channel last tested.

Check Input Resistance, ATI channel
Equipment Required Prerequisites

One Digital Multimeter, (Item 24 on page 50)

One Dual-Banana Connector, (Item 6 on page 48)

One precision 50 Ω coaxial cable, (Item 5 on page 48)

One SMA male-to-female BNC adapter, (Item 16 on page 49)

One 1.85 mm to SMA female adapter, (Item 30 on page 51)

One SMA female-to-female adapter, (Item 15 on page 49)

One SMA female short circuit adapter, (Item 22 on page 50)

(See Prerequisites on page 47.)

Figure 22: Input resistance test hookup

1. Install the test hookup and preset the instrument controls:

a. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
b. Short the cable from the multimeter by connecting a shorting adapter and SMA-to-SMA adapter to the BNC-to-SMA adapter.
c. Read and record the resistance of the multimeter leads.
d. Hook up the test-signal source: Connect, through a 50 Ω precision coaxial cable, the input of the multimeter to Ch 2 through

adapters. (See Figure 22 on page 154.)
e. Set the Vertical Scale to 10.0 mV per division

2. Check input impedance against limits:

a. Measure the impedance: Read and record the measured impedance.
b. Remove the dual banana connector from the digital multimeter (DMM), turn it 180 degrees and reinsert it in the DMM input.
c. Measure the impedance: Read and record the measured impedance.
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d. Add the two measurements and divide the result by 2.
e. Subtract the resistance of the multimeter leads from the average that you calculated.
f. Enter the result on the test record.
g. Check - The measurement is within the limits specified in the test record.

3. Set the Vertical Scale to 20 mV per division and repeat step 2 on page 154.
4. Set the Vertical Scale to 30 mV per division and repeat step 2 on page 154.
5. Disconnect the hookup: Disconnect the equipment from the instrument.

Check input resistance, TekConnect channels
Equipment Required Prerequisites

One Digital Multimeter (Item 24 on page 50)

One Dual-Banana Connector, (Item 6 on page 48)

One precision 50 Ω coaxial cable (Item 5 on page 48)

Adapter

One SMA male-to-female BNC adapter (Item 18 on page 50)

One SMA female-to-female adapter (Item 15 on page 49)

One SMA male short circuit adapter (Item 22 on page 50)

(See Prerequisites on page 47.)

Figure 23: Input resistance test hookup

1. Install the test hookup and preset the instrument controls:

a. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
b. Short the cable from the multimeter by connecting a shorting adapter and SMA-to-SMA adapter to the BNC-to-SMA adapter.
c. Read and record the resistance of the multimeter leads.
d. Hook up the test-signal source: Connect, through a 50 Ω precision coaxial cable, the input of the multimeter to Ch 1 through

adapters. (See Figure 23 on page 155.)
e. Set the Vertical Scale to 6.25 mV per division

2. Check input impedance against limits:

a. Measure the impedance: Read and record the measured impedance.
b. Remove the dual banana connector from the digital multimeter (DMM), turn it 180 degrees and reinsert it in the DMM input.
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c. Measure the impedance: Read and record the measured impedance.
d. Add the two measurements and divide the result by 2.
e. Subtract the resistance of the multimeter leads from the average that you calculated.
f. Enter the result on the test record.
g. Check - The measurement is within the limits specified in the test record.

3. Set the Vertical Scale to 140 mV per division and repeat step 2 on page 155.
4. Repeat steps 2 on page 155 through 3 on page 156 for the remaining TekConnect input channels:

a. Move the test setup to an unchecked TekConnect channel.
b. Set the Vertical Scale of the channel to 6.25 mV per division.
c. Repeat steps 2 on page 155 through 3 on page 156.

5. Disconnect the hookup: Disconnect the equipment from the instrument.

Time base system checks
These procedures check those characteristics that relate to the time base system and are listed as checked under Warranted
Characteristics in Specifications. 

Check timebase and delay time accuracy and reference
Equipment Required Prerequisites

One timer-counter (Item 8 on page 48)

One 50 Ω, precision coaxial cable (Item 5 on page 48)

One SMA male-to-female BNC adapter (Item 18 on page 50)

One sine wave generator (Item 9 on page 49)

(See Prerequisites on page 47.)
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Figure 24: Timebase and delay time initial test hookup

1. Install the test hookup and preset the instrument controls:

a. Hook up the test-signal source: Connect the input of the timer-counter to Ref Clock Out . (See Figure 24 on page 157.)

• Set the timer-counter gate to 1 s.
• Set the timer-counter to count the 10 MHz reference output.

b. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
2. Confirm the time base is within limits for accuracies:

a. Check Time base, delay time accuracies, and reference output frequency:

• CHECK that the count on the timer-counter is within limits.
• Enter the count in the table 18.

Time since initial/last
adjustment

Minimum Measured count Maximum

0 9999.999 kHz 10000.001 kHz
1 year 9999.991 kHz 10000.009 kHz
2 years 9999.988 kHz 10000.012 kHz
3 years 9999.985 kHz 10000.015 kHz

• Compare the measured count to the value for the time since the last time base adjustment 19.
• If the count is within the limits, enter Pass in the test record. If the count is not within limits, enter Fail in the test record.

3. Disconnect the hookup: Disconnect the equipment from the instrument.

18 The limits in the table are valid for an ambient temperature in the range 23 ±5 °C.
19 Use the CALibrate:TBASE:Adjust? query to determine the date and time of the last timebase calibration adjustment.
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Figure 25: Timebase and delay time second test hookup

4. Install the test hookup and preset the instrument controls:

a. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
b. Hook up the test-signal source: Connect the output of the sine wave generator to the CH1 input. (See Figure 25 on page 158.)

• From the button bar, select Measure and select the Ampl tab.
• Click the Pk-Pk button.
• Click the X (Close) button.
• Set the Vertical Scale to 50 mV.
• Set the generator for a 10.0 MHz sine wave.
• Set the generator to output a 4 division signal. Adjust the output until the Pk-Pk readout displays 200 mV.

c. Set the instrument controls:

• Move the cable from the CH1 input to the rear-panel Ext Ref In input (See Figure 26 on page 159.)
• From menu mode, select Utilities and select External Signals.
• Click the External button to select the external reference.

Performance verification

158



Figure 26: Timebase and delay time final test hookup

5. Confirm external reference:

a. Perform a signal path compensation:

• Select Utilities and then select Instrument Calibration.
• Select Run SPC (Calibrate on some instruments) and wait for the signal path compensation to finish.

b. Check the completion status: Enter the pass/fail status in the test record. If the Status is Fail, refer the instrument to qualified
service personnel.

6. Disconnect the hookup:

a. Disconnect all test equipment from the instrument.
b. Set the instrument controls:

• From menu mode, select Utilities and select External Signals.
• Click the Internal button to select the internal reference.

c. Perform a signal path compensation:

• Select Utilities and then select Instrument Calibration.
• Select Run SPC (Calibrate on some instruments) and wait for the signal path compensation to finish.

Check delta time measurement accuracy
Equipment Required Prerequisites

One 50 Ω, precision coaxial cable (Item 5 on page 48)

One sine-wave generator (Item 9 on page 49)

One adapter (Item 18 on page 50)

(See Prerequisites on page 47.)
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This procedure checks the Delta Time Measurement Accuracy as listed in Specifications.

Figure 27: Delta time accuracy test hookup

1. Install the test hookup and preset the instrument controls:

a. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
b. Hook up the sine-wave generator:

• When testing an ATI channel: Connect the sine-wave output of the sine-wave generator through a 50 Ω precision coaxial cable
to Ch 2 through an adapter and connector saver.

• When testing a TekConnect channel: Connect the sine-wave output of the sine-wave generator through a 50 Ω precision
coaxial cable to Ch 1 through an adapter.

• Power on the generator.
• Set the sine-wave generator to output a sine wave of the frequency shown in the table. (See Table 14 on page 161.)
• Set the generator output for 60 mV. (This amplitude will be adjusted later to get an 8-division pulse on screen.)
• Set the Vertical Scale to the Volts/Div shown in the table.
• Set the Trigger Source to the input channel you are using.

c. Modify the initialized control settings:

• Readjust the Trigger Level so the trigger level is at 50% of the rising edge of the sine wave.
• From the button bar, select the Horiz/Acq button. Select the Manual button to turn on Manual Mode.
• Select the Acquisition tab. Press the IT button to turn on Interpolate Time Only.
• From the button bar, select the Vertical button.
• Select Digital Filters (DSP) Enabled.
• Set the vertical scale, generator frequency, record length, and sample rate as indicated in the following table for the instrument

under test.
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Table 14: Delta time measurement settings

Instrument Volts/div Sine wave
generator
frequency

Record
length

Sample rate
(IT mode)

Burst
width

Delta time rms
accuracy limit

Delta time pk-pk
accuracy limit

BWE on
DPO77002SX
(TekConnect inputs)

6.25 mV 19.49 GHz 10000 100 GS/s 10 ns 0.620 ps 6.20 ps
50 mV 19.49 GHz 10000 100 GS/s 10 ns 0.400 ps 4.00 ps
100 mV 19.49 GHz 10000 100 GS/s 10 ns 0.400 ps 4.00 ps

DPO75902SX
(TekConnect inputs)

6.25 mV 19.49 GHz 10000 100 GS/s 10 ns 0.620 ps 6.20 ps
50 mV 19.49 GHz 10000 100 GS/s 10 ns 0.400 ps 4.00 ps
100 mV 19.49 GHz 10000 100 GS/s 10 ns 0.400 ps 4.00 ps

DPO75002SX
(TekConnect inputs)

6.25 mV 19.49 GHz 10000 100 GS/s 10 ns 0.620 ps 6.20 ps
50 mV 19.49 GHz 10000 100 GS/s 10 ns 0.400 ps 4.00 ps
100 mV 19.49 GHz 10000 100 GS/s 10 ns 0.400 ps 4.00 ps

DPO73304SX 6.25 mV 19.5 GHz 10000 100 GS/s 10 ns 0.653 ps 6.53 ps
50 mV 19.5 GHz 10000 100 GS/s 10 ns 0.427 ps 4.27 ps
100 mV 19.5 GHz 10000 100 GS/s 10 ns 0.418 ps 4.18 ps

DPO72504SX 6.25 mV 15.5 GHz 10000 100 GS/s 10 ns 0.821 ps 8.21 ps
50 mV 15.5 GHz 10000 100 GS/s 10 ns 0.495 ps 4.95 ps
100 mV 15.5 GHz 10000 100 GS/s 10 ns 0.480 ps 4.80 ps

DPO72304SX 6.25 mV 14.3 GHz 10000 100 GS/s 10 ns 0.806 ps 8.06 ps
50 mV 14.3 GHz 10000 100 GS/s 10 ns 0.495 ps 4.95 ps
100 mV 14.3 GHz 10000 100 GS/s 10 ns 0.487 ps 4.87 ps

DPO72004SX 6.25 mV 124 GHz 10000 100 GS/s 10 ns 0.924 ps 9.24 ps
50 mV 14.3 GHz 10000 100 GS/s 10 ns 0.555 ps 5.55 ps
100 mV 14.3 GHz 10000 100 GS/s 10 ns 0.553 ps 5.53 ps

DPO71604SX 6.25 mV 10.8 GHz 10000 100 GS/s 10 ns 1.09 ps 10.9 ps
50 mV 10.8 GHz 10000 100 GS/s 10 ns 0.598 ps 5.98 ps
100 mV 10.8 GHz 10000 100 GS/s 10 ns 0.596 ps 5.96 ps

DPO71304SX 6.25 mV 8.8 GHz 10000 100 GS/s 10 ns 1.24 ps 12.4 ps
50 mV 8.8 GHz 10000 100 GS/s 10 ns 0.730 ps 7.30 ps
100 mV 8.8 GHz 10000 100 GS/s 10 ns 0.719 ps 7.19 ps

BWE off
DPO73304SX 6.25 mV 19.5 GHz 10000 100 GS/s 10 ns 0.678 ps 6.78 ps

50 mV 19.5 GHz 10000 100 GS/s 10 ns 0.469 ps 4.69 ps
100 mV 19.5 GHz 10000 100 GS/s 10 ns 0.466 ps 4.66 ps

Table continued…
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Instrument Volts/div Sine wave
generator
frequency

Record
length

Sample rate
(IT mode)

Burst
width

Delta time rms
accuracy limit

Delta time pk-pk
accuracy limit

DPO72504SX 6.25 mV 15.5 GHz 10000 100 GS/s 10 ns 0.829 ps 8.29 ps
50 mV 15.5 GHz 10000 100 GS/s 10 ns 0.527 ps 5.27 ps
100 mV 15.5 GHz 10000 100 GS/s 10 ns 0.512 ps 5.12 ps

DPO72304SX 6.25 mV 14.3 GHz 10000 100 GS/s 10 ns 0.840 ps 8.40 ps
50 mV 14.3 GHz 10000 100 GS/s 10 ns 0.534 ps 5.34 ps
100 mV 14.3 GHz 10000 100 GS/s 10 ns 0.526 ps 5.26 ps

DPO72004SX 6.25 mV 124 GHz 10000 100 GS/s 10 ns 0.933 ps 9.33 ps
50 mV 14.3 GHz 10000 100 GS/s 10 ns 0.600 ps 6.00 ps
100 mV 14.3 GHz 10000 100 GS/s 10 ns 0.598 ps 5.98 ps

DPO71604SX 6.25 mV 10.8 GHz 10000 100 GS/s 10 ns 1.05 ps 10.5 ps
50 mV 10.8 GHz 10000 100 GS/s 10 ns 0.680 ps 6.80 ps
100 mV 10.8 GHz 10000 100 GS/s 10 ns 0.674 ps 6.74 ps

DPO71304SX 6.25 mV 8.8 GHz 10000 100 GS/s 10 ns 1.23 ps 12.3 ps
50 mV 8.8 GHz 10000 100 GS/s 10 ns 0.835 ps 8.35 ps
100 mV 8.8 GHz 10000 100 GS/s 10 ns 0.833 ps 8.33 ps

ATI
DPO77002SX 0.1 mV 43.5 GHz 10000 200 GS/s 10 ns 0.315 ps 3.15 ps
DPO77002SX 0.3 mV 43.5 GHz 10000 200 GS/s 10 ns 0.244 ps 2.44 ps
DPO75902SX 0.1 mV 43.5 GHz 10000 200 GS/s 10 ns 0.290 ps 2.90 ps
DPO75902SX 0.3 mV 43.5 GHz 10000 200 GS/s 10 ns 0.233 ps 2.33 ps
DPO75002SX 0.1 mV 43.5 GHz 10000 200 GS/s 10 ns 0.267 ps 2.67 ps
DPO75002SX 0.3 mV 43.5 GHz 10000 200 GS/s 10 ns 0.220 ps 2.20 ps

d. Adjust the generator output as necessary to obtain 8 divisions of displayed waveform.
e. Set up for statistics measurements:

• From the button bar, select Measure and then select the More tab to show the More Measurements menu.
• Click the Burst Width button.
• Select Setups Gating and then select Cursor.
• Click Setup.
• Select Setups Statistics and then select All. Set the Weight n= to 1000. Click Reset to reset the statistics.
• Click Setup.
• Select Setups Ref Levs and then select Absolute.
• Click MidRef. Using the keypad, set the mid reference level to 0 V. Click the X (Close) button.
• Click one of the cursors to assign the multipurpose readouts to the cursors.
• Click the Cursor readout and set the Cursor 1 x position to –5.0 ns, and set the Cursor 2 x position to +5 ns.
• Pull down the Vertical menu, select Zoom Setup.
• Click Zoom to toggle Zoom on.
• Set the Horizontal Zoom position to 45% (100 GS/s) or 40% (200 GS/s), and set the Zoom factor to 20.
• Click a cursor to assign the multipurpose readouts to the Cursors.
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• Set the Cursor 1 x position near the trough of the waveform so that ref level annotation is consistently indicating the same edge
after the trigger point.

• Set the Zoom position to 55% (100 GS/s) or 60% (200 GS/s).
• Click a cursor. Set the Cursor 2 x position so that ref level annotation consistently indicates the same falling edge and the

cursor Δt is close to 10 ns.
f. Read the measurement:

• Select Horiz/Acq > Run/Stop.
• Select Edit > Clear Data. Allow approximately 1000 acquisitions to accumulate, then press Run/Stop.
• Read the Std Dev statistic measurement.
• Enter the time on the test record.
• The standard deviation (St Dev) measurement must be less than or equal to the rms Delta-time accuracy limit for your

instrument. (See Table 14 on page 161.)
• Read the Max and Min statistic measurements.
• Subtract the Max and Min statistic measurements.
• Enter the time on the test record.
• The absolute value of the difference of the Max and Min measurements must be less than or equal to the pk-pk Delta-time

accuracy limit for your instrument and bandwidth setting. (See Table 14 on page 161.)
• Press the Run/Stop button.

g. Repeat for all other Volts/div settings in the table for your instrument:

• Set the vertical scale, generator frequency, record length, and sample rate as indicated in the table.
• Repeat step 1.f on page 163.

h. Repeat for all channels of your instrument:

• Connect the sine-wave output of the sine-wave generator through a 50 Ω precision coaxial cable to the next unchecked
TekConnect channel through an adapter.

• Set the sine-wave generator to output a sine wave of the frequency shown in the table. (See Table 14 on page 161.)
• Set the generator output for 60 mV. (This amplitude will be adjusted later to get an 8-division pulse on screen.)
• Set the Vertical Scale to the Volts/Div shown in the table.
• Set the Trigger Source to the input channel you are using.
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• Repeat substeps 1.c on page 160 through 1.h on page 163 until all channels have been checked.
2. Disconnect all test equipment from the instrument.

Trigger system checks
These procedures check those characteristics that relate to the trigger system and are listed as checked in Specifications. 

Check time qualified trigger accuracy
Equipment Required Prerequisites

One sine wave generator (Item 9 on page 49)

One 2X attenuator (Item 23 on page 50)

One 50 Ω, precision coaxial cable (Item 5 on page 48)

One SMA male-to-female BNC adapter (Item 18 on page 50)

(See Prerequisites on page 47.)

1. Install the test hookup and preset the instrument controls:

a. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
b. Modify the default setup:

• Set the horizontal Scale to 2 ns.
c. Hook up the test-signal source: Connect the output of the sine wave generator to Ch 1 as shown in the following figure.

Figure 28: Time qualified trigger test hookup
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d. Set the trigger mode: Select Trig > Mode. Set the Trigger Mode to Normal.

Figure 29: Measurement of time accuracy for pulse and glitch triggering

2. Confirm the trigger system is within time-accuracy limits for time qualified trigger accuracy (time range <1  μs):

a. Set upper and lower limits that ensure triggering at 100 MHz: (See Figure 29 on page 165.)

• Select Trig > A Event (Main) Trigger Setup and then select the A Event tab; then pull down on Trigger Type and select Width
triggering.

• Pull down Pulse Width and select Inside limits.
• Click Upper Limit. Use the keypad to set the upper limit to 10 ns.
• Click Lower Limit. Use the keypad to set the lower limit to 2 ns.

b. Display the test signal:

• Set the Horizontal Scale to 20 ns.
• Set the output of the sine wave generator for a 100 MHz, five-division sine wave on screen. Set the Vertical Scale to 20 mV

(the waveform will overdrive the display).
• Press SET to 50%.

c. Check against limits: Do the following subparts in the order listed.

• While doing the following subparts, monitor the display (it will stop acquiring) to determine when triggering is lost.
• If using the optional front panel, press the multipurpose knobs until Fine is on.
• Use the multipurpose knob or the keypad to increase the Lower Limit readout until triggering is lost.
• CHECK that the Lower Limit readout, after the instrument stops triggering, is within the following limits:

Model Limit

DPO models 4.835 ns to 5.165 ns

• Enter the time on the test record.
• Use the keypad to return the Lower Limit to 2 ns and reestablish triggering.
• Click Upper Limit; then use the multipurpose knob or keypad to slowly decrease the Upper Limit readout until triggering

stops.
• CHECK that the Upper Limit readout, after the instrument loses triggering, is within the following limits:
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Model Limit

DPO models 4.835 ns to 5.165 ns, inclusive

• Enter the time on the test record.
3. Confirm the trigger system is within time-accuracy limits for pulse-glitch or pulse-width triggering (time range ≥1  μs):

a. Set upper and lower limits that ensure triggering at 250 kHz:

• Click Upper Limit. Use the keypad to set the upper limit to 4 μs.
• Click Lower Limit. Use the keypad to set the lower limit to 500 ns.

b. Display the test signal:

• Set the Horizontal Scale to 4 μs.
• Set the Vertical Scale to 100 mV.
• Set the output of the sine wave generator for a 250 kHz, five-division sine wave on screen. Set the Vertical Scale to 20 mV (the

waveform will overdrive the display).
• Press SET to 50%.

c. Check against limits: Do the following subparts in the order listed.

• If using the optional front panel, press the multipurpose knobs until Fine is on.
• Use the multipurpose knob or keypad to increase the Lower Limit readout until triggering is lost.
• CHECK that the Lower Limit readout, after the instrument stops triggering, is within the following limits:

Model Limit

DPO models 1.47 μs to 2.53 μs, inclusive

• Enter the time on the test record.
• Use the keypad to return the Lower Limit to 500 ns and reestablish triggering.
• Click Upper Limit; then use the multipurpose knob or keypad to slowly decrease the Upper Limit readout until triggering

stops.
• CHECK that the Upper Limit readout, after the instrument loses triggering, is within the following limits:

Model Limit

DPO models 1.47 μs to 2.53 μs, inclusive

• Enter the time on the test record.
4. Disconnect the hookup: Disconnect the equipment from the instrument.
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Check sensitivity edge trigger DC coupled
Equipment required Prerequisites

One leveled sine wave generator (Item 9 on page 49)

Three precision 50 Ω coaxial cables (Item 19 on page 50)

Two SMA female to BNC male adapters (Item 21 on page 50)

Three SMA female-to-female adapters (Item 15 on page 49)

One 10X attenuator (Item 1 on page 48)

One power splitter (Item 11 on page 49)

Male N-to-BNC adapter (Item 14 on page 49)

One SMA adapter (Item 18 on page 50)

One 5X attenuator (Item 2 on page 48)

One 2X attenuator (Item 23 on page 50)

(See Prerequisites on page 47.)

Note: The sine wave generator output amplitude must be leveled to within 0.35 dB of the reference frequency (10 MHz) through
the trigger frequency being tested. Refer to the Sine Wave Generator Leveling Procedure if your sine wave generator does not
have automatic output amplitude leveling. (See Sine wave generator leveling procedure on page 175.)

Note: This procedure checks a typical, not warranted, specification.

1. Install the test hookup and preset the instrument controls:

a. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
b. Modify the initialized front-panel control settings:

• Set the Horizontal Scale to 20 ns.
• Set the Trigger Mode to Normal.
• From the button bar, select Horiz/Acq and then select the Acquisition tab.
• Select Average and set the number of averages to 16.
• Click the Equivalent ET button.

c. Hook up the test-signal source:

• Connect the signal output of the generator to a power splitter. Connect one output of the power splitter to Ch 1 as shown in the
following figure. Connect the other output of the power splitter to the Aux Input as in the following figure.
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Figure 30: Sensitivity, edge trigger, DC coupled test hookup

2. Confirm the trigger system is within sensitivity limits (50 MHz):

a. Display the test signal:

• Set the generator frequency to 50 MHz.
• From the button bar, select Measure.
• Select Setup Ref Levs; then click the Min-Max button.
• Click the Setup button and select the Ampl tab; then click the Amplitude button.
• Click the X (close) button.
• Select Trig > A Event (Main) Trigger Setup.
• Press Set to 50%.
• Set the generator amplitude on screen as follows:

Model Divisions

DPO models 5 divisions

• Now fine adjust the generator output until the Ch 1 Amplitude readout indicates the amplitude is as follows (Readout may
fluctuate):
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Model Amplitude

DPO models 500 mV

• Disconnect the 50 Ω precision coaxial cable at Ch 1 and reconnect it to Ch 1 through a 10X attenuator.
b. Check the A trigger system for stable triggering at limits:

• Read the following definition: A stable trigger is one that is consistent; that is, one that results in a uniform, regular display
triggered on the selected slope (positive or negative). This display should not have its trigger point switching between opposite
slopes, nor should it roll across the screen. At horizontal scale settings of 2 ms/division and faster, if using the optional front
panel, Trig'd will remain constantly lighted. It will flash for slower settings.

• Select the positive trigger slope.
• Adjust the Trigger Level so that there is a stable trigger. CHECK that the trigger is stable for the test waveform on the positive

slope.
• Select the negative trigger slope. Adjust the Trigger Level so that there is a stable trigger.
• CHECK that the trigger is stable for the test waveform on the negative slope.
• Enter pass or fail in the test record.
• Leave the trigger system triggered on the positive slope of the waveform before continuing to the next step.

Figure 31: Measurement of trigger sensitivity - 50 MHz results shown

c. Check B trigger system for stable triggering at limits: Do the following subparts in the order listed.

• From the button bar select Trig, select the A Event tab, and set the Source to Line.
• Select the A->B Seq tab, and click the A then B Trig After Time button.
• Select the B Event tab, and click the Set To 50% button.
• CHECK that a stable trigger is obtained for the test waveform for both the positive and negative slopes of the waveform. (See

Figure 31 on page 169.)
• Enter pass or fail in the test record.
• Leave the Delayed trigger system triggered on the positive slope of the waveform before continuing to the next step. Also,

return to the A trigger: select the A->B Seq tab and click the A->B Sequence A Only button. Then select the A Event tab.
• Select the A Event tab, and set the Source to CH1.
• Press the X (Close button).

3. Confirm the AUX Trigger input (at 50 MHz):
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a. Display the test signal:

• Remove the 10X attenuator and reconnect the cable to Ch 1.
• Set the signal amplitude as follows: 2.5 divisions
• Now fine adjust the generator output until the Ch 1 Amplitude readout indicates the amplitude is as follows (readout may

fluctuate): 100 mV
b. Check the AUX trigger source for stable triggering at limits: Do the following in the order listed.

• Use the definition for stable trigger from step 2.b on page 169.
• Set the Trigger Source to Aux (Ext).
• Press Push-Set 50%.
• CHECK that a stable trigger is obtained for the test waveform on both the positive and negative slopes. Set the Trigger Slope

to the negative trigger slope. Adjust the Trigger Level to stabilize the trigger if required.
• Enter pass or fail in the test record.
• Leave the trigger system triggered on the positive slope of the waveform before proceeding to the next check.
• Set the Trigger Source to Ch 1.

4. Confirm that the A trigger system is within sensitivity limits (full bandwidth):

a. Set the Horizontal Scale: Set the Horizontal Scale to 200 ps.
b. Display the test signal:

• Set the generator frequency to full bandwidth as follows:

Model Generator frequency

DPO models 25 GHz

• Set the generator amplitude on screen as follows:

Model Amplitude

DPO models 5 divisions

• Now fine adjust the generator output until the Ch 1 Amplitude readout indicates the amplitude is as follows (readout may
fluctuate):

Model Amplitude

DPO models 500 mV

• Check that a stable trigger is obtained.
c. Repeat step 2 on page 168, substeps 2.b on page 169 and 2.c on page 169 for the full bandwidth selected.

Table 16: Trigger settings

Generator amplitude

Generator frequency

Horizontal scaleA trigger B trigger

75 mV 5 GHz 5 GHz 200 ns

Table continued…
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Generator amplitude

Generator frequency

Horizontal scaleA trigger B trigger

100 mV 10 GHz 10 GHz 200 ps

150 mV 15 GHz 15 GHz 200 ps

350 mV 20 GHz 20 GHz 100 ps

500 mV 25 GHz 25 GHz 100 ps

d. Display the test signal:

• Set the generator frequency to 10 MHz. Set the Horizontal SCALE as indicated in the table. (See Table 16 on page 170.)
• Fine adjust the generator output until the Ch 1 Amplitude readout indicates the amplitude listed in the table for a frequency not

yet checked. (See Table 16 on page 170.)
• Set the generator frequency to the frequency in the table that corresponds to the amplitude just set. Set the Horizontal SCALE

as indicated in the table. (See Table 16 on page 170.)
• CHECK that a stable trigger is obtained.
• Read the following definition: A stable trigger is one where the Trig'd LED will remain constantly lighted.
• Select the positive trigger slope.
• Adjust the Trigger Level so that there is a stable trigger. CHECK that the trigger is stable.
• Select the negative trigger slope. Adjust the Trigger Level so that there is a stable trigger.
• CHECK that the trigger is stable.
• Enter pass or fail in the test record.
• Leave the trigger system triggered on the positive slope of the waveform before continuing to the next step.
• From the button bar select Trig, select the A Event tab, and set the Source to Line.
• From the button bar select Trig, select the A->B Seq tab, and click the A then B Trig After Time button.
• Select the B Event tab, and click the Set To 50% button.
• CHECK that a stable trigger is obtained for the test waveform for both the positive and negative slopes of the waveform. Adjust

the Trigger Level to stabilize the A trigger. Click Level and use the keypad or the multipurpose knob/Fine button to stabilize the
B trigger. Click one of the Slope buttons to switch between trigger slopes. (See Figure 31 on page 169.)

• Enter pass or fail in the test record.
• Leave the B trigger system triggered on the positive slope of the waveform before continuing to the next step. Also, return to

the A trigger: select the A->B Seq tab and click the A->B Sequence A Only button. Then select the A Event tab.
• From the button bar select Trig, select the A Event tab, and set the Source to CH1.
• Press the X (Close button).

e. Repeat step 4.d on page 171 until each frequency in the table is checked. (See Table 16 on page 170.)
f. Display the test signal (Aux trigger at bandwidth):

• Set the Horizontal Scale to 1 ns.
• Reconnect the cable to Ch 1.
• Set the generator frequency to full bandwidth as follows:

Model Generator frequency

DPO models 11 GHz
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• Set the generator amplitude on screen as follows:

Model Amplitude

DPO models 8 divisions

• Now fine adjust the generator output until the Ch 1 Amplitude readout indicates the amplitude is as follows (readout may
fluctuate):

Model Amplitude

DPO models 800 mV

g. Repeat step 3.b on page 170 only, for the full bandwidth selected.

Note: You just checked the trigger sensitivity. If desired, you may repeat steps 1 on page 167 through step
4.e on page 171 for the other channels (Ch 2 [TekConnect only], Ch 3, and Ch 4).

5. Disconnect the hookup: Disconnect the equipment from Aux In and the channel last tested.

Output signal checks
The procedure that follows checks those characteristics of the output signals that are listed as checked under Warranted Characteristics in
Specifications.

Check fast edge output
Equipment required Prerequisites

One precision 50 Ω coaxial cable (Item 19 on page 50)

One SMA termination, (Item 4 on page 48)

One DC calibration generator (Item 7 on page 48)

One adapter (Item 18 on page 50)

Two precision 50 Ω coaxial cable (Item 5 on page 48)

One BNC T connector (Item 25 on page 50)

One adapter (Item 16 on page 49)

(See Prerequisites on page 47.) Also, the instrument must
have passed Check Timebase and Delay Time Accuracy and
Reference. (See Check timebase and delay time accuracy and
reference on page 156.)

1. Install the test hookup and preset the instrument controls:

a. Hook up test-signal: Refer to the following figure. Terminate the unused Fast Edge signal.
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Figure 32: Fast edge output initial test hookup

b. Initialize the instrument: Pull down the File menu, select Recall Default Setup.
c. Modify the initialized front-panel control settings:

• Set the Vertical Scale to 120 mV/div.
• Set the Horizontal Scale to 200 μs.
• Select the Trig > A Event (Main) Trigger Setup menu. Press Set to 50%.
• Center the display on screen.
• From the button bar, select Horiz/Acq and select the Acquisition tab.
• Click Average and set the number of averages to 128.

2. Confirm the fast edge signal:

Figure 33: Measurement of fast edge frequency

a. Save the fast edge signal in reference memory:

• From the menu bar, select File; Save As . . ., Waveform, and then Ref 1.
• Click the Save button to save the Fast Edge signal in reference 1.
• Disconnect the signal from Ch 1 and the Fast Edge connector.
• Select File; Recall . . ., Waveform, and then select the file name.
• Click the Recall button to recall the probe compensation signal to the display.

b. Hook up the DC standard source:

• Set the output of a DC calibration generator to off or 0 volts.
• Connect the output of a DC calibration generator to Ch 1. Refer to the following figure.

Performance verification

DPO70000SX Series Oscilloscopes Specifications and Performance Verification 173



Figure 34: Fast edge output second test hookup

c. Measure amplitude of the fast edge signal:

• From the button bar, select Horiz/Acq and select the Acquisition tab.
• Click Average and set the number of averages to 16 using the keypad or the multipurpose knob.
• Adjust the output of the DC calibration generator until it precisely overlaps the top (upper) level of the stored fast edge signal.
• Record the setting of the DC generator.
• Adjust the output of the DC calibration generator until it precisely overlaps the base (lower) level of the stored fast edge signal.
• Record the setting of the DC generator.

d. Press the X (close) button to remove the menus from the display. (See Figure 35 on page 174.)

Figure 35: Measurement of fast edge amplitude

e. Check against limits:

• Subtract the value just obtained (base level) from that obtained previously (top level).
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• CHECK that the difference obtained is within limits as follows:

Model Limits

DPO models 450 mV to 650 mV

• Enter voltage difference on test record.
3. Disconnect the hookup: Disconnect the calibrator from the Ch 1 input.
4. Check the negative output. Repeat steps 1 on page 172 through 3 on page 175 using the Differential Fast Edge NEGATIVE output.

Sine wave generator leveling procedure
Some procedures in this manual require a sine wave generator to produce the necessary test signals. If you do not have a leveled sine
wave generator, use one of the following methods to level the output amplitude of your sine wave generator. 

Note:

Method 1 is not recommended for ATI channel bandwidth measurement due to high measurement uncertainty, unless the
measurements are corrected using complex S-parameter values for the power splitter, power sensor, and instrument under test. In
Method 2 cable loss provides isolation that reduces impedance mismatch errors at ATI bandwidth frequencies. However Method 2
requires that the generator and cable have adequate amplitude stability with time and with cable movement.

Method 1

Equipment required Prerequisites

Sine wave generator (Item 9 on page 49)

Meter, power and sensor (Item 10 on page 49)

Power splitter (Item 11 on page 49)

50 Ω precision cable 2.92 mm male-to-female (Item 12 on page 49)

One K male-to-male adapter (Item 13 on page 49)

(See Prerequisites on page 47.)
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Figure 36: Sine wave generator leveling equipment setup

1. Install the test hookup: Connect the equipment as shown in the above figure.
2. Set the Generator:

• Set the sine wave generator to a reference frequency of 10 MHz.
• Adjust the sine wave generator amplitude to the required number of divisions as measured by the instrument.

3. Record the reference level: Note the reading on the level meter.
4. Set the generator to the new frequency and reference level:

• Change the sine wave generator to the desired new frequency.
• Input the correction factor and/or the new frequency into the level meter.
• Adjust the sine wave generator amplitude until the level meter again reads the value noted in step 3 on page 176. The signal

amplitude is now correctly set for the new frequency.
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Method 2

Equipment required Prerequisites

Sine wave generator (Item 9 on page 49)

Level meter and power sensor (Item 10 on page 49)

Two male N to female BNC adapters (Item 14 on page 49)

Two precision coaxial cables (Item 5 on page 48)

One or two SMA male-to-female BNC adapters (Item
18 on page 50)

(See Prerequisites on page 47.)

1. Install the test hookup: Connect the equipment as shown in the figure below (start with the sine wave generator connected to the
instrument). (See Figure 37 on page 177.)

2. Set the Generator:

• Set the sine wave generator to a reference frequency of 10 MHz.
• Adjust the sine wave generator amplitude to the required number of divisions as measured by the instrument.
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Figure 37: Equipment setup for maximum amplitude

3. Record the reference level:

• Disconnect the sine wave generator from the instrument.
• Connect the sine wave generator to the power sensor.
• Note the level meter reading.

4. Set the generator to the new frequency and reference level:

• Change the sine wave generator to the desired new frequency.
• Input the correction factor and/or the new frequency into the level meter.
• Adjust the sine wave generator amplitude until the level meter again reads the value noted in step 3 on page 178. The signal

amplitude is now correctly set for the new frequency.
• Disconnect the sine wave generator from the power sensor.
• Connect the sine wave generator to the instrument.
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